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Welcome 

Thank you for buying Opus and on behalf of everyone at Digital Workshop I’d like to welcome 

you to our multimedia creativity product, Opus, and to the exciting future that is interactive 

multimedia publishing and the opportunities it opens up for innovative and engaging 

presentations, scrapbooks, marketing, creative writing, education, games and training. We are 

sure you will enjoy using the software and exploring the many interesting new uses you can put 

your computer to for pleasure or profit... from the production of engaging rich-media 

presentations and promotions for clients and colleagues to the creation of fun, audio-visual 

projects for friends and family. Opus is a series of products for a range of uses at home or in 

business and is designed to provide everything you need to get started with creating quality 

interactive publications as quickly and easily as possible whilst also providing the power and 

functionality to produce very sophisticated material when you want to move on. You can 

achieve sophisticated results without any programming skills or complex scripts to learn. If you 

need higher level development you can use OpusScript and the extended functionality of the 

top of the range products to produce full-function database applications and so on. Morevoer 

the interface and the file format is the same across the whole range so growing your skills has 

never been easier. As with all Digital Workshop products you also get two extra benefits...free 

technical support and the chance to make your views count. Our technical support is free for 

the lifetime of the product and is available from our web site, our online forums, or by phone, 

fax or mail to our offices. Maintenance releases, which provide small changes and bug fixes, are 

available free of charge (except postage and handling where appropriate) and can usually be 

downloaded from the Internet. We only ever charge for upgrades – which include significant 

new features and even then we try to ensure excellent value for money. Remember we have to 

buy our software too so we know how frustrating it can be. 

We are proud of our reputation for excellent customer service so we hope you received this 

product promptly and that you enjoy using it. If you have any suggestions or ideas on how to 

make the program even better or any other comments to make about our products and service 

please let us know. We welcome and appreciate your feedback, good or bad. Many of the 

features in this version have resulted directly from customer feedback. Details of how to 

contact us are provided in Contacting Digital Workshop. 

Stay in Touch If you bought this product directly from Digital Workshop you are automatically a 

registered user. However, if you bought it through a third party, please take time to complete 

and post the registration card or email us with your details at reg@digitalworkshop.com. This 

enables us to let you know of any free maintenance updates when they become available and 

entitles you to receive our newsletter with hints and tips and special offers. Should you decide 

to email us, please send details of when and where you bought the product. If possible, please 

send us a scanned copy of the invoice as proof of purchase. 



  



About the Manuals 

Opus is provided a wide range of versions and editions to cover the many uses you can put the 

software too and allow for specialisation of the program, its resources and samples. All versions 

use the same user-friendly interface and way of working and the same basic principles of 

operation. This manual introduces all those basic principles and provides the fundamental 

information you need to start working with any version of Opus. However, from time to time it 

may refer to elements which may not be relevant to, or included in, your version but where it 

does so this will be made clear. A range of other support materials are provided which can be 

used in conjunction with this manual as necessary. These will include details of functions or 

options specific to your version and a comprehensive reference of the actions, triggers and 

properties available. If your version of Opus support OpusScript then an OpusScript reference is 

also included. Once you have reviewed this manual and the Getting Started guide you will only 

need the other support materials as reference as and when you hit a particular need and those 

materials have been designed to be used that way. The most comprehensive and up to date is 

obviously the online help file which is accessed via the Help menu. Access is also provided via 

the browser front end on the CD-Rom if you have bought the boxed product. 

  



Installation 

Opus is a powerful programming tool and therefore needs a full administrator account to work 

effectively. 

  



Overview 

Interactive Multimedia Publishing As its name suggests there are two ways in which Interactive 

Multimedia Publishing (IMP) differs from traditional publishing... Multimedia: Unlike a piece of 

paper a computer-based publication can combine words and pictures with sound, animation 

and video for both interest and information. Interactivity: Most importantly and unlike any 

other media, a computer-based publication can respond to interaction from the reader. It 

allows them to move through the document in the way that is relevant to them, to jump to 

specific places, get further details, prices or place an order simply by clicking a button. It also 

allows you to keep track of where they have travelled. However interactive multimedia 

publishing is still essentially publishing and allows you to create digital versions of the same 

kinds of documents as you would ordinarily create on paper with the extra dimensions of 

multimedia and interactivity. Many people are seeing the benefit of publishing material in 

interactive form directly onto disk or CD-Rom or to the Internet, especially as more and more 

PCs now come with built-in writable CD drives. It allows all kinds of documents to come to life 

with sound and video as well as text and pictures, drawing users through the document and 

even asking for their feedback or orders from within the material. Opus also allows you to 

publish full-blown multimedia to the Internet without the compromise involved in using HTML. 

It provides a streaming web plug-in which efficiently delivers your multimedia website to your 

visitor’s computer with all the functionality in the program – allowing for some spectacular web 

sites. In this way interactive multimedia is one of the most exciting forms of communication 

available to us today, but until now creating interactive multimedia communications was a 

difficult and demanding job. Now Opus extends the concept of desktop publishing into the 

audio-visual, interactive realm of multimedia. With Opus, interactive multimedia programs can 

be created as easily as a DTP document and published in digital form for distribution on CD-

Rom or across the Internet. 

Multimedia is already a favourite tool for the business presentation professional. Opus offers 

the ability to add multimedia pizzazz quickly and easily to standard business presentations and 

promotional items but also allows you to extend presentation and promotion into new modes 

by easily adding interactivity and distribution of the finished publication. It also provides 

numerous new opportunities for extra dimensions in learning and training and creative arts. 

Opus is so simple to use that you don't need to be a computer expert to create a captivating 

multimedia presentation. In fact, Opus has been designed with non- technical specialist in 

mind, providing logical, yet powerful tools for experts to pass on their knowledge in the most 

exciting and effective way. Furthermore, you can tailor your project to your own needs, 

capacities and budget so interactive multimedia comes into the reach of small businesses and 

even individuals. It is also particularly useful where confidentiality is an issue and where the 

involvement of as few additional parties as possible is required. Multimedia publishing offers 



“books” which can include sounds, moving images, words and pictures; plus it can also be 

interactive. That is, it does not have to be read page by page but allows the reader to choose 

the course of their study and for the teacher to chart their course and test them at appropriate 

times. Multimedia publishing also offers the creative person opportunities for creativity far 

beyond what has until now been available. A single creative artist can command words, 

pictures, music, sound and film images into whatever combination he or she desires. Interactive 

multimedia publishing is extraordinary communication for ordinary people. Opus is interactive 

multimedia publishing at its easiest. 

Opus Publications Opus uses the metaphor of a book to describe the interactive multimedia 

publication and each page of the book is a screen or dialog, which appears on the PC screen. On 

it are the objects of multimedia publishing, text, pictures, video, sound and buttons, all of which 

can then be set up to react to various events such as the user clicking on them. 

Opus Objects You have the following objects available when creating interactive multimedia 

publications with Opus: 

Chapters - used to divide your publications into manageable sections and to set the size and 

style of the pages within that section of the publication. These settings allow you to have pages 

of different sizes and shapes and have pages appear over other pages instead of replacing 

them. Pages - these are the areas of the screen on which you create your publication and which 

contain the other objects. They can look like standard windows with a title bar and border or be 

completely customised. They can appear over the top of the existing Windows desktop or block 

it out completely. Frames – used to group objects together. Any object drawn on a frame while 

the frame is selected will become a sub-object of the frame. This, for example, enables you to 

show or hide a group of objects with a single command. Animation of frame objects is relative 

to the frame. This can be useful if you want to animate objects in a specific area of the page. 

Text – for either typing text directly onto the page or importing it from ready- made disk files in 

text (.txt) or Rich Text (.rtf) formats. You can also link the text file to a disk file so that the text in 

that file is loaded when the publication is run. This enables you to display a piece of text that 

may subsequently change (dynamic text). Buttons – for standard or graphical buttons. Hotspots 

– for invisible active areas. Images – for still pictures in most popular formats. Drawn Objects – 

vector format shapes and lines, which you can draw on your page using the tools provided. 

Video & Animation – objects for displaying video or animation including animated GIFs. Text 

Input Box – a special sort of text object allowing the user to type information into the object, 

for example, their name or answers to questions. Slideshow – a series of images displayed one 

after the other at definable intervals. Browser – an Internet browser object that provides a 

"live" view of an Internet page. (Requires Microsoft Internet Explorer.) DocView – similar to the 

Internet browser, this allows you to display documents created in ActiveX-compliant programs, 

including Word documents, Excel spreadsheets and PowerPoint presentations. Timeline – this 



object does not actually appear on the page, but is essentially a collection of multiple actions in 

a timed sequence that can be triggered by a single event on the page. All the actions available 

to other objects can be included in timelines and they are displayed visually so the interaction 

and timing can be easily viewed and organised. 

Sound – allows you to play sound and music files from computer files or from audio CDs. These 

last two objects are not actually visible on the page but are still an integral element of your 

publication. 

Key Technical Information 

To get the very best from Opus, there are a number of considerations, which you need to take 

into account when designing your publication. 

Optimising Speed Opus has been written to get the best possible performance from your 

computer and uses Direct X technology to provide optimum performance. However, as Opus is 

such a versatile program, it is possible to try to do more on a single page than some lower 

specification Windows machines can cope with and if this is the case, your publication will slow 

down. Here are some considerations to take into account with regard to the speed of your 

publication. Using large AVI and WAV files, lots of animation and slideshows will all impact on 

the speed of your publication. Using graduated fills for backgrounds of pages or objects and 

using blur, transparency or shadows, particularly with video will also slow the publication down. 

Vector objects drawn with the in-built drawing tools are smaller than bitmaps and will 

download faster over the Internet. This makes them particularly useful for publications that will 

be primarily distributed via the Internet. If you attempt to run the publication on a 256-colour 

machine the pages have to be dithered which can reduce speed enormously, particularly the 

initial start up and moving between pages. Opus publications incorporate a read-ahead cache, 

this means that they try to predict what you will need next. Then, while you are reading the 

page or deciding what to do next it will load the material in readiness for when you move on, 

thus improving the speed of the publication. However, in order to stop animation, transitions 

and video from becoming too stilted, these activities take precedence. Therefore on lower 

specification machines, you should try to avoid or keep down the amount of video, transitions 

and animation you use in areas where you want the publication to move very quickly. In the 

case of sound files you can specifically request that the sound is preloaded by checking the 

relevant checkbox. This helps ensure a sound will synchronise perfectly with its event even on 

slower machines. 

Optimising Web Publications 

The Opus streaming web plug-in downloads your multimedia web site in sections and as soon 

as it has got what it needs to display a page it will do so and then download whatever it is likely 

to need next in the background. Therefore the best approach for multimedia web sites is to 



make them as modular as possible and have lots of small pages rather than one complex one. 

The Publish Settings allow you to create a publication with separate data files for individual 

pages, which can be particularly useful when your web publication is not very linear. In 

particular your front page should be as simple as possible to ensure that your visitors get to see 

something quickly or they will wander away. Using vector objects drawn with the Opus drawing 

tools can be particularly effective as they are so small – as with Macromedia Flash, animating 

them has virtually no impact on the download time. 

Timing Considerations One of the most common problems users experience with Opus is that it 

sometimes stutters or jumps unpreditably. This is almost invariably due to the fact that the 

publication is trying to do too much at once or because the computer the publication is running 

on has interrupted momentarily to do something else. For Opus the key event is the start of an 

action – the instant it happens. It is therefore easy to miss this fraction of a second and Opsu 

may then need to catch up which will make it appear to jump. In most cases this is handled 

seamlessly by Opus but occassionally too many events have been interrupted by something 

Windows needs to do and something else happening on the computer or being delayed in the 

publication makes Opus miss too many events and so when it updates itself which can make 

the publication can appear to jump. This often happens when using a string of Show After 

commands and transition timings to synchronise a series of events. The Show After timing can 

vary by up to four tenths of a second, as can the transition timings so you need to allow for this 

variation. It is obviously exacerbated if you have a string of events one after another. For more 

precise timing and control and therefore to avoid any stiltedness, most versions of opus include 

a timeline function. This allows you to place actions at specific intervals and Opus know to run 

the whole thing in series. It is also much easier to synchronise actions this way as you can see 

their location in time and align them visually. 

CD-Rom Publications and Loading Resources 

Publications which run from a CD-Rom drive and publications which require sound or video to 

load will also have slight variations in timing, especially when run for the first time. Opus tries 

to mitigate this by trying to predict what resources are required but it also tries to get your 

page started as soon as possible (that’s what you’d want when its only a simple page). 

You have the control to design your publication to work in all circumstances. By setting 

resources to preload or by starting your publication with a loading page you can mitigate the 

problem caused by your publication resource requirements. In other words, Opus gives you the 

control and the options to decide how your publication performs and you should ensure your 

publication design does not relinquish that control to the Windows operating system which 

may have its own priorities. 

Publication Resources The resources your publication uses are the images, videos, sound files 

and so on, which you have imported into the publication. Whilst you are editing your 



publication, Opus refers back to your original files and does not take another copy into the 

publication file. This is particularly important as multimedia files can be very large and to create 

a second copy would use up significant amounts of disk space. However, it does mean that you 

must keep the original copy on your computer while you wish to edit your publication. When 

your publication is published the resources are supplied with the publication and the original 

resources only need to be referred to if you want to edit the publication again. 

Reversing a Publication Please note that it is not possible to “reverse engineer” a publication 

and retrieve the publication file and/or resources from the published version. It is therefore 

advisable to retain a backup of both your editor files and the resources it uses. 

Resource Manager From time to time you may move your publication or its resources or you 

may work with other staff who have their network drives mapped to different drive letters. This 

may cause the Opus Editor to lose its connection to the resources. You will get a wanring 

message to this effect and a special Resource Manager is provided to enable you to relocate 

and reassign the resources as necessary. 

Disk Space 

The amount of disk space required by an Opus publication depends on the resources that you 

use and especially the size of any video and sound effect files included. The publication data file 

is compressed for distribution so that the publication will require additional disk space to run. 

Therefore the Opus Editor .IMP publication file rarely takes very much disk space. However, if 

you consolidate your resources using the Consolidate option on the Publication menu, this will 

take a copy of your resources and save them alongside your publication file. When you come to 

publish you will need significant amounts of disk space, not only to save the finished publication 

but also for creating temporary files whilst compressing the data of your publication. Again the 

exact amount will depend greatly on the resources used in your publication. 

System Requirements The Opus Editor and the publications it creates are compatible with 

Windows 98, 2000, NT4, ME or XP. It uses Direct X technology where that is available and we 

recommend that Direct X is specified as a minimum requirement for publications, as they will 

be much more effective with Direct X than without. Although the Opus Editor will work on any 

machine compatible with these operating systems, it needs (as a minimum) a good Pentium II 

machine to perform well although memory is far more important than processor speed and We 

also recommend that the Editor will be most comfortable to work with in a screen resolution of 

1024x768 or greater. If you wish to run in 800x600 you may need to customise the toolbars to 

fit and if you have to run in 640x480 you will need to use the full-screen editing mode as much 

as possible (see full- screen editing in the online help for further details). Opus and the 

publications it creates are not compatible with 256-colour modes. And can therefore only be 

run on systems with graphics cards and monitors capable of 64 million colours or true colour. 

Opus is compatible with multi-monitor setups. We strongly recommend you install Microsoft’s 



Media Player (or Direct X Media), which will considerably enhance the playback of MPEG and 

AVIs. You will need to install QuickTime 4 or better to enjoy QuickTime support in the program 

or your publications. The DocView object will view only those programs for which active 

viewing software is installed. For instance, it will view Macromedia Flash files on any system 

with Flash installed. 

CD and DVD Burning 

The function to burn CDs or DVDs within Opus is provided using third party software (Nero v6). 

However you can also use other software if you wish and simply get Opus to preapre the files 

you need to burn. Further details of this are provided in the Help file. 

Further Information Other technical information, including latest functionality and the file 

formats supported by the version you have bought, are included in the electronic help so they 

can be updated more regularly. Further information, hints, tips and updates are provided on 

our web site at www.digitalworkshop.com. A hot link to this Internet-based support is provided 

on the Help menu. 

  



 

Technical Support 

Save Yourself a Phone Call Digital Workshop is pleased to provide a free lifetime technical 

support service for its products via our dedicated support line. To help us maintain this service 

free of charge, please try to solve your own problems before you call. Things you could try first 

are... Check the Common Problems section of this manual and the Help File. Read the relevant 

section in the manual and search for any related subject in the index. Do the same with the 

online Help. An extensive keyword index is provided to assist you in locating the problem and 

Opus Help is context sensitive, so if the dialog you are presented with has a Help button it will 

take you straight to further assistance. Try to repeat your problem. Work through it again 

checking what you are doing, that you are not missing any steps, or moving on too quickly to 

notice an error message. Try reproducing the problem in a new publication or in isolation on a 

single page to see if it is a combination of factors that is causing the problem. If possible try a 

similar thing in another Windows package. If you are having difficulty printing then try printing 

something from Paintbrush (for bitmap graphics) or WordPad (for text and/or metafile 

graphics) to check that your Windows printing is set up properly. Check that you are not 

running out of disk space, (Windows Explorer displays the free disk space in the status bar at 

the bottom), or system resources (choose Help > About in Windows Explorer to view the 

available resources). Try freeing some disk space by deleting unwanted files or restart Windows 

to refresh your system resources. Check whether there are new drivers for your graphics card 

and install these. Do the same for your printer if the problem is with printing. 

How to Contact Support 

If you still cannot solve the problem you can contact usfor support. Almost all support queries 

involve something specific to your system or your particualr publication. And even if they are 

not we need to know as much information about your system as possible. Therefore we have 

included a special function on the Help menu for contacting support which includes all the 

system information we need. Using this method to contact support via email will be much more 

efficient and result in a much quicker resolution of your problem. 

Contact Support By Phone If you need to contact support via telephone for some reason please 

ensure you have precise details of your problem, particularly how you can reproduce it and if 

possible be at your computer when calling. Please also ensure you have the following 

information to hand if possible. The exact wording of any error message you have received. The 

version of Opus you are using (You can determine this by clicking Help > About Opus > System 

Information.) The version of Windows you are using. The type of processor (486, Pentium, 

Pentium II), the amount of RAM (memory) and the free disk space your computer has. Graphics 

card type and the mode you are running in. You can check this in the Display section of the 

Control Panel. For your convenience Opus provides most of the information for you via the 



System Information tab of the About box. 

Contacting Digital Workshop You can contact us for technical support or to provide feedback 

and suggestions for this product as follows: Email: support@digitalworkshop.com Internet: 

www.digitalworkshop.com Tel: 0870 120 2185 for technical support 

or 0870 120 2186 for general enquiries. Fax: 0870 120 2187. 

International Distributors Technical support may also be available in your country from one of 

our other offices or distributors. Please check the Help file or our web site for details of our 

distributors and agents. 

  



Before You Start 

Preparation and planning is not wasted effort when creating multimedia projects but can save 

valuable time later on. This chapter highlights some of the matters that should be considered 

before you even start creating the publication. 

Choosing a Design Theme Prior to starting on your publication you should decide on the overall 

theme and feel of the project, how it will look and who it is intended for. For example, you 

would not use the same colour scheme and style of images for a company presentation and for 

a children’s maths game. You should also consider how it is to be distributed and whether it will 

need to contain a lot of text or photographs. This will enable you to establish a basic concept of 

the publication, which you can then build into a storyboard. 

Creating a Storyboard It is useful, though by no means essential, to plan the pages of your 

publication in the form of a storyboard. This can be done to a greater or lesser extent 

depending on your personal preference and the kind of project you are doing but as with most 

things, careful planning in advance will often save reworking things later. The storyboard is 

basically a layout of the basic contents of your publication, the fundamental designs of pages 

and how they will interact. Will you have a title page? Will you access the pages via a Contents 

menu or will the reader browse through the pages in order? What buttons will be on every 

page? All these things can be considered in advance and a structured plan or storyboard can be 

created on paper if required. We particularly recommend that you try to give your publication a 

consistent feel by using buttons in the same places on the page and by using the same 

background or design for all or most of the pages. This requires planning ahead to allow for 

your most complex page. 

To assist you with this Opus allows you to create Master Pages which can have a particular 

design and/or contain specific objects which are then automatically included on any 

subsequent page which is set up to use be a “clone” of the Master Page. 

Raw Materials 

Gathering Resources Any multimedia publication can only be as good as the resources, (the 

words, pictures, sound and animations), which are used in it. Opus publications can include a 

wide range of resources in most of the popular formats (see File Formats in the Help File for 

details of exactly which formats are supported in this version). This allows you to use your 

existing collections of clipart and free snippets of music and sound given away with sound cards 

and magazines, or on bulletin boards and shareware CD-Roms. It also means that material in 

the many clipart and media clips products and libraries now on the market can also be used. If 

possible it is best to gather, or at least source, any resources you are going to use in the 

publication before you start so that you can know exactly what is going to be possible. You may 

find, for example, that you cannot find video material suitable for a training package but you 



have got a range of suitable cartoons - the whole look and feel of the publication would 

therefore need to be altered to suit this change of approach. 

Preparing Resources Your project will progress more quickly and smoothly if you prepare your 

resources in light of the considerations below: 

Words Opus allows for the direct input of text and provides a number of text formatting 

controls internally. However, many users will feel more comfortable creating bulk text in a word 

processor they are familiar with so Opus will import standard text (.TXT) and rich text format 

(.RTF) although some of the more complex formatting such as images, tables and columns will 

not be successfully imported but in these instances you can use the DocView object to view the 

document in its native format if the software supports the Active X interface. 

Pictures 

When using bitmap graphics in your publication the key consideration is that they will look best 

if they are the right size for the frame they are being placed in or they may lose quality when 

they are resized to fit into the frame provided. This also happens most noticeably with 16 

colour and 256 colour graphics particularly those that have been reduced to those colours using 

dithering which can produce ugly banding of colour. However, this is also a consideration for 

high colour graphics if the discrepancy between the original size and the size in Opus is too 

great. A further consideration in this instance is that high colour graphics can be large and 

therefore take time to load, so reducing their size to the correct one will make them smaller 

and quicker to load. If you are resizing a graphic by a considerably amount you may need to 

sharpen it or use some of the other image enhancement tools now available to recover some of 

the quality and sharpness. This requires a specialist program like Paint Shop Pro. When 

publishing, Opus optimises the graphics for the size they are used and will only store one copy 

of a graphic however many times it is used in the publication so these considerations only apply 

in the editor. Vector graphics (e.g.: WMF and EMF) can be scaled up and down without loss of 

quality; these are useful for resizable publications. Please note that WMF files can be bitmap as 

well as vector. The WMF files created by Paint Shop Pro, for example, are bitmap and will not 

scale as successfully as vector images. You should also note that EMF are higher quality vector 

files than WMF and should always be chosen in preference if possible. Paint Shop Pro can be 

used to resize bitmap pictures, to reduce or enhance the number of colours in them and also to 

apply specific palettes to them to avoid palette clash when creating 256-colour publications. 

Whether you do this before you start your publication or after (to ensure that you don't work 

on resources you then find no use for) is entirely up to you. Alpha Channels & Transparency 

Some picture formats include not just picture information but transparency information – that 

is areas of the picture which can be ignored, e.g.: PNG alpha channels and GIF transparency 

settings. Opus will recognise these areas of transparency and display the graphic accordingly. 

You cannot use the transparency controls in Opus with this transparency. Opus allows you to 



specify a colour or range of similar colours as transparent by selecting the transparency option 

on the Image properties. You can also set the overall transparency and a pattern of 

transparency (blend) for any object via the relevant sections of the Effects tab of the Properties 

dialog. This latter setting is independent of any alpha channel the image may have itself. 

Animation and Video Videos and animations can be resized, but remember they may not look 

their best or replay very quickly if not displayed at their original size. This is particularly true of 

Animated GIF files, which do not resize as successfully as photo-quality material. MPEG and 

QuickTime movies will generally maintain high quality and speed, even when resized. Opus 

does not include its own player for MPEG and QuickTime movies, but relies on the media 

handling provided by the applications and drivers that are currently installed. If you experience 

any problems with QuickTime movies, please ensure that you have the latest version of 

QuickTime installed. The new ASF format should be preferred over AVI, especially for web-

based publications, as this will then be streamed over the Internet. 

Sounds There are two categories of sound formats, midi and WAV. The former tend to be 

smaller and are instructions to the sound card to play certain instruments, as such they rely on 

the sounds embedded in the sound card and can vary from system to system. WAV format files 

are more consistent and naturalistic but can be large. The new Ogg, format (or MP3 and ASF) 

formats provide the realism of WAV format but are substantially smaller so these are often the 

preferred choice. 

Other Considerations 

Special Effects As long as you are running Opus or its publications under Windows 2000or 

better, on a system with plenty of memory, special effects such as transitions, transparency and 

shadows will be suitable for almost any size of graphic but should be allowed plenty of time to 

perform when used on large graphics or pages. If you experience problems with the speed of 

transition effects you can use the Exclusive option but please note the technical consequences 

for doing so described on page 137. You may also find that transitions which divide the graphic 

into blocks or sections will perform more smoothly when performance is a premium. 

TIP Don't overdo special effects. They are much more effective when used to sparingly. Be 

particularly careful using them to move whole pages on and off as they can slow the pace of 

your publication or distract from the content. 

Distribution Method 

 

Multimedia resources can take up a considerable amount of space and you should consider this 

before you start. If you are distributing your publication on floppy disk it will probably be 

impractical to include a great deal of WAV format sound or video so you may want to consider 

opportunities for keeping the size of your publication to a minimum. DVD and Video Publishing 



If you are planning to output your publication to a video file or DVD-Video you will need to 

consider the reduced amount of interactivity these format provide. In more advanced versions 

of Opus you can still record an interactive publication to video using the Keyboard and Mouse 

Recorder function to record you as you use the publication. 

  



Notes for PowerPoint® Users 

This chapter provides comparison of key features and processes in Opus compared to Microsoft 

PowerPoint, so that users of that product can upgrade smoothly. The key thing to remember is 

that to reflect the wider range of projects Opus is usually used for it refers to you document as 

a publication instead of a presentation, and its slides are referred to as pages. Although Opus is 

perfectly capable of producing stylish basic presentations quickly and easily, the major 

difference from Powerpoint is that Opus is capable of full-blown interactive applications and 

allows you to go far beyond what a normal presentation package could do. You could, for 

example, set up a presentation to record how it was being used which might be useful for sales 

training – a special component is provided to do this for you so no programming is needed from 

you. Alternatively if you work in a area of business which is subject to government regulation or 

has specific health and safety requirements you might want presentations which can only be 

edited in part by your sales staff. Opus allows you to set Permissions on any object on your 

page so you can lock the elements you need to keep consistent. 

Workspace In both programs the main area on the right of your screen is filled with an editable 

view of your current slide/page. The bulk of the left hand side is covered by an additional 

overview of your presentation or its content. This is where PowerPoint provides its slide sorter, 

outline and slide details view. You select between them using the buttons at the bottom of that 

panel. Opus provides a tabbed "organiser" instead. You select between the different views by 

clicking the tabs at the left edge. This is where Opus provides quick access to new Page 

Templates, which is similar to PowerPoint’s New Slide Auto Layout dialog. The other obvious 

difference with Opus is that it provides a quick-pick colour palette at the bottom of the 

workspace but has extensive drawing tools provided on the main Tools toolbar which rounds 

down the centre of the workspace. The colour palette is used for selecting Fill and Outline and 

Text colours for similarly to the PowerPoint tools at the bottom of the screen. Opus also 

provides onscreen access to page templates and readymade clipart and components via a 

series of tabbed palettes on the left of the workspace. 

New Presentation/Publication Creating a new presentation/publication is similar in both 

programs, allowing you to choose various aspects in advance. In PowerPoint the various aspects 

of the presentation are provided in a set of tabs on a single dialog, whilst in Opus they are 

presented as a set of dialogs in a Wizard. Opus does not provide an Auto-content Wizard 

instead the content is built into the page templates which you can drag into your presentation 

from the Page Templates gallery on the left of the workspace. The first two dialogs of the New 

Publication Wizard in Opus allow you to choose from a range of publication categories and then 

a colour scheme or design. This is equivalent to choosing a Design template in PowerPoint. In 

some versions of the product you can also choose the type of publication you are creating as 

Opus allows a far wider range of publication output formats than Powerpoint. The two 



programs then differ slightly in how new pages are added. 

Adding New Pages To add a new slide (or page) in Opus simply select the Page Templates tab of 

the Organiser and double-click on the Layout you require. The Page Template palette is 

equivalent to PowerPoint’s New Slide Auto Layout dialog. 

Adding Content In PowerPoint you add additional content via the Insert menu or from the 

toolbar at the bottom of the screen. In Opus the content object tools are in a toolbar between 

the Organiser and the Page View. To add ready-made content in Opus, you can simply drag it 

onto your slide/page from the Resource gallery provided in the Organiser. 

Slide Sorter In Opus you can sort and reorder your pages in the Pages section of the Organiser. 

Simply select the page and drag it to its new location. 

AutoShapes In Opus the preset shapes are provided as part of the Draw tool. Click the Draw 

tool and a floating Draw Tools toolbar will appear providing a range of drawing styles. At the 

end of this is a drop down box containing a series of preset shapes that you can then draw onto 

your page. 

Making Things Happen 

In PowerPoint you display the elements of your slides and move between pages using 

repetition of basic keys or mouse clicks. In Opus the templates we have provided largely mirror 

this functionality for your convenience. However, Opus has much more power and versatility 

when it comes to interactivity. Those mouse clicks or key presses which make things happen 

are called triggers and in Opus you have full control of those triggers and what actions those 

triggers perform. Please note: Opus uses Show in Turn and Hide in Turn actions to mimic the 

interactivity of Powerpoint’s basic presentations. For a step-by-step introduction as to how this 

works view How Bullet Points Display in Opus in the Help file. 

Animation In Opus, animation is used differently to PowerPoint. Animation in PowerPoint is 

used more in the context of what Opus calls Transitions (see below) or Text Animations which 

are accessed via Show and Hide buttons on the toolbar. In Opus, animations are most easily 

applied to objects using the Animation Wizard. These can be similar to transitions in that 

objects can scroll on and off the page or fade in and out but you can also set objects to bounce 

around the page or move along a path or animate on a regular basis. 

Transitions In Opus you can apply a transition to any object not just to the slide or page. Indeed 

you can set a transition for when it is shown and one for when it hides Remember that showing 

and hiding of all objects on a page also occurs when the page itself is shown or hidden. The 

transition for an object is one of its Properties so you can edit it by simply double-clicking on 

the object and going to the Transition tab. Text has some additional transitions called 

animations which animate the letters or words into place in innovative ways. There is an 

animation similar to Powerpoint’s teletype effect and also several similar to those available in 



Macromedia Flash. 

Effects Not to be confused with either of the foregoing, Opus includes a set of Effects functions 

that allow you to alter the appearance of an object in stylish and interesting ways more akin to 

a graphics package. These are provided as Properties of an object. The most popular of these 

are transparency, drop shadow and flare. Quick access to these functions is also provided on 

the Object Properties toolbar. 

Viewing Your Publication 

As with PowerPoint you can preview your publication in Opus at any time. However, in Opus 

you can preview both a single page and the whole publication. In PowerPoint you preview your 

slideshow by pressing F5 or selecting Slideshow from the View menu. In Opus you preview a 

single page of your publication by pressing F5. To preview the whole thing press F4. Or select 

Preview Page or Preview Publication from the Publication menu. When you have finalised your 

presentation you may wish to create a standalone version for viewing on your own computer or 

on another. This process is called Publishing and creates a single, standard program (.exe) file 

that will run on any supported Windows system without the need for Opus. 

Distributing Your Publication In place of PowerPoint’s Pack and Go, Opus has Publishing, It 

provides a range of output options and as a more sophisticated distribution option which allows 

you to specify an icon for the setup program and so forth, via a Distribution Wizard. There is 

also an Upload Wizard 

Video and DVD Publishing Opus also provides DVD-Video publishing so that you can output 

your presentation to a video file or to a DVD-Video which can be displayed on stand alone 

domestic DVD players. This functionality os only available for Powerpoint through additional 

software. 

Going Further Opus is actually designed as a visual program creation tool, so it contains many 

features and functions that Powerpoint does not possess. It is not possible to list all of these 

and the opportunities they provide but they include: 

• Text input 

• Variables 

• Scoring 

• Reading and writing disk files These are detailed more thoroughly in the For more ideas and 

inspiration take a look at the samples provided with this program or on our website. 

Don’t be daunted, with the basic principles you learn from doing your presentations in Opus 

you’ll quickly be able to get more creative than you’d believe and soon it will only be your 

imagination that limits how far you go beyond extraordinary. 

  



Basic Principles 

 

The Workspace 

By default, when you start Opus, the screen is divided into three sections as follows: 

Organiser The Organiser on the left provides an Explorer-style view of the publications that you 

have open and the objects in them. It also provides palettes of resources and page templates. It 

is divided up into sections providing different items. The sections you have available will 

depend on the mode in which you have chosen to run Opus, but they can include: Pages – all 

the pages of your publication, with any master style page at the beginning. Objects – a tree-

view of all the different objects on all your pages. 

Actions – a similar view of all the actions you have added to the objects of your page. Resources 

– a set of galleries of components, clip art and other resources you can reuse in your 

publication made available for ease of use. In the Objects section you can select, rename and 

delete objects. You can also drag them around to change the order on which they appear on 

screen, or drag them between pages or even different publications. You can expand or contract 

any section of the tree by clicking on the plus or minus boxes at the head of each section. 

The Resources section provides a series of pigeonholes for objects, pages and combinations of 

objects that you might find useful. The sets of resources are divided up into “galleries”. The list 

of galleries you currently have installed appears at the top of palette and you can choose 

between these galleries simply by selecting the title of the one you want. What is available here 

will depend on what you installed during the installation process. You can click on objects with 

the right mouse button and drag objects from here onto your page or vice versa. A special 

Scratch Pad gallery is provided for you to use as a temporary pasteboard for objects you are 

using repeatedly throughout a particular publication. You can also create your own galleries. 

Page View – Editing Window 

The main window to the right of the Organiser is the Page View and provides a WYSIWYG 

editing view of the pages in your publication and a thumbnail view of your overall publication. 

This is where you design the pages that will make up your publication/presentation. You can 

have more than one Editing Window open at a time allowing you, for example, to have a 

Publication View open of your whole publication and a couple of pages open for cutting and 

pasting objects between them. 

Colour Palette Bar Opus provides an onscreen palette for you to quickly select colours for the 

main properties of your Opus objects such as background and border. The Colour Palette 

appears at the bottom of the Opus workspace. Note: If the colour palette is not displayed in the 

Opus workspace, select Palette Bar from the View menu to open it. 



Additional sets of colours can be organised in particular palettes and loaded and saved as 

required. Each palette is accessed via a tab with its name on which appears along the bottom of 

the palette bar when more than one palette is loaded. Below is an illustration of the Palette 

Bar, please note the colours extend across the Opus workspace. 

Further details on using the colour palette are provided later in this manual and in the Help file. 

Layer Palette In versions of Opus intended for more complex publications the page can be split 

up into layers so that you can show and hide whole sections of objects easily. To facilitate this a 

layer palette is provided in the bottom left corner of the workspace. 

Further details on using layers and the layer palette are provided in the Help file or in the 

appropriate additional manual if this feature is included in your version of Opus. 

Getting Extra Workspace The Organiser can be resized or even closed completely to provide 

more space for the Editing Window. Opus also includes buttons to temporarily hide these 

elements and then restore them again at the touch of the appropriate button... 

This button hides and shows the Organiser (or press F2). 

If you want to work on your publication with the absolute minimum screen clutter you can 

temporarily switch to full screen editing mode by pressing F10 or clicking the Full screen mode 

button... 

In this mode only the Tool palette is available, plus editing commands accessible from the right 

mouse menu. You can quickly return to the usual Opus workspace by clicking the Full Screen 

button again or pressing Esc. 

Roll Up Dialogs Some of the large dialogs in Opus can be set to automatically roll up out of the 

way so that you can move quickly and easily between the dialog and your page. 

When the rollup button at the top right of the screen is displayed, the dialog rolls-up out of the 

way when you click on the publication behind. Only the title bar will be displayed. Move the 

mouse pointer over the title bar again to re-display the dialog. 

Click on the roll-up button once to disable this roll-up feature. 

Zooming In and Out You can also zoom in and out to get an overall or close up view of your 

page and the objects on it by using the magnifying glasses on the toolbar, or by selecting a 

zoom level from the drop down list box. 

Alternatively the Zoom tool on the Tools toolbar lets you click on the area of the page you want 

to zoom in or out on. Once selected, click with the left mouse button to zoom in and with the 

right mouse button to zoom out. 

Zoom to Fit There is also a special option in the drop down menu allowing you to set Zoom to 

Fit. With this option operating Opus will automatically enlarge or reduce your page so it fits into 



the editing space available. The zoom is updated whenever the window is resize too. This 

means you will always get the biggest view of your whole page. 

Rulers and Guides 

Opus provides a set of rulers at the top and left edge of your Editing Window to help you line 

objects up when designing your page. The measurements are provided in pixels. If you click on 

a ruler at a particular point a guideline will appear running across or down your page at that 

point. 

The Toolbars When you start Opus, the following toolbars are displayed. Each toolbar button is 

described in the status bar at the bottom of the Opus workspace. Toolbar button also embody 

tool tips, so if you hover the cursor over the button, it will display a reminder of its function. 

The toolbars can be reorganised via the Customise option on the Tools menu. 

Main 

The primary toolbar runs across the top of the workspace and is in two sections. The first 

provides the main file controls and allows you to add new publications, pages or chapters, or 

move material between Opus and other programs via the clipboard or duplciate objects. It also 

provides the Undo and Redo buttons. 

View 

This section of the primary toolbar provides view and grid options, allowing you to toggle the 

grid and rulers on and off, set the zoom, or to switch to full-screen editing mode. Most 

importantly it also provides the buttons to preview your page or your publication and to 

navigate the editor backwards and forwards through pages of the publication. 

Object Properties 

The first section of the second level of toolbar provides shortcuts to the Object Properties 

including transparency, flare, background and shadow. It also includes a shortcut button to set 

the object as initially hidden and two buttons to set the transition when the object is shown 

and when it is hidden. Most of these buttons have an arrow alongside indicating that they can 

use a range of further presets which can be accessed from a flyout panel which will appear 

when you click on the arrow. 

Text Format 

The other section of the second level of toolbar provides the standard text editing functions 

such as bold, italic, underline plus left, right, centre and full justification. Note that you can also 

select outline text and to stretch the text to fit. This toolbar also provides a palette of graphical 

bullet points and shortcutbuttons to set special text animations to bring the text on or take it 

off. These buttons have an arrow alongside indicating that they can use a range of further 

presets which can be accessed from a flyout panel which will appear when you click on the 



arrow. 

Tools  

Dividing the Organiser from the Editing Window is a palette of tools for creating the various 

objects (frame, text, button, image etc) that can be placed on an Opus page and for 

manipulating the selection of objects. Several of these tools will have arrows alongside 

indicating that they have additional options which can be chosen from a flyout menu which will 

appear when you click on the arrow.  

In the case of Opus Pro  even more buttons will have this option as you can add your own 

preset tools to each object creation tool. This is detailed in the Help file and in the 

accompanying additional manual. Most notably the drawing tools have a number of different 

options available from the flyout including freehand, line drawing and preset shapes. 

As hotspot and path animation objects are created with the same type of tool they use a similar 

flyout. 

The first few tools on the Tools toolbar provide: 

the Selection arrow which is the tool most used most often as it allows you to select, move, and 

resize objects. When you use one of the other object creation tools the tool returns to this 

slection arrow once the object has been drawn unless you have the sticky tools option on. 

the Scale Tool which allows you to set the scale of the object ideal for resizing collections of 

objects consistently. (If you need to understand the difference between the scale tool and 

resizing the object use the scale tool on a piece of text.) Note that this sets the scale properties 

of the object as detailed on the Properties dialog. 

the Sticky Tools button lets you lock the object creation tools so that they do not automatically 

switch to the selection tool on completion of the object. This enables you to create several 

objects of the same type one after another. 

the Zoom tool lets you click on an area of your page to enlarge it. 

At the bottom of the toolbar is the Lock Selection tool which allows you to lock the selection on 

the current object. When editing a complex document, especially with object below others it 

can often be useful to lock the selection so that you don’t accidentally click off the object and 

lose the selection. Once you have selected the object you want click this button or press Ctrl+L 

to lock the selection. You will not be able to select any other object on the page until you 

repeat the procedure to deselect. You can switch selection in this mode by selecting different 

objects in the Organiser tree. The remainder of the toolbar is taken up with tools to create the 

various objects you can use on the page. Some of these tools represent a set of tools as 

detailed above with regard to the drawing tools. 

Frame – allows you to create an object to contain a set of other objects. 



Multiframe – creates an object which can contain a series of frames to hold combinations of 

other objects to be displayed in sequence or on command. 

Rollover – an object containing a set of frames which appear according to the mouse activity. 

Thus you can set frames to appear when the mouse moves over the rollover or when the 

mouse is clicked. 

Text and Disk-based Text – creates a text object which you can simply type text into on screen 

or one which imports text from a disk-based file. 

Text Input box – creates an object which the user of your publication can type into. Often used 

for gathering user information or filling in forms or for replies to questions in quizzes. 

Button – to create a button. 

Image – to create a container for an image 

Draw – to draw vector graphics including straight lines, freehand lines and shapes or preset 

shapes including squares stars and circles depending on the subtool you have selected. 

Hostpot – to draw an invisible area to create an active area over part of another object, usually 

an image. Again you can draw different shapes depending on the subtool you select 

Animation Path – to draw custom paths for objects to be animated along using the Animation 

Wizard or the Follow Path action. 

Video – adds a container for a video or animation file. If your version of Opus supports 

Quicktime VR then the tool to create a container for this will also be available here 

Slideshow – for creating a slideshow of disk-based images. 

Sound – a special creation tool because in Opus sounds are not objects but an action (Play 

Sound). This is a QuickBuild button which allows you to quickly apply a sound effect to an object 

which will be played when the object is clicked on. 

Browser Viewport, HTML Object and DocView – these tools allow you to draw containers to 

hold a live view of an internet site or web page or active documents from Office applications 

such as Word and Excel or Flash movies as well as embedding HTML widgets into an HTML5 

publication. 

Timeline – allows you to create a timeline for putting together a series of synchronised actions 

which can be run with single command. The timeline does not appear on the page. In versions 

where the timeline is an important element of the workspace this will already be on view and 

will be activated by selecting this tool. Otherwise the tool will bring up the Timeline dialog for 

editing. 

Script Object – this will attach a script object to your page in a similar way to the timeline tool. 

Obviously this is only available in advanced versions of Opus which support OpusScript. 



List Box – a component for developers which allows a list of active text to be created and 

actions applied to the relevant selection. Only provided in advanced developer versions of Opus 

Scrollbars – adds a horizontal or vertical scrollbar to an image or a piece of text. 

  



Creating a New Publication 

The first step in getting started with Opus is to create a new publication. This publication may 

contain no pages at all, one blank page, or, have a style and layout selected from standard 

templates supplied with the program. If you are running Opus from the icon you will be asked 

to create your publication or open an existing one but if you are already running Opus you 

should click the New Publication button... 

...or select New...Publication from the File menu. Opus provides support for different types of 

publications and therefore the first stage will be to decide which type of publication you want 

to create. You can change this at a later stage via the Type tab of the Publication Properties but 

as some publication types do not support all functions it may result in you losing functionality if 

you do not select the correct publication type at this stage. Details of the different types of 

publication are provided in the Appendix but the most commonly-used ones are the Opus 

publication, the Opus Flex publication which creates a publication in Macromedia Flash format 

or the Video/DVD publication types which create publications which will ultimately be 

converted to non-interactive video. If you are not using Opus in Wizard mode a blank 

publication will be opened. If your version of Opus provides support for different types of 

publications you will be asked first what type of publication you want to create. You can change 

this at a later stage via the type tab of the Publication Properties but as some publication types 

do not support all functions it may result in you losing functionality if you do not select the 

correct publication type at this stage. This is particularly important with less interactive 

publication types such as Video or DVD publications. If you are running Opus in Wizard mode 

the New Publication Wizard will run as follows. You will be given the option to choose a blank 

publication or open an existing one as well as choose one from the templates provided. You will 

then be given the choice of the type of publication you wish to create. You will proceed directly 

to the Publication Category dialog. Where you can choose the type of publication you wish to 

create. 

This choice will decide the type of content provided in the page templates. All these categories 

have blank page templates so you can create entirely custom pages if you wish. The next dialog 

of the Wizard lets you choose a style for your publication from the professional designs 

provided with the program. 

The styles available are specific to your chosen category but all are fully editable. If you want to 

create your own design or want a plain colour then choose the Plain style. 

Screen Resolution One problem faced by all multimedia developers is the issue of screen 

resolution. Screen resolution refers to the number of pixels that are displayed on the screen - a 

system running at 800 x 600 screen resolution displays 800 pixels along the width of the screen 

and 600 pixels along the height. Users can easily adjust their system’s display resolution using 



the display settings (Start > Settings > Control Panel > Settings). 

Increasing the screen resolution from 800 x 600 to 1024 x 768 effectively decreases the size of 

the pixels being transmitted to the monitor, so that 1024 pixels now fit along the width of the 

screen and 768 pixels make up the height. As the size of the pixels is being reduced, on-screen 

objects such as text and graphics appear physically smaller but the user benefits from clearer, 

sharper images and the ability to fit more objects on-screen without cluttering the workspace. 

Conversely, decreasing the screen resolution from 800 x 600 to 640 x 480 increases the size of 

the pixels being transmitted to the monitor. Text and graphics now appear larger and fewer 

objects can be placed on-screen without overlapping. However, lower screen resolutions are 

often used by partially- sighted users and users of small display devices. Screen resolution 

obviously has a great effect on the display of multimedia content and, as many multimedia 

developers have found to their cost, publications may look very different when viewed at 

different screen resolutions. For example, if a publication is designed at a resolution of 640 x 

480, any text used will become much smaller when viewed at 1024 x 768, often to the point of 

becoming unreadable. Using images with dimensions greater than 640 x 480 pixels is fine if the 

audience is viewing at a resolution of 800 x 600 or greater, but any users with 640 x 480 screen 

resolution will not be able to view the whole image without the use of scrollbars. 

Change Display Options Thankfully, Opus allows you to easily determine how your publication 

should be displayed at different screen resolutions, leaving you free to concentrate on the 

design and content of your publication without fear of resolution issues. After you have chosen 

to create a new blank publication or a publication from a template, the following options 

should appear on-screen: 

Below are descriptions of each of the options shown, but if you need an on- screen reminder, 

simply click the More Information button to display a brief summary of each setting. 

Scale Publication to Fit Any Screen The publication will be created at a size of 800 x 600 pixels, 

but the published executable will contain code to detect your end-user’s screen resolution and 

dynamically scale the publication horizontally and vertically to fill the screen. Please note that, 

as the publication is effectively magnifying its content, your images and text may become 

slightly blocky. The magnitude of this blockiness depends entirely on the level of magnification 

required to fill the screen (i.e; how high the user has set the screen resolution) and the graphics 

and processor power of the machine displaying the publication. As the publication is working 

very hard to constantly monitor and scale objects, you may also notice that animations and 

transition effects become a little sluggish and the timing of actions is affected. Again, these 

problems are most likely to occur on machines with very high screen resolutions (as more 

scaling is taking place) or 

Temporarily Change Resolution to Publication Size Your publication will be created at a size of 

800 x 600 pixels, but the published executable will contain code to automatically adjust your 



end-user’s screen resolution to 800 x 600, allowing your publication to display at full screen. 

This change is temporary and the screen resolution will be returned to its previous setting once 

the publication has been closed. 

The change of screen resolution will cause your user’s screen to flicker momentarily. This is an 

unavoidable consequence of altering the screen resolution, but you may want to notify your 

users that this behaviour is normal and will not damage their system. Please note that altering 

the screen resolution in this way may prevent your publication from running on older laptop 

systems. Many of these systems use graphics cards set to safe-mode settings and are locked at 

640 x 480 screen resolution. If you encounter this problem, you should find that downloading 

the most recent display drivers from the laptop manufacturer’s website should unlock other 

display modes and allow you to view the publication. Keep Original Size and Centre on Screen 

Your publication will be created at a size of 800 x 600 pixels, but the published executable will 

contain code to detect your end-user’s screen resolution. If the user’s resolution is greater than 

800 x 600, your publication will be centred on the screen and a border will be placed around 

the publication to fill the remainder of the screen. Opus lets you configure the surround colour 

by clicking Publication > Publication Properties > Options and adjusting the Surround Colour 

settings. 

Editing Object Names When you create a new publication in the Extended mode of Opus, a 

chapter and master page are automatically created to allow you to start work without having to 

manually create these objects. If you click on the Objects tab in the Organiser pane, you will see 

that, by default, the publication is given the title Untitled1, the first chapter is named Chapter 1 

and the master page is called Style. 

If you create a new non-master page (by clicking File > New > Page or by using the icon on the 

main toolbar), you will see that the page is given the name Page 1. Create another new page 

and you will see that it is given the title Page 2. 

All publications, chapters and pages are automatically numbered in the sequence in which they 

were created. However, you will find it easier to navigate through your publication and select 

pages to go to if you change the name to something more descriptive. You can change this 

name, and the name of the chapters and the pages, by left- clicking on the name you want to 

edit so that it is highlighted. Left click again on the highlighted name and when you release the 

mouse button, the name will turn into a text edit box and you can change it to suit. 

Alternatively you can select Rename from the right-mouse menu. Press Enter to accept the 

name once you have typed it or click elsewhere in your workspace. Once you have started 

editing a name there is no way to cancel it but you can use Undo to revert to the original. You 

do not need to limit the name to eight letters, and it can include spaces so you can write a 

descriptive sentence if you wish. However, if you write a long name some of it will not be visible 

unless you reorganise the layout of your workspace so that the Organiser is wider. However, a 



truncated name will “pop-up” when the mouse moves over it. 

You can also edit the name of the object via the General tab of the Properties for that object. 

To bring up the Properties dialog for a selected object, double- click on it or press Ctrl+R. 

Adding Chapters and Pages You can add further Chapters to your publication by clicking the 

New Chapter button... 

or by selecting New...Chapter from the File menu. The new chapter will be added to the end of 

the publication. You can add pages to your publication by clicking the New Page button... 

or by selecting New...Page from the File menu. This will add a blank page to the end of your 

publication. To use one of the templates provided with Opus simply switch to the palette of 

Page Templates in the Organiser and double-click on the page you require. A copy will be 

automatically added to the end of publication. 

Selecting Publication Elements You can select one publication, one chapter and one page as the 

active document by clicking with the left mouse button on the name in the Organiser window. 

The name of the active publication and the active chapter will appear in bold in the Organiser. 

You can select more than one object at one time by holding down the Ctrl key while clicking on 

the objects required. If you want to select a list of items simply select the first item in the list 

and then hold the Shift key down while selecting the last item in the list. All the intervening 

items will also be selected. Obviously this is most useful for selecting multiple pages for copying 

into another publication as you can only edit the content or properties for one item at a time. 

Reorganising Chapters and Pages 

In both the Organiser and the Publication View you can reorganise the chapters and/or pages 

within your publication by clicking with the left mouse button on the chapter/page you want to 

move and then dragging to where you want that object to go. Alternatively, if you use the right 

mouse button instead you will be given the option to move or copy the object to the new 

location. A small menu will appear allowing you to choose whether you want a copy of the 

object, or you want to move it, thus deleting it from its original location. If you change your 

mind about the action simply select the Cancel option. 

Moving the object will remove it from its original location and place it in the new one. Copying 

will put a copy of the object in the new location and leave the original intact in the first 

location. In the Organiser a further option appears. The Insert into option is for copying objects 

onto frames and is not used for pages and chapters. You can have more than one publication 

open at any time and you can drag and drop chapters and pages across publications in just the 

same way as within publications. This allows you to swap or copy whole chapters or pages from 

one publication to another. 

Cut and Paste In addition to dragging pages and chapters around in the Organiser, you can also 



Cut, Copy, Paste and Delete pages and chapters using the appropriate options from the Edit or 

the right mouse menus, just as you can with any object on a page. A Duplicate command is also 

provided which combines both copy and paste and will immediately reproduce the selected 

objects on the page. To create a series of objects a Paste Multiple Times option is also provided 

which allows you to set the number of copies of an object which will be pasted from the 

clipboard. Use this with the functions on the arrange menu and you can quickly build 

arrangements of similar objects. 

Editing a Page 

Setting Page Size Opus allows you to customise the page size and even use different pages sizes 

per chapter although this latter option is rarely useful for video or DVD export or for outputs 

which don’t use Chapters. In some versions of Opus you can also subdivide your publications 

into a series of panels – this is explained in further detail in the Help file. All the pages in a 

chapter must be the same size. Therefore if you want different sized pages in your publication 

you need to have a chapter for each different page size required. You can move between pages 

in different chapters, just as easily as you can between pages in the same chapter, so this does 

not prevent you having different-sized pages in the same section. By default the size of each 

page is set to 800x600. You can change this default via the Options option and you can change 

the size of pages in individual chapters by editing the Chapter Properties. (For further details 

see Chapter Properties on page 242). The page size can be changed at any time though 

obviously reducing the page size after adding objects may mean that some objects no longer fit 

on the page. 

Setting a Page Background By default a blank new page is white so one of the first things you 

will probably want to do is to give it a different background. Page backgrounds can be a flat 

colour, a graduated fill between two or four colours, or an image. The background colour and 

style are set via the Background section of the Page Properties dialog. To bring up the Page 

Properties dialog, simply double-click on the page with the left mouse button to bring up the 

appropriate Settings dialog and then select the Properties tab to bring that section to the front 

if it is not already on view. 

For a flat or graduated colour for the background, click on the Background tab to go to that 

section. 

Click the Use Background option to switch this on and then use the first of the colour boxes to 

set the basic colour. 

You can  then choose from a series of preset backgrounds styles or basic gradient or solid fills 

which you can edit to suit. 

You can choose the colour for a solid colour background from the drop-down colour palette 

accessed by clicking on the arrow beside the relevant colour well. 



You can then select a colour from the palette by clicking on it. 

If the colour you require is not available in the colour palette you can use the Custom option to 

call up the Colour Selector dialog to create a customised colour. 

If you add your chosen colour to the Custom colours palette on this colour selection dialog 

using the Add to Custom Colours button, this colour will automatically be added to your Opus 

colour palette. It can then be chosen from anywhere else in the program. A colour history is 

also displayed for you to pick custom colours you have used most recently. If the colour you 

require is being displayed on screen you can quickly choose it by selecting the colour picker 

and then clicking on the colour wherever it appears. 

Graduated Fills You are not limited to flat colours for your background. You can choose range of 

gradient styles including linear, radial and central and can customise the angle and the position 

of colours to suit. 

A special control is provided for you to customise the gradient. You can add up to seven colour 

points along the gradient (marked by simple arrowheads) using the add and delete buttons. The 

colour can be amended at each point by selecting the colour palette button or double-clicking 

on the colour pointer. 

A Reverse button is also provided for you to easily switch the directions of gradients once 

selected. If relevant you can also change the angle of the gradient using the angle compass 

provided. You can have both a background image and a background colour. This gives you the 

option of having an image that is smaller than your page size surrounded by a colour. 

Background Image The Image tab allows you to select an image to use on the background of the 

page. This can be a custom background that creates a particular design or texture for the page, 

a background image or an abstract pattern. Click the Image tab to bring it to the front and then 

use the Browse button to locate the graphic file you want to use via a standard Windows Open 

file dialog. 

If the Preview checkbox is ticked the image will be displayed in the preview box below the 

filename 

TIP: If one of the main contents of the page is to be an image you can get a stylish effect by 

using a very pale or colourised version of that main graphic as the background for he page as 

a sort of visual echo. 

If the image is a different size or shape to the page then you have a number of options to set 

the way it is displayed. By default the image is displayed at the top left corner of your page but 

you can change that. You can centre it, or repeat the image across and down the page as many 

times as required (as if it were a bathroom tile) or you can stretch it to fit. In the latter case you 

can choose to ensure that if the picture does not have the same proportions as the page, it will 



keep its aspect ratio and therefore not looked stretched out of shape, this may mean that it 

does not entirely fill the page. All of these options are selected by clicking on the appropriate 

radio buttons from the group illustrated. 

In addition, you can choose to ignore a colour in the image by clicking the Transparent option 

and choosing the colour you want to leave out from the colour palette, or by using the colour 

picker tool. 

This option is most useful to remove the surrounding background colour from an image so that 

the content object appears over the background of the page rather than on its own 

background. With the subtlety of colour modern systems can now display it can be difficult to 

judge the required colour by eye therefore, the colour picker tool is the best way to choose the 

transparent colour as you can pick it from the copy of the image displayed in the preview box. If 

you find that the background is not fully removed it probably means that across what appears 

to be a flat colour there are variations in the hue of the colour you have chosen. You can use 

the tolerance slider beneath the edit box to increase the range of that particular colour which 

will be ignored. If your images is scaled or rotated while being used in your publication you can 

achieve a much smoother appearance by checking the Bilinear Resampling option though this 

can sometimes cause a slight reduction in the speed of performance. 

Page Border As with almost all objects in Opus, you can also give the page a border. This can be 

as simple as a black outline or a bevel or it can be a shape. One of the most interesting and 

unusual features of Opus is that your publication does not need to be square! They can be 

circular, cloud-shaped or appear in the outline of a country! A wide range of borders are 

provided and are divided into categories. Choose the category of border you want and then 

simply select the one you want by clicking on the name in the Style list provided. The result can 

be previewed in the box underneath 

Even more interesting results can be achieved if you switch the page background off, either by 

clicking off the checkbox on the Background tab 

or by clicking the shortcut button on the toolbar. 

This will leave the page itself as transparent (as represented by a chequered pattern) and 

means your various elements will simply appear over the existing desktop, which allows for 

some very interesting and powerful effects. However, please note that complex publications 

done in this way may be slow and page transitions can be awkward and stutter. You should only 

use this option with static publications. Attempting to animate an object over a transparent 

background will only work on the highest specification computers. 

Setting a Page Transition 

As with any object in Opus, you can set the page to appear using a special effect instead of just 

appearing on screen. It can slide or scroll up, down, left or right or it can fade into place and 



leave in a similar or different style. This is known as a transition. The page transitions are set via 

the Transitions section of the Properties dialog for the page, which you can call up by double-

clicking anywhere on the page. 

The first choice to make is whether you want a transition for when the page appears (Page On) 

or when it leaves (Page Off) or both, which you can do by clicking on the relevant checkbox so 

that a tick appears in it. A selection of the most popular or your most recently-used transitions 

is provided in a drop down list box from quick selection. 

Alternatively you can select the More... button to view the complete range of transitions. This 

will call up the Transitions dialog with a list of different styles of transition on the left and an 

icon list of the transitions in that style, alongside it. Note that a QuickBuild button is provided 

which allows you to quickly apply a sound effect to accompany the transition if you wish. 

Further details are provided in the QuickBuild section and in the Help file. 

Select the style you are interested in and then click on an individual icon for the particular 

transition you want. The result will be previewed in the panel at the bottom right so you can try 

several to see which is most suitable. The other setting available is Transition length , which 

specifies how long the transition effect, will take, effectively the speed of the transition. Use the 

spin buttons (arrows) to increase or decrease the value in the edit box, which represents the 

seconds the transition will take. Any interval smaller than a few tenths of a second is unlikely to 

make a noticeable difference but may be useful for timing purposes. All transitions for pages 

are exclusive as there are no other actions possible while the page is turning. 

Background Music and Sound You can also attach a sound or piece of music to a page so that 

whenever it appears the sound is played. This can be used either to play a sound simply for 

effect or to start a narration related to the page. Alternatively, because the sound file started 

by the page is only stopped by other settings and actions, you can use it to start a piece of 

background music that will continue throughout your publication. 

Opus will accept most popular formats for music files, including WAV, MP3 and MID. The latter 

are often smaller and Midi can be particularly useful for long background music tracks but Midi 

relies on the simulation of musical instruments provided by the audio card in the computer and 

this can vary quite considerably. You attach a sound to a page as you would with any other 

object and that is to give the page an action that plays the sound. In this instance you will 

choose On Show as the trigger as this will play the sound file automatically when the page 

appears. You then choose whether to play a disk-based file by using the Browse button to 

locate the file required, or a track from an audio CD. The tab also provides controls as to the 

number of times the file or track is played, whether it plays at full volume, and whether it fades 

in and/or out. 

Note that you can play only one Midi file and/or one CD track at the same time but you can play 



(mix) several different WAV and MP3 tracks at the same time though what kind of cacophony 

might result is your business. This can, however, be useful for playing WAV format background 

music or narration and still having WAV sound effects on buttons etc. If you do not want the 

sound or music you have started on this page to continue when the user moves on to another 

page simply click on the Stop when page changes option so that no tick appears in the box. 

The other options on the Sound dialog are dealt with in the Actions: Sound section later in this 

manual. 

TIP: You can play multiple WAV, MP3 and WMA sounds and you can also play one CD track 

and one Midi file all at once. 

 

Turning the Page Automatically Although Opus is aimed at creating interactive publications 

there are times when you will want a page to change automatically. This might be because it is 

part of a timed rolling presentation, a time-limited test or a cover page or notice that you 

display for a short period before moving onto the first interactive page. Even where the user 

could interact with objects on the page it could be useful to turn the page automatically to 

ensure that the publication moves on even if the user forgets to move on. Opus offers an easy 

solution by allowing you to specify a time for the page to be displayed. This option is on the 

General tab of the Page Properties. 

Use the spin buttons to set the time (in minutes and seconds) for which the page will be on 

display and then select the page to which it should move using the drop-down list provided. 

Creating Objects 

Once you have created one or more pages for your publication you can add some content. This 

can take the form of text, images, video, slideshows, buttons and sounds. To help you create 

your objects in a tidy layout, Opus provides a Grid option. This displays a series of dots or 

dotted lines on your page. 

Drawing and repositioning of objects is then forced to stick to this grid making it much easier to 

create objects aligned with each other. Details of how to set the grid up and change the 

spacing, style and colour are provided in a later section. You can switch the grid on and off with 

the Grid toolbar button 

or by pressing the Shift and F8 keys at the same time. You can switch the grid from lines to dots 

via the Grid option on the View menu. The colour and other settings for the grid are provided 

via the Options on the Tools menu. 

You can also switch the rulers on and off by using the Rulers toolbar button. Clicking on the 

Ruler will create a guideline at that point. To delete guidelines simply drag them off the page. 

All the objects in Opus are created in one of two ways, depending on what sort of object they 



are. If they are simply holders for content you draw rectangular areas into which the content 

goes. For objects which are content in their own right (lines, stars, bullets, etc.), you use the 

drawing tools to draw the object itself. The Tools toolbar also provides the buttons to add three 

special action control objects - Hotspots, Animation Paths and Timelines. 

This chapter deals with creating the former type of object while drawn objects are dealt with in 

the next chapter and action control objects are dealt with separately. For content objects you 

add the object to your page in the same way by selecting the appropriate tool and then 

outlining the area on the page where you want the object to go, this area is marked out by a 

dotted line box which only appears in the editor not your final publication and is referred to as 

the bounding box because it sets the boundaries for the object. Please note that if you apply an 

action to an object you are applying the action to the whole area you have drawn to hold the 

object unless you use the Ignore Transparent Region checkbox explained later in this manual. 

To create containers for the various content of your page you firstly click with the left mouse 

button on the Tools toolbar button for creating the object you want, or select the appropriate 

object from the Insert menu... 

Frame – allows you to create an object tyo contain a set of other objects. 

Multiframe – creates an object which can contain a series of frames to hold combinations of 

other objects to be displayed in sequence or on command. 

Rollover – an object containing a set of frames which appear according to the mouse activity. 

Thus you can set frames to appear when the mouse moves over the rollover or when the 

mouse is clicked. 

Text and Disk-based Text – creates a text object which you can simply type text into on screen 

or one which imports text from a disk-based file. 

Text Input box – creates an object which the user of your publication can type into. Often used 

for gathering user information or filling in forms or for replies to questions in quizzes. 

Button – to create a button. 

Image – to create a container for an image 

Draw – to draw vector graphics including straight lines, freehand lines and shapes or preset 

shapes including squares stars and circles depending on the subtool you have selected. 

Hostpot – to draw an invisible area to create an active area over part of another object, usually 

an image. Again you can draw different shapes depending on the subtool you select 

Animation Path – to draw custom paths for objects to be animated along using the Animation 

Wizard or the Follow Path action. 

Video – adds a container for a video or animation file. If your version of Opus supports 

Quicktime VR then the tool to create a container for this will also be available here 



Slideshow – for creating a slideshowof disk-based images. 

Sound – a special creation tool because in Opus sounds are not objects but an action (Play 

Sound). This is a QuickBuild button which allows you to quickly apply a sound effect to an object 

which will be played when the object is clicked on. 

Browser Viewport and DocView – these tools allow you to draw containers to hold a live view 

of an internet site or web page or active documents from Office applications such as Word and 

Excel or Flash movies etc. Note that these objects only work by accessing the relevant 

additional software and this must already be installed on the computer. Thus to view Excel files 

your user must have Excel or and Excel viewer installed on their PC. Once you have selected the 

tool for the object you want to create, move the cursor over your blank page. Note that Opus 

tells you the exact location of your cursor in the status bar at the bottom of the workspace. 

When you have moved to the correct location, click with the left mouse button on the page 

where you want the top left corner of the object to be. You can reposition it later so it only 

needs to be approximate. Then, keeping the left mouse button pressed down, drag the cursor 

over to the right and down until you have highlighted the area you want the object to cover. 

You can resize the object later, so again this only needs to be approximate. 

Once you have completed drawing the object, Opus will launch the appropriate Properties 

dialog so you can begin editing the object’s properties, including its actual content, as described 

in the next section. You can switch this automatic launch off via the Options dialog accessible 

from the Tools menu. If you do switch this option off you will need to manually launch the 

Properties dialog by double-clicking on the object with the left mouse button or pressing Ctrl+R. 

Creating Similar Objects Again If you want to create a number of objects of the same type you 

should ensure the “sticky tools” button is down. This will keep the currently selected tool active 

until you select another one. 

With this option off the program will always return to the Selection tool when you have finished 

drawing an object. 

Creating the Same Object Again Often you will want to create objects of the same size and 

shape. To save you fiddling you can take a copy by using the Duplicate function. This 

immediately makes a copy of the selected object with all the same properties, contents and 

actions. Select the object you want to copy and click the Duplicate button on the Tools palette 

or press Ctrl+D. 

Note that when duplicating an object in this way any actions, which have been set up for the 

object will be retained as well as the contents. 

Drawing Tools 

Opus is supplied with a series of drawing tools for creating the objects most commonly used in 



creating multimedia pages. These include straight and freehand lines, circles, stars, polygons, 

squares and rounded rectangles. You can even draw with a selection of ready-made shapes 

such as speech bubbles, frames and flashes. All the objects drawn with these tools are vector 

graphics, which means they use maths to describe their shapes rather than a grid of pixels of 

particular colours. This means they can be resized without becoming jagged, that they can be 

reshaped after they are drawn and that they create very small files. These objects can be given 

a particular colour, together with a different colour outline in different widths or with different 

line styles as detailed below and in the Help file. You can even add different end caps to open-

ended lines to create arrow is different directions and so forth. Unlike bitmap drawing tools 

such as those in paint programs these objects can be repositioned and edited afterwards so 

your drawing does not need to be perfectly accurate to start with. All these vector tools are 

available from a single vector Draw tool button on the Tools toolbar. Note that the actual 

button visible on the toolbar will reflect the subtool which is currently active. To change the 

subtool select it from the flyout menu accessed by clicking on the down arrow beside the tool. 

When you select this tool a floating palette of tools will appear from which you can select the 

one you require. 

Straight Lines and Shapes 

This tool lets you draw straight lines between two or more points. Simply click with the left 

mouse button where you want the line to start and then move the mouse to the next point and 

click again. 

TIP If you hold down the Shift key when using this tool your drawing will be snapped to the 

grid for that page if the grid is not turned on. This is particularly useful for ensuring that 

straight lines are level. 

If you continue to move the mouse and click the left mouse button you can create a straight-

sided shape. If you then return to the beginning and click close to the starting point, the 

program will ask you if you want to close the polygon thus turning a straight line into an object. 

Whenever you have finished drawing your line simply click with the right mouse button to stop 

the drawing tool. 

Freehand Lines and Shapes 

This button allows you to draw any shapes you like with the mouse. Click and hold down the 

left mouse button where you want the object to start, then drag the mouse in the shape you 

want. 

As before if you return to finish close to the start of your object, Opus will give you the option 

of connecting the two points and turning the object from a line to a closed shape. 

Selecting Yes will result in a closed shape as illustrated on the left below. Otherwise the object 

will be left as drawn, as illustrated on the right. 



To close a polygon after it has been drawn simply select the two nodes you want to connect 

and click the Close Shape button (see below). In the cases of the remaining tools the actual 

object you draw can be chosen from a number of preset styles in a palette which drops down 

from the arrow alongside the tool button itself. Note there is an additional tool for creating 

freehand shapes using bezier curve drawing. 

This is provided for users familiar with Bezier curve drawing who prefer that method. Unless 

you know and prefer that style of drawing simply use the freehand drawing tool described 

above 

Square and Rectangle 

This tool allows you to create squares, rectangles and the adjacent tool draws rounded 

rectangles. The drop down list allows you to choose between standard rectangles and those 

with rounded corners. The fill and outline for the object are set in advance or can be edited 

subsequently by choosing the relevant optiosn on the colour palette. If you do not require a 

colour outline or you want a hollow shape simply select None for the colour for the Outline and 

Fill respectively. To draw with the tool simply select the style you require from the drop down 

palette. Move the mouse to where you want the top left corner of the object to be. Click and 

hold down the left mouse button and then drag the mouse away from the start point to create 

the object. 

When the object is the required size and shape release the mouse button to finish drawing. 

TIP: To draw a square rather than a rectangle simply hold down the Alt key while you draw. 

You can use the Alt key similarly to maintain the proportions of any vector object. 

TIP:  As with all vector objects, if you hold down the Shift key when you begin using this tool 

your drawing will be snapped to the grid for that page if the grid is not turned on or will 

ignore the grid if it is on. 

TIP: As with all vector objects, if you hold down the Ctrl key while drawing, the tool will use your starting 

point as the centre of the object rather than the top left corner. This can be particularly useful where you 

wish to draw a shape around an existing object. In the case of the rounded rectangle drawing tool you can 

edit the radius of the corners once the object is complete. When you release the drawing tool to complete 

drawing a rounded rectangle large nodes appear at the curve of the radius and you can click on any of these 

and drag them as required to edit all corners to suit. 

Circle, Ellipse and Spiral 

This tool works in the same way as the preceding tool except that it will draw circles or ellipses. 

You can choose the type of shape it will draw by selecting it from the dropdown palette 

accessed by clicking the down arrow alongside the tool. 

All the same keys can be used to lock the drawing to the grid, draw from the centre. To draw 

circles simply hold down the Alt key while you draw. 

Regular Polygon 



This tool offers a wider range of shapes allowing you to chose to draw triangles, pentagons (5 

sides), hexagons (6 sides), heptagons (7 sides), octagons (8 sides), nonagons (9 sides) and 

decagons (10 sides) which are selected from the accompanying drop down palette. 

Star 

This tool lets you draw stars with various numbers of points. To create irregular stars you 

should then edit the individual points as required (see Editing Drawn Objects below.) 

AutoShapes 

The final tool in this section works as the previous tools but provides a selection of commonly-

used shapes such as arrows, speech bubbles, flow chart symbols and panels. Again you select 

the exact object you want by selecting it from a drop down palette of options. 

Note that some of these symbols are designed to take the current foreground and background 

colours. If these have been set to None or to White the resulting thumbnails on the drop down 

paletter may appear incomplete or not be visible at all. 

Outline and Fill You can select the colour for the fill of the object by clicking on the required 

colour in the palette with the left mouse button. The chosen colour will be shown in the 

leftmost box in the colour indicator at the left of the palette. 

If you want the object to have no fill simply click on the None option. 

You can select the outline for an object by clicking on the colour required with the right mouse 

button. This chosen colour will appear in the second box in the colour indicator at the left of the 

palette. 

Again you can select None if you require no outline. The changes you make are immediately 

applied to any objects you currently have selected when you change the colour. For further 

details about using the colour palette please see Choosing Colours. 

Editing Drawn Objects Unlike drawings in paint programs the actual lines describing the vector 

objects created using these tools can be edited after they have been drawn. The object is made 

up of a series of points (called nodes) with a straight or curved line connecting them. You can 

move the nodes to different positions, you can add or remove nodes and you can change the 

shape of the lines between the nodes and whether they can turn sharp corners at the nodes or 

whether they are smooth. To edit an object in this way you must select node editing from the 

right mouse menu or from the vector-editing toolbar. You can also switch between node editing 

and editing the whole polygon using the respective buttons: 

Once in node-editing mode, the nodes of the object will now appear as small squares along the 

lines of the object and the cursor will change to an arrowhead. Note that the exact style of the 

nodes and editing handles may differ in Opus depending on the default options set when 

shipping your version of the product. The size and colour of these can be set via the Options 



function on the Tools menu. 

A node-editing toolbar will also appear allowing you to change the properties of the nodes. 

You can now select individual nodes by clicking on them or select a series of nodes by holding 

down the Shift key while you click on them. You can also draw a box to surround a group of 

nodes to select them all by clicking inside the dashed outline around the object and dragging 

with the mouse button. A second dotted line box will be drawn temporarily on the screen and 

any nodes that fall within that box will become selected. 

The colour of a selected node will reverse. Once you have selected the node(s) you can click 

and drag the mouse cursor to move the nodes wherever you wish or you can use the following 

toolbar options... 

Add a Node – this is only active when you have two nodes selected and it will add a third node 

between the two nodes. If you have more than two nodes selected it will add an extra node 

between each pair. 

Delete a Node – clicking on this button removes any selected nodes. Alternatively you can 

simply press the Delete key. 

Break Apart – this option will break open the shape at the point you have selected. You cannot 

have more than one break in a shape. 

Close Shape – this allows you to close a shape by drawing a connecting line between the two 

end nodes. You must have the two end nodes of a line selected. If the nodes are close enough 

Opus will simply merge them, otherwise it draws a line between them. 

Smooth Curve – requires the line to move through the point smoothly. Thus any editing of the 

curve you do will also affect the curve on the other side of the node as it tries to keep the curve 

smooth. 

Sharp Curve – this allows the curve of the line coming into the node to be edited independently 

of the line leaving the node thus allowing you to create sharp changes of direction. In drawing 

programs this is often referred to as a cusp node. 

To Curve – changes a straight line into a curve. You need to have two nodes selected for this 

option to be available. 

To Line – changes a curved line into a straight line. 

Editing Curves 

In addition to editing the position of nodes or changing the way the lines pass through them 

you can also edit the shape of the curves themselves. When you select a node attached to a 

curve you will notice two small editing controls appear attached to the node by a dotted line. 

If you click and drag on these editing handles you can edit the curve to the required shape. 



The way in which the editing handles affect the curves will be affected by whether the node is 

set to require Smooth Curves or Sharp Curves as detailed above. 

Action Control Objects 

Opus also provides three other objects that are not used in the same way as other objects. 

These objects are not part of the content of your publication but instead provide control for the 

actions in your publication. 

Animation Path As it’s name suggests this object is a path along which you can animate any 

object. You draw the path in the same way as you draw vector objects described in the previous 

chapter, except that you initially select the Path Animation tool instead of the Drawing tool. 

As with drawn objects a flyout palette of tools is available allowing you to select to draw a path 

of straight lines, freehand lines or preset shapes of various types. The last of these provides a 

selection of useful ready-made paths, such as a bouncing ball, a loop-the-loop and a figure of 

eight. When you finish drawing the path you will notice that it draws as a single line with arrows 

along it indicating the direction of travel. 

To change the direction of travel you can select Reverse Direction from the Vector menu or the 

pop-up menu that appears when you click on the path with the right mouse button. 

You can also use Flip and Mirror on the Vector menu to switch you path top to bottom (Flip) or 

left to right (Mirror) without changing the direction. The outline and fill colours and controls 

have no effect on the animation path. 

If you now preview your publication you will see that the path does not appear on your page. 

However, you can now select another object on your page and use the Animate action to make 

it move along the path you have created. This process is described in further detail later in the 

Animation section of this manual. If, for any reason, you do want to see the path during the 

editor preview simply select the Display Path in Preview option from the right mouse menu for 

the path. It still will not appear in the final publication. You can create an animation path from 

any vector object by selecting Copy as Path option from the Vector menu although you cannot 

perform this process in reverse. 

Hotspot This tool allows you to create invisible “buttons” or hotspots in any shape you like. 

Hotspots are a key feature of interactive publications and are most often used to make certain 

parts of a picture interactive rather than the whole thing. This allows you to have a number of 

independent interactive actions on a single image and could be used, for example, to may each 

country on a map link to a separate page relating to that country. As with the Animation Path, 

this object is drawn using the drawing tools described in the previous chapter, except in your 

choice of initial tool. To create a hotspot, start by clicking on the Hotspot tool. 

A flyout menu of options is available for you to choose from as with the other tools which allow 



vector drawing. Draw the area you require either by hand or using the preset shapes provided 

and then edit it to fit exactly as described above. Remember to ensure the Properties of the 

object is set to ignore the transparent area or the whole bounding box of the object will be 

active. But note that if the object does not have a fill then only the outline will be active which 

can make it appear that it is not working. In this case you can change the fill and outline but the 

object will always be drawn semi-transparently to remind you that it will be invisible in the final 

publication. For further information on this aspect see Irregular Hotspots in the Advanced 

Techniques section. 

Timelines 

The last of these additional options on the Tools toolbar is to add a Timeline to your 

publication. A timeline is basically a self-contained set of actions in a carefully specified order 

and combination, which can then be launched by a single action. In contrast to all the other 

tools you do not draw anything on your page to use a timeline – it is merely created in the 

Organiser and you must select it there in order to edit it. Timelines are covered in more 

detailed in the Advanced Techniques section of this manual. 

Add Sound 

This tool is simply a shortcut way of adding a Play Sound action to the object you select. It 

assumes that you will want the sound triggered by a left mouse click as this is the most 

common requirement. However, once the action is applied you can edit the action as normal, 

including the trigger. Opus provides a dedicated Sound Browser which allows you to preview 

the sounds provided with the program. These represent dedicated sound effects and music 

chosen specifically for their usefulness in multimedia authoring. The Sound Browser also 

provides a Browse button to use the standard file browser to look elsewhere for sound files. 

  



Existing & Ready-Made Objects 

You can speed up the creation of your publications by using objects and even pages, which are 

already available. They can either be the ready-made components we have supplied with the 

program, objects you have saved as components to use again, or simply objects or pages from 

existing publications. Note that in all cases the objects retain their actions as well as their 

contents. It is important to remember that this may mean they refer to objects that are no 

longer present on the page. For example they may be trying to show or hide an object that is 

not there, or play a sound with a different name. If you want to reuse combinations of objects 

that refer to each other, you need to create them all as sub-objects of a frame and then make 

the whole frame a component. 

Copy and Paste In addition to the Duplicate command explained in the preceding Chapter, you 

can copy a selected object to the clipboard using the Copy command from the Edit or right 

mouse menu. You can then paste the copy onto the same page or another page using the Paste 

command from the same menus. Note that the object will be pasted in approximately the same 

place on the page as they were copied from but offset by a number of pixels. This offset can be 

set to suit your requirements via the View section of the Options dialog available from the Tools 

menu. This has the advantage of allowing you to copy material from other pages and even from 

other publications. You can copy and paste whole pages and even chapters in this way by 

selecting them in the Organiser and then copying and pasting as usual. 

Resource Components Opus is provided with a whole range of ready-made objects. These 

include useful standard buttons, ready-made combinations of actions for saving a VCR style 

control or a volume control, right up to page templates for particular styles of publications. 

They are provided in special sections of the Organiser called resource galleries The galleries you 

have installed are listed at the top of the gallery palette and you can switch between them by 

simply selecting the required name in the list. 

To use a ready-made object, simply select the object you want to use on your screen by clicking 

on it in the gallery with the left mouse button, then hold the mouse button down and drag the 

object onto your page. Note that you can drop the object anywhere on the page as it 

automatically goes to where it was originally created. This ensures you can be confident that 

you are using the object consistently across pages. If you do want the object in a different place 

you can of course move it once it has been dropped onto the page. Alternatively, simply select 

the component object you want to create and move the cursor over the page. You can now 

draw the component object just as you would any other object. 

Creating Your Own Components You can create your own components by storing your own 

objects in the Component Galleries. You can store them in any unlocked gallery (represented by 

an open padlock icon in the top left of the gallery). This function is particularly useful to store 



objects you are going to use repeatedly in one publication, or in a series of publications, as well 

as to act as a pasteboard for objects while you redesign a page or decide whether an alternative 

option is going to work. You can place your objects in a gallery by opening that gallery in the 

Organiser view. Then select the object, hold the right mouse button down and drag the object 

from your page onto the gallery. A small menu will appear letting you decide whether you want 

to move or copy the object to the gallery. Alternatively you can select the object you want to 

store and then click it with the right mouse button. Select the Copy to Gallery option from the 

right mouse menu and then choose the gallery you want the object stored in by choosing it 

from the fly-out menu that appears. You can temporarily store your objects by dragging them 

to the special Scratch Pad gallery, which acts as a kind of pasteboard while you are working on a 

project. You can permanently save your components by creating a new gallery. This is covered 

in detail in the Working with Files section on page 247. 

  



Choosing Colours 

Opus provides an onscreen palette for you to quickly select colours for the main properties of 

your Opus objects such as background and border. The left of the palette shows the current live 

colours in a Colour Indicator box. 

The lefthand colour is the fill colour and the right hand colour is the outline colour. In between 

is a button to swap these two over and beside them is a colour picker allowing you to choose a 

colour from anywhere on your screen – useful for matching existing colour schemes. 

To select the “fill” colour – used for the background colour and the fill colour for drawn objects 

– simply click on the colour required with the left mouse button. To select the “pen” colour – 

used for the outlines of vector objects and borders – simply click on the required colour with 

the right mouse button. There are then buttons to add or delete additional palettes for you to 

add your own custom colours or if you right click on the palette a menu will appear allowing 

you to load and save additional palettes which you can either save from within Opus or can be 

created in any paint program which exports .pal files. Additional palettes are presented via a 

series of tabs along the base of the section. The remainder of the the bottom that is a standard 

palette of colours. Alongside the palette of colours itself is the None button to select no colour 

for background or outline. 

Custom Colours You can create custom colours via the Opus Colour Selector. To customise the 

current colours simply click on the relevant Colour Indicator box or double- click on any colour 

well in the palette. The Opus Colour Selector will appear. 

You can either select one of the existing colours from the various palettes on the left by clicking 

on them with the left mouse button or you can create a new one by clicking on the colour 

wheel and then adjusting the Luminance slider to get to the approximate shade. If necessary 

you can then use the other controls to get the precise colour required by altering the amount of 

red, green or blue, or by adjusting the hue, saturation and/or luminance via the edit boxes 

provided. If you want to place this colour in your personal palette you should click the Add to 

Custom Colours button and it will now appear in the Custom Colours palette both on this dialog 

and on the main Opus screen. Note also that, for your convenience Opus also keeps track of 

your most recently used colours in a Colour History. This enables you to quickly pick colours you 

are using regularly in a particular publication but which you do not want to include in your 

custom colours palette. When you have chosen your colour click the OK button to use it in the 

Opus palette. If you want a colour similar to the existing colour but with a slightly different hue 

or luminance – for example to colour a highlight or shadow of an existing colour click and hold 

the mouse button on the colour and a special colour swatch will appear. 

This allows you to select related colours by moving the mouse over the swatch and releasing it 

when you have found the colour you want. 



Gradient Fills The Background tab in the Properties dialog box allows you to set a background 

for your page/object. You can choose from a list of background styles including a simple solid fill 

colour to gradient fills. In this version you can also have multi-coloured gradient filss and even 

add your own styles to the list – see Background in the Help file for a full description of options 

available in this tab. New to this version is the Gradient Bar when you have selected a Gradient 

Fill in the Presets panel of the Background tab... 

Using the Gradient Bar: 1. Use the Gradient Bar to select the colours you want to include in the 

gradient. By default two colours are selected and displayed on the bar like so 

. The triangle is filled with the colour to be used. 

2. Click on the to the Gradient Bar, then double-click the to open the colour well and choose 

the new colour – the new colour will then be displayed in the triangle, for example, 

.You can add as many colours as you like to the bar and you can re-arrange them by dragging them across the 

Gradient Bar.  

3. To remove a new colour then 

click on the 

button. 

button to add a new colour 

from the Gradient Bar, select the 

 4. To edit the colour of a 

open a colour well and then select your new colour – see Drop Down Colour Wells in the Help file for more 

information on selecting colours.  

5. Use the Twist and Bands options to set the number of spirals and the amount of twist for the 

circular gradients from the Styles list. 

to increase the number of twists and bands. To see what effect each of these options does, set 

them both to one first and increase the number by one and see the effect it has on the 

thumbnail displayed in the Preset box. 6. Use the Start Size option to set the width of one 

colour against the other 

in the circular gradients. Use the spin buttons to increase or decrease the start size. 7. Use the 

Offset options to set where the centre point of a circular gradient is. By default it is set to 50% 

across and 50% down, which means the dead centre of the object or page in which this gradient 

is to be used. 

8. Click the Reverse button if you want to reverse the order of the colours on the Gradient Bar. 

Vector objects can also use gradient fills – see the Help file for more information. 

Gradient Presets If you have created a new gradient style that you like, you can add it to the list 



of Styles provided by Opus. Click on the Presets button and select the Add to Presets... option – 

this will open the Fill Preset Name dialog in which you can give the new style a name... 

When you click the OK button in the dialog, the new style is added to the bottom of the Preset 

box and can be used with other pages or objects in this publication. To delete or rename the 

preset styles shown in the Preset box, click the Presets button and select the Manage Presets... 

option – this will open the Manage Preset Fills dialog in which you can select the name of one 

of the panes displayed in the Preset box and either delete or rename it. 

  



Editing Your Layout 

Selecting Objects You can select objects that already exist on your page, by using the Selection 

tool and clicking on the object with the left mouse button. A bounding box, including small, 

white boxes at the corners and sides (called resizing handles), will surround the object. Note 

that the exact style of the handles and the boundign box will depend on the settings shipped 

with the version you have bought and can be edited via the Options. 

If you place the mouse cursor over these resizing handles you will see the cursor change to a 

double arrow and a large double-arrow will also appear around the box. These are controls to 

allow you to interactively resize, rotate and skew the object as described shortly. 

Selecting Multiple Objects You can select more than one object at a time by pressing the Shift 

key down while you click on each of the objects you want to select. To deselect one object from 

the group keep the Shift or Ctrl key pressed own and click on the object again. It will then be 

removed from the selection and the dotted bounding box will disappear. Notice that the first 

object you selected has a different selection rectangle style to the others - it is surrounded by a 

dotted border rather than a dashed line. This is the primary object in the group. It is this object 

that is used as a reference if you automatically realign or resize the group of objects. So if you 

use the Make Same Size function, all the objects will be resized to the size of this one. (See Page 

117) 

Deleting Objects You can easily delete objects from your page by selecting them in the page or 

in the Organiser and then pressing the Delete key on the keyboard, selecting Delete from the 

Edit menu or right mouse menu, or by clicking the Delete toolbar button. 

If you want to delete the object but retain a copy of it on the clipboard you can use the Cut 

option from the Edit menu or the Cut toolbar button. 

Resizing Objects You can resize objects you have created on the page by selecting the object 

you wish to amend and then click on one of the resizing handles. Keep the mouse button down 

and drag the resizing handle in the direction you want to change the object’s size. 

The handles at the sides will let you resize the object horizontally, the handles at the top and 

the bottom will let you resize the object vertically. The handles at the corners will let you resize 

the object in both directions at the same time. Note that if the grid option is on the size of the 

object will jump to the next grid position. 

TIP If you press the Alt key down while resizing using the handles in the corner the object will 

retain its current aspect ratio. This will not work if the grid is on. If you press the Shift key 

while resizing this will restrict the resizing to grid intervals if the grid is not on or it will ignore 

the grid if it is on. The size of the object is displayed in the status bar as you move. Release 

the mouse button when the bounding box is the required size and the object will resize to 



those dimensions. You can also edit the size of the object via the Size panel on the General 

tab of the Properties for the object. 

You will often find it neater if the frame containing an object is the same size as the object. You 

will need it to be if you want to add a border to the object using the Border property. Opus 

provides two toolbar shortcuts to achieve this. They are also provided as options on the 

Arrange menu. 

This toolbar button is Fit to Contents and displays the object at its original size and fits the 

frame around that. 

This toolbar button is Fit to Current Size and fits the frame around the object at the size it is 

currently displayed on screen. 

Rotate and Skew You can also rotate and skew (shear) objects on screen. When you move the 

cursor over the resizing handles you will see additional arrows appear slightly offset, 

If you then move the cursor onto one of these arrows you will notice the cursor changes. When 

over the corners it becomes the Rotate cursor and over the arrows on the sides it becomes the 

Shear cursor. 

If you now click and hold down the left mouse button you can drag the mouse to rotate and 

shear the object as you require. 

TIP: If you press the Shift key while rotating or shearing this will restrict the operation to grid 

intervals even if the grid is not on. 

Editing Multiple Objects You can move, resize and/or rotate more than one object at the same 

time by selecting all the objects as described in Selecting Multiple Objects (see page 107) and 

then editing one of those objects as detailed above. As you edit one object the others will 

change appropriately as well. Note that you do not need to edit the primary object, editing any 

of the selected objects will change them all. You can also change some of the object’s 

properties in this way. If , for example, you wanted to apply the same background or a drop 

shadow to a group of objects simply select the objects concerned, press Ctrl+E or select Edit 

Properties from the right mouse menu. Any changes you make or any options you set on the 

dialog that appears will be applied to all the selected objects. Settings not adjusted via the 

dialog will remain as they previously were on an individual basis. 

Repositioning Objects 

You can reposition objects easily by clicking on them with the left mouse button and then, 

holding the mouse button down, dragging them to the new position. You can also drag objects 

off the page area itself by holding down the Ctrl key as you drag. This can be useful for 

animating objects into view although if you simply want to scroll objects on/off the page when 

they first appear or when the leave you should use position them where you want them to be 



and use the Scroll Page transition to move them there. You can reposition multiple objects by 

selecting all the objects required and dragging the selection to the location required. 

Nudge You can also nudge objects one pixel at a time in any direction by using the appropriate 

arrow keys. This can be invaluable in fine tuning the position of objects so that they align with 

other elements on the page. 

Position Alternatively you can edit the exact location by setting the co-ordinates on the General 

tab of the Properties dialog for that object. This can be useful for setting a very precise location 

for the object. 

Grouping Objects There are two ways of grouping objects together in Opus depending on 

whether you simply want to collate some objects for organisational reasons and to make them 

easier to reposition and resize or whether you want the whole group of objects to be able to 

respond to triggers and undertake actions. 

Group The first Group option will simply organise the objects into a group for you to manage 

more readily in the editor. The biggest benefit of this is that all objects in the group can be 

resized as one and can also be easily repositioned beyond the original boundaries of the group. 

The Group object cannot have actions attached to it but actions on other objects can refer to 

the group thus allowing you, for example, to hide/show or animate the group using a button. 

Group as Frame You can combine groups of objects together by placing them on the same 

frame. The frame itself does not need to have any visible attributes and other, independent, 

objects can be drawn over the top of it. This allows the whole group of objects to have actions 

attached to it. Note that resizing the frame does not change the size of the objects contained 

There are a number of ways to do this but perhaps the simplest is to select the objects you 

want to group together and select Group Objects by Frame from the right mouse menu or from 

the Arrange menu. Alternatively, to create an object as part of a frame, select the frame first 

and then draw the new object onto the frame. Objects, which are sub-elements of a frame, 

appear in the Organiser as a sub- tree off the appropriate frame. 

To add an object which has already been drawn click, on it with the right mouse button in the 

Organiser and drag it onto the name of the frame you want it to become part of. A small menu 

will appear from which you should select the Insert Into option. This will then move the object 

onto the frame. 

Changing Group Style You can convert a frame group to a simple group and vice versa by using 

the relevant commands on the right mouse menu. Please note however, that converting a 

frame group to a simple group will result in any actions or attributes on the primary frame 

being lost. 

Ordering Objects Opus offers you full control over the order in which the objects on the page 

appear, and thereby whether an object appears over or under another. As well as fundamental 



design control, this allows you to hide irregular hotspot buttons under an illustration, put a 

caption on video and even make animated objects move between scenery objects. Note that 

this ordering is different to the Editor Layers provided in some versions of Opus. These Editor 

Layers are simply to assist with design and layout of complex publications in the editor and 

have no bearing on the final publication other than establishing the order of objects in the 

Organiser. The layering of objects is represented in the Organiser. The higher up the Organiser 

listing the object is, the nearer the top of the page it will appear. 

In this example Text 1 is above Video 1 whilst Text 2 is underneath. The order of objects is 

initially the order in which they are created but you can reorder them by simply dragging them 

up and down the Organiser tree. Note that dragging objects, which are positioned on a frame, 

may drag them off the frame and make them no longer part of that group. Alternatively you 

can move an object up or down one layer by selecting it on the page and choosing Move Up or 

Move Down from the Layer option on the Edit or the right mouse menu. You can quickly bring 

an object to the top of the page or send it to the back of the page by selecting Move to Front or 

Move to Back from the same menu. 

Triggering Across Layers By default, the layers of objects are completely transparent to mouse 

clicks so that actions on objects underneath others are still triggered by the mouse click, even 

though they are not visible. You can change this by altering the options below which are 

provided on the General tab of the Properties for an object. 

This is set on an object by object basis, but if you want to block a series of objects you can do so 

by creating a transparent object specially and making this a barrier. You can also have active 

objects above this barrier if you want. 

Aligning Objects Automatically In addition to using the grid to ensure that you draw and position objects in the 

right place, you can also align objects automatically. You can make a group of objects align with each other by 

selecting the objects you want to align and then selecting the relevant option from the Align submenu of the 

Arrange menu. The effect they have is as follows...  

 Align...Top 

 Align...Bottom 

 Align...Left 

 Align...Right 

 Align...Centre Horizontally 

 Align...Centre Vertically 

You can also select Both which combines both horizontal and vertical centre alignment. If you 

wish to centre the selected objects on the page you can select Centre on Page from the Arrange 

menu and then choose Horizontal, Vertical or Both as appropriate to your requirements. Note 

that when multiple objects are selected, the combined selection is centred and the relationship 



between the individual objects is maintained, the individual objects themselves are not centred 

in relation to each other as they would be with Align...Horizontal Centre. 

 

Original Combination of Objects 

Centre...Horizontally Centre...Horizontally Centre...Horizontally 

Align...Horizontal Centre 

Text and button captions are aligned left to right using the standard text alignment controls 

from the Format toolbar, or the Justification submenu of the Text menu. If you want to align 

text vertically to the top, bottom or centre of its frame this option is available on the Text tab of 

the Properties dialog. 

Align Rotation or Skew There are often times when you want several different objects to be 

rotated or skewed by the same amount. This can be tricky to achieve manually so Opus 

provides Align Rotation and Align Skew on the Arrange menu to do this automatically. The first 

object you select will set the rotation or skew which will be copied to the other objects.  

Spacing Objects Automatically Often when designing interactive multimedia you will have a 

series of similar objects on the page, a row of images, or a column of buttons. These look 

neatest when evenly spaced, which can require some care to achieve manually. Opus provides 

a shortcut via the Space Evenly option on the Arrange menu. Selecting this produces a 

submenu, which allows you to space the object evenly across the page or down the page. The 

function will space all the objects evenly between the two outermost objects. 

In addition there is an option allowing you to stack objects across or down the page. This will 

cause the objects to be positioned exactly alongside each other in whichever direction you have 

chosen. Again this is available by selecting Stack from the Arrange menu. The above options 

only apply to selected objects and require that two or more are selected. 

Making Objects the Same Size Similarly your design is likely to include objects that will look best 

if they are the same size. Opus provides a shortcut for this too with the Make Same Size option 

on the Arrange menu. This function applies to multiple selected objects and uses the first object 

you selected (the primary object) to set the size for the other objects you have selected. 

Selecting this option brings a submenu allowing you to choose whether to make all the objects 

the same width, the same height or both. 

Reducing Screen Clutter If you are developing a moderately complex publication or page, your 

screen can become very cluttered. It can be therefore very useful to reduce the muddle of 

objects you are not currently working on. Opus provides several ways to solve the problem of a 

cluttered page. 

Outline Mode This mode simply displays the object as a box outline and does not display its 



content. The name of the object is provided for identification purposes. Thus 

becomes: 

You can either switch individual objects to outline mode or the whole page. Individual objects 

are switched in and out of Outline mode by selecting the relevant objects on the page or in the 

Organiser, and selecting Outline from the right mouse menu. You can switch them back from 

outline mode by selecting Show in Editor from the right mouse menu. You can switch the whole 

page to outline mode by selecting Outline from the View menu, pressing F8 or by clicking the 

Outline button on the toolbar. 

Objects that have been individually set to Outline mode will not be affected by the overall 

setting. All objects will still appear when you preview your page. 

Hiding Objects Completely At times even the outline of an object can be irrelevant clutter so 

Opus also offers you the option of concealing the object entirely. This can be particularly useful 

if you have a very complex page and want to concentrate on particular portions of it at one 

time. It is also useful if you have objects that, once complete, are not relevant to the ongoing 

design of the page and are therefore better out of sight. An example of this might be a set of 

text objects being used as tool tips. Select the object or objects you want to conceal and select 

Conceal in Editor from the right mouse menu. The object will no longer be visible on the page 

though it will still display when you preview the page. You can now only select this object in the 

Organiser view where it is displayed in grey to indicate that it is not visible in the editor. 

Show Selected Only In addition to the above options, Opus offers a further control to reduce 

screen clutter. This option allows you to see only the currently selected objects. It is, in essence, 

a quick way to switch any object you are not working on to Conceal in Editor and back. Select 

the object you want to work on, together with any associated objects, and then select Show 

Selected from the View menu or click the optional Show Selected button from the toolbar. 

If you have chosen to keep multiple objects in view you can change your selection once the 

other objects have been concealed. 

Editor Layers  

The higher level versions of Opus such as Opus Pro which are intended to be used for more 

complicated publications provide a further facility to reduce screen clutter and organise the 

various sub-elements of your page. 

You can set your page to use Layers and this enables you to place objects or sets of objects on 

different layers and to show and hide different layers as you work. You can reorder the layers 

and, most usefully you can set the layers to view in an onion skin mode which means the layer 

you are currently working on is the only one fully visible and layers either side of it are partially 

transparent so that you can use them as reference but it is still clear what objects are part of 

the active layer. A layer palette is provided in the bottom left hand corner of the Workspace to 



allow you to reorder layers and switch through the different viewing modes. Full details are 

provided in the Help file. 

Undo and Redo  

Opus provides a multilevel Undo, which allows you to go back and undo your previous actions. 

The Undo option is provided on the Edit menu and will change to reflect the action selected 

e.g.: Undo Create Object, Undo Delete etc. If you change your mind at any point you can redo 

an action you have undone by selecting Redo from the Edit menu. Alternatively both of these 

options are available on the toolbar where you can click on the arrow alongside the toolbar 

button to see a list of all your recent actions so that you can undo back to a certain point by 

selecting the last action you want undone. 

In the illustration above all the actions up to and including the highlighted action “Modify 

Properties” would be undone. Redo has a similar list, which works in the same way but in the 

opposite direction. 

Reset In addition, there is a Reset option, which allows you to quickly, and easily reset skewed 

and rotated objects to their original orientation. This option is available on the Edit menu or the 

right mouse menu. 

It allows you to reset rotation, horizontal and vertical skew, transparency or all transformations 

at once. 

  



Adding Content 

Once you have created an object you will need to edit its properties, most notably its content. 

You do this via the Properties section of the settings dialog, which provides a set of tabs to 

access the various sets of properties as appropriate. 

You can call up the settings dialog for any object by double-clicking with the left mouse button 

on the selected object or by selecting Properties from the Edit menu or from the right mouse 

menu. Then select the Properties tab if that section is not already to the front. For each object 

at least one tab will be different and will be named after the object to which it refers. This is the 

tab that allows you to set the content for that object and the properties for that particular 

content. The other tabs provide properties applicable to the object irrespective of its content. 

The way to edit the content is slightly different for each object. The remainder of this chapter 

deals with the Properties of specific objects and the following chapter outlines Properties which 

apply to all objects. Some of the more advanced Properties are only introduced briefly here so 

that you are aware of their existence. We recommend these features are reviewed via the Help 

file when and if they are required. 

Frame Properties Frames have no specific content themselves and are designed to contain 

collections of the other objects that you wish to keep together. They do not have a Properties 

tab of their own. Any other objects can be drawn onto a selected frame and will become a sub-

element of the frame and you can edit the individual properties of those elements as 

appropriate. Frames are also intended to act as design elements by providing panels or borders 

but in these cases they have no contents. The other properties (Background, Border etc) can be 

set as appropriate. 

MultiFrame Properties 

Multiframes allow you to create a series of frames which can be shown automatically in turn or 

on command. They are a sort of slideshow of frames. This allows you to reveal combinations of 

objects at the same location or to provide animations created from a series of objects or 

combinations of objects. Only one frame of a multiframe is visible at a time. You cannot overlay 

one frame with another. Note that the selection bounding box of a multiframe is slightly 

different to most objects. There are two bounding boxes, the outer one represents the 

multiframe and the inner one represents the constituent frame. You can change the selection 

via the Organiser or by clicking with the Alt key held down. The Multiframe tab allows you to 

set the multiframe to play automatically and to set the properties for that replay. 

You can set the time for each frame to be displayed but typing it into the eidt box or using the 

spin buttons to change the setting up or down. Note that you need to take into account the 

length of time taken by any transitions you have applied to individual frames. You can also set 

the frame to play just once, a specific number of times or to replay continuously until the page 



changes. 

Rollover Properties Rollovers are special kinds of multiframes which have sections specific to 

mouse events. Thus you can create a combination of objects for when a mouse moves over the 

default set of objects or when the mouse button is pressed down. This is particular useful for 

creating tooltips on objects. 

Only one frame of a rollover is visible at a time. You cannot overlay one frame with another so 

consistent content must be copied and pasted onto each frame as required. 

The rollover tab simply lets you specify which state you want a frame for. In most case you will 

want to leave all these options checked so that they are available if required. 

Text Properties Text can be typed and edited directly onto the page. When you create a Text 

object, or if you click in a Text object that has already been selected, the cursor will change to 

an I-beam and you can type directly onto your page as you would in a word processor. The 

fundamental properties of text, font, size and effect (bold, italic etc.), can be applied by 

highlighting the text to select it, and then choosing the attributes required from the Format 

toolbar or from the Text menu. 

These are mostly the formatting commands familiar from any other Windows program which 

handles text but there are one or two which might not be immediately obvious. The two 

buttons alongside the font size allow you to increase and decrease the font size from the 

existing one rather than select it from the dropdown list. 

Allows you to choose and apply graphical bullets. The selection of bullets 

available is provided on a dropdown palette. Note that the colour of some of the bullets is set 

by the current fill and outline settings. There are also a couple of unusual formatting functions 

- Sets text to outline format. 

Density Justification and 

Aspect Justification. 

These are similar to the more familiar Full Justification which spreads the words across the page 

but does not change the size of them. The Density Justification also spreads the words and does 

not change their size but puts spaces between the characters in a word. The Aspect Justification 

spreads the words but stretches the words to fill the space as well. The illustration below 

illustrates the results of these when compared to the more familiar Full Justification 

The Density and Aspect methods can provide some visually interesting effects. 

Applying Colour To apply colour to the text select the text and click on the colour you require in 

the colour palette. To give the text a background colour click on the colour palette with the 

right mouse button. (Note that this is not the same as the background for the text object.) 



TIP If you want to apply text attributes to all the text in an object you do not need to use the 

I-beam cursor to select it. Simply select the text object and apply the formatting you want. 

Additional Text Properties The text properties tab provides additional formatting options 

including the vertical alignment of text in its container frame. The margins between the frame 

and the text and whether the text is ant-aliased or not. 

The other options on this tab refer to more advanced features which are detailed in the Help 

file. They allow you to specify text styles for specific uses of text such as when autonarrating or 

for hypertext. There are also options to allow you to set how the text is displayed in the 

container, whether to prevent lines being cut off at the bottom of the container or whether to 

show only one paragraph at a time. This latter can be used with the text scrolling actions to let 

users move through text a paragraph at a time without scrolling – a much more civilised way of 

reading large amounts of text on screen. 

Inserting Text from a Disk File You can also load text that you have created in another 

application, rather than type it directly in Opus. To do this, create or select a text object and 

then click the Insert from file button on the Format toolbar or the Text menu. This permits the 

loading of Rich Text Format or standard ASCII text. 

Adding Scrollbars If your text is too long for the object you want to display you can add a 

scrollbar to allow the user to scroll through the text. These scrollbars are highly customisable. 

You can change the colours of the buttons, the thumb and the background. You can even use 

graphics for the buttons for even greater versatility. This is explained in further detail elsewhere 

in this manual. 

For the moment it will suffice that to add a scrollbar to a piece of text you simply select the text 

and then click the Add scrollbar button or select Add scrollbar from the Text menu. 

Linking to a Disk-based Text File You can also set a text object to display a text file, which it 

loads from disk when the publication is being used. This is useful for displaying text which is 

updated independently of the publication or which is actually generated during use of the 

publication. To do this, create a text object as usual and set the font properties required 

without any text being included. Go to the Text tab on the Properties dialog and check the 

Automatically read in this disk file option. Then type in the path and name for the text file you 

want to load or use the Browse button to locate it if it exists in the same location on your 

system. 

Whether the text object contains text now is obviously dependent on whether the text file is 

present on your system. If the file isn’t on your system we suggest you use a mock file to ensure 

that the function is working as you require. We also recommend that you attach a scrollbar to 

this text object unless you are very confident that the text this may be asked to contain is never 

going to be more than the object can display. Opus will not automatically add a scrollbar if too 



much text is loaded. 

Replace Fonts There are often circumstances where you want to change the fonts used 

throughout a publication or page template. This may be because your corporate style has 

changed or because the fonts in the page templates don’t fit with your required design or 

corporate style. Rather than having to go through each page individually to change the fonts, 

Opus provides the function to replace all the occurrences of one font with another. Select 

Replace Fonts from the Tools menu. This will bring up the Replace Fonts dialog. Here you can 

choose the font you want to change and choose the font you want to replace it with. 

The existing text formatting will be preserved wherever possible. In some cases, however, 

depending on the font chosen, it may not be possible to preserve bold and italic settings. 

Insert Special Characters There are occasions when you wish to include special characters such 

as copyright or trademark symbols in your text. Many special characters are included in basic 

fonts and there are also dedicated symbol fonts such as WingDings which provide entirely 

graphical characters. But in both cases it can be difficult to remember which key or key 

combination produces them, even if you can recall which font includes the symbol you are 

looking for. Opus provides a visual shortcut to this via the Insert Character function on the 

QuickBuild menu. Choosing this option will bring up a dialog which will allow you to choose a 

font and then review the characters available in it. 

Simply double-click on the character you want to insert or, if you want a combination of 

characters, select the character and press the Select button so that it appears in the edit box. 

Once the set of characters is as required press the Insert button to place the chosen characters 

into your text. 

Checking Spelling 

Opus includes built-in spell-checker. It is possible to switch this on to check spelling as you type 

but note this as it can slow down text input and import, especially where the text includes 

variables. It is available to check the spelling on your page/chapter/publication at any time by 

selecting Check Spelling from the Tools menu or by pressing F7. This will call up the following 

dialog. 

This allows you to specify how much of your publication you want to check via the options in 

the Search Scope: drop down list which allows you to select chapter, page or publication. And 

then begin checking spelling by clicking on the Start button. As with most spell-checkers, 

whenever the function finds a word it does not know it puts it into the Unknown Word box and 

makes any suggestions for correct spellings in the Suggestions list. If necessary you can then 

select one of these suggestions so that it appears in the Change to: box and click the Change or 

Change All buttons as required. Further details and instructions for the other aspects of the 

spell-checker are provided in the online help which you can access by clicking the Help button 



on the spell-checker dialog. 

Find and Replace This option allows you to search your publication for a specific piece of text 

and replace it with another if required. Select Find from the Tools menu or press Ctrl+F4 to call 

up the Find dialog. 

Type the text you want to find in the Find box and check the Match case checkbox if you want 

the function to look for the text with the same mixture of upper and lower case letters. If you 

want to replace this text with another piece of text, type the replacement text in the Replace 

box. Then click on whichever Find or Replace button is appropriate. If you click the Advanced>> 

button you can see a list of the instances of the text you are looking for and you can quickly 

jump to one of those by selecting it and pressing the Go to button at the bottom. 

Text to Vector You can convert any text in a Text object a vector. This means you can create 

text and format it using the Format toolbar and then convert the text to a Draw object that you 

can then reshape. This is particularly useful if you want to create an interesting visual effect 

with your text – you stretch it, skew it, add gradient fills to each letter and so much more. Once 

you have converted a Text object to a vector it becomes a Draw object. This means you cannot 

format the text using the Format toolbar or retype the text that has been converted. 

Button Properties The content for a button is simply its appearance, which can be set up via the 

Button tab of the Properties dialog. The Colour panel of the Button section of the Button 

Properties dialog allows you to customise this basic button style... 

Light Bevel 

Outline 

Dark Bevel 

Surface 

You can choose a custom colour for the surface and both the light and dark bevels for the 

button. Click on the arrow beside the relevant colour well and then use the Opus colour palette 

to choose a colour as explained previously.You can also choose the width of the bevel by using 

the spin buttons to increase or decrease the width of the bevel. You can choose to have no 

bevel at all which allows you to have a flat panel as a button. 

You can also specify the transparency for the bevels via the Bevel Transparency option: 

You can also choose to add a simple black outline to the whole button by checking the Add 

outline option. This helps to separate the button from the background and is therefore 

particularly useful where one of the bevel colours is similar to the background colour of the 

page. A basic button with a bevel automatically sinks when pressed, but you can also set 

particular properties for certain different states of the button by clicking on the relevant icon in 

the box on the left and then editing the properties of the button to suit. 

So, for example, if you wanted to make a button go red when the cursor moved over it, simply 



select the Mouse Over Appearance icon. Then click on the Colour checkbox and select red as 

the surface colour. If you do not set any options for a particular appearance, Opus will use the 

default settings or the settings implied by the Normal Appearance. You do not have to use 

different styles for each state; they can be the same or you can miss them out altogether. 

Graphical and Icon Buttons You can also make a graphical button by using the Image section of 

the dialog and either choosing specially-designed images to represent your button instead of 

the standard format (in which case you should click the Colour checkbox on the Button tab off) 

or to combine the two and load an illustration onto a standard button. You can find the image 

you require by using the Browse button to navigate to the correct location and then click on the 

As with all Opus file dialogs a preview box is provided for you to view your selection before 

loading it and there is a drop down list box for your most recently-used directories so you can 

quickly browse the locations you use most often for graphics. There is no need to use graphics 

that look like buttons if you do not wish to. You can use images of objects, characters, icons or 

images of 3D text as captions. Finally, as with standard buttons, you can use different graphics 

for different states of the button (when the mouse cursor moves over it, when the button is 

down, etc.) by selecting the relevant state from the icon list at the left of the dialog and then 

loading a new graphic or variation on the same. You can use the Transparent option to ignore a 

certain colour in the image. This is most useful for ignoring the background of the image file 

and leaving just the object as an irregular-shaped graphic. Note that to prevent the transparent 

area still being receptive to the user’s mouse click, you should go to the General tab and check 

the Ignore transparent region option so that it is on. 

Icon Buttons By giving your button an image as well as you can combine the basic coloured 

button with a graphic button to create a standard icon button, which also has a graphic or icon 

on it. Obviously this only works where the graphic is smaller than the button or the background 

will not be visible. 

Invisible Buttons In some circumstances you may want to use invisible buttons, for example, as 

hidden hotspots underneath particular areas of larger graphics. To create an invisible button 

simply click on the Colour option so that it is off and do not load a graphic or give the button 

any other characteristics. The button will now have no content and therefore not be visible, but 

will remain active. In most circumstances, however, you should use the Hotspot tool to draw 

whatever active area you want. This is further explored in the Irregular Hotspots section of 

Advanced Techniques. 

Animated Buttons As all objects can have actions just like buttons, you can create animated 

buttons by building a slideshow from graphics that look like buttons. Alternatively you could 

give a video or animation a Raised style Border to make it look like a button. Several examples 

are provided in the examples and component galleries supplied with Opus. 

Caption In addition, the button can contain a caption. This is a piece of text overlaying the 



button itself. 

Click again on a selected button and the cursor will become an I-beam allowing you to create or 

edit the text for the caption just like an ordinary text object. You can set the font style, size, 

colour and alignment just as you do for ordinary text. 

Button Types You can also choose different styles of behaviour for your button. 

It can be a standard style button, which drops down and then pops back up when clicked. 

Alternatively it could be a button that works like an on/off switch where you click it to switch it 

on, the button stays down until you click on it again to switch it off. Finally, you have the option 

of setting the button to act like a radio button – for this you need two or more buttons set to be 

radio buttons and given the same Group ID number. This means that the buttons are connected 

and only one can be down at any one time. Clicking on one will cause any others in the group to 

pop up. Note that the special variables are provided for you to quickly store the state of radio 

buttons so that you can then act according to which is set. This is detailed in the Help file. 

Borders As with other objects you can add borders to buttons via the Borders tab. Please note, 

however, that using a border will negate the built-in bevel edges and the button will not 

automatically drop down when pressed and the button styles will not be apparent. 

Image Properties This content tab is available in the properties for most objects and is not 

exclusive to Image objects. The Image tab of the Properties section of the dialog allows you to 

load and set up an image in any of the supported file formats (see the online Help for details of 

currently supported formats). Simply click the Browse button to bring up a standard Windows 

Open dialog to locate and select the image you want to display. The filename box also has a 

drop down list of most recently-used files so that you can try several images quickly. If you wish 

to remove an image and no longer display it, simply select None from the drop down list box. 

As with all images in Opus, you can then choose how the image will be displayed in relation to 

the box containing it. You can keep it as Fixed at the starting point of the box (the top left 

corner). You can Tile it across the box so that it is displayed repeatedly across and down until 

the box is filled. You can also Centre the image in the box. Finally, you could choose to stretch 

the image to fit the container you have drawn, keeping its proportions (aspect ratio) if you 

prefer. Keeping the aspect of an image prevents it looking stretched out of shape. All of these 

options are simply chosen by clicking the relevant radio button or checkbox. 

You can also choose to ignore one of the colours in the image and let the background show 

through. This is most often used to remove the background of an image so the subject of that 

image is incorporated alone as illustrated: 

No colour is transparent 

White is transparent 



With the subtlety of colour modern systems can now display it can be difficult to judge the 

required colour by eye therefore, the colour-picker tool is the best way to choose the 

transparent colour as you can pick it from the copy of the image displayed in the preview box. If 

you find that the background is not fully removed it probably means that across what appears 

to be a flat colour there are variations in the hue of the colour you have chosen. You can use 

the tolerance slider beneath the edit box to increase the range of that particular colour which 

will be ignored. 

Video & Animation Properties 

The Video tab of the allows you to load and set up a movie or animation in any of the 

supported file formats (see Help for details of currently supported formats). This includes 

animated GIF files (these should not be loaded as image files). Simply click the Browse button to 

bring up a standard Open File dialog to locate and select the video or animation you want to 

display. As with still images you can choose to tile, centre or stretch the video to fit. In addition 

you can set the video to start automatically so that it is always running when the page is 

opened. You can also specify whether it is visible only when it is actually running. With this 

option off a frame of the video will be displayed even when the video is stopped. By default this 

will be the first frame but there is an option for you to pick a specific time from which the 

preview frame should be taken. This is useful for videos with blank or unhelpful first frames. 

When the video stops the frame it stops on will be displayed. You can mute the audio 

soundtrack if it has one. There is also a Video display type which can be changed via a Change 

button which allows you to set different ways in which the video will be displayed. 

The default setting is to use a chromakey mode which is the best compromise between 

allowing Opus functionality and displaying the video at the best rate. You can also choose to 

make the video Always on top which means it will play in a separate area and will always 

appear over the top of anything else in your publication. You will only need to change these 

settings if you have particular requirements and should review the information in the Help file 

before doing so. You can also set the video to play once, continuously, or for a specified 

number of times. All these options are set by clicking the appropriate checkbox in the selection 

of options on the left side of the dialog. 

Slideshow Properties When you call up the Properties for a Slideshow there is a Slideshow tab 

which allows you to select and organise the contents. This is basically a series of image files 

displayed in turn. It can be used simply for displaying a series of pictures or it can be used for 

animation by replaying the frames of a cartoon. In the former case, remember that pressing a 

key or using the Play Slideshow action can control each frame of the slideshow - slides do not 

have to advance automatically. In the latter case remember that the smaller the area being 

animated, the better, so it may pay to only animate parts of an object. 

You can choose the images included in the slideshow by clicking the Add button. This will bring 



up a standard Open dialog for you to locate the images you want. 

TIP You can select more than one filename in the dialog by holding down Ctrl whilst clicking 

on each name. If you want to select a range of consecutive images use the Shift key whilst 

clicking on the first and last names in the range. 

The images will then be listed in the order they will be displayed. If you add the wrong file you 

can select it in the list and then press the Remove button to remove it from the slideshow. If 

the images are in the wrong order you can reorder them by selecting one or more images and 

using the Up and Down buttons to move them through the list. 

TIP Selecting multiple files in the slideshow list allows you to apply the same transition and 

timing to a number of slides at once. 

Slide Timing You can set the time each slide will be displayed on screen during the slideshow by 

selecting it and then using the spin buttons on the Slide timing edit box to increase or decrease 

the value as required. 

Transitions You can also specify a transition effect with which the image will be drawn onto the 

screen. The transitions available are the same as those available for all other objects. You can 

select the transition required from the drop-down list of the most popular transitions or you 

can select from the complete range of transitions by clicking the Browse button. This calls up 

the Transition dialog on which you can pick a transition by selecting one of the groups of 

transitions listed down the left and then selecting the icon for the transition required. 

TIP The Slide transition is a special transition for slideshows, which can be particularly 

effective as it results in one image being pushed aside by the incoming image. 

Exclusive Windows and NT are multitasking environments and Opus is a multithreaded 

program, which may mean that other events on your publication page could interfere with the 

speed of your transition effects or even make them pause momentarily. We have therefore 

provided an Exclusive option. 

This option allows you to make the transition effects run with a much higher priority than 

normal. This means they will be quicker and smoother, but it also means that any other activity 

on the page will be delayed until the transition has finished. For example, the object will not 

register a mouse click to trigger an event until the transition is finished. 

All Files There is also a special All Files option for slideshows. 

This tells Opus to create the slideshow from all the files in a particular directory at the time 

when the finished publication is run. This is useful, for example, for creating a simple generic 

picture viewer by creating a generic slideshow, which automatically views all the pictures from 

a Photo CD. You can then change the CD for another Photo CD, as long as the images are in the 

same place, the slideshow will now display these. It might also be used to provide a generic 



slideshow where a third party will edit the pictures the slideshow should contain. When you 

select this option, the dialog will change to include the edit box below where you can type the 

directory where the files are held, or you can use the Browse button to locate the directory.  

Other Properties You can specify how the slideshow should display the images (centred, tiled 

etc.) as with static images, and as with Video, you can specify whether the slideshow should 

play a set number of times or continuously until it is explicitly stopped, or the page is turned. 

Displaying Slides Randomly 

If your slideshow is not linear you may wish to display the slides in the slideshow randomly 

each time it is run. This is common, for example, in rolling promotional presentations used to 

present a series of highlights at exhibitions, or in shop windows or foyers. You can make your 

slideshow random by clicking the Random checkbox at the bottom of the Play panel. 

Starting Automatically 

You can set the slideshow to be self-starting by clicking on the Auto Start option. As with Video 

this means that you do not need any action to be performed for the slideshow to start playing. 

Text Input Properties This is a variation of a text object and can be created from any text object 

but is provided as a separate tool for convenience. It is a box, which accepts text input from the 

user and as such has no content until the user puts it there. Its properties are automatically set 

up to look like a familiar text edit box but you can change these to suit. The other section of the 

dialog can be used to change these properties as with any other object. The subject of text 

input is dealt with in more detail on page 281 in the Advanced Techniques section. 

Browser Viewport Properties This object provides a live view of an Internet page. This means 

that it can display a web page that will respond when you click on the links on that page. Its 

content is therefore an HTML file that describes a web page. This can either be on disk or on 

the Internet itself. You specify the HTML page you require by typing the full address (or URL) in 

the box provided. If the file is on the current computer rather than the Internet you can use the 

Browse button to locate it. 

If the page to be displayed is on the Internet itself you can tell Opus to automatically connect to 

the Internet to see this file by clicking the checkbox provided. 

You can, however, allow your user to sanction this connection. 

You can also specify that if the internalised browser does not launch then the publication will 

launch the users stand-alone browser to show the page. In this instance, however, you will not 

be able to use the actions in the publication to control the browser. 

Status Bar The only other content the Viewport can have is a status bar, which will keep the 

user updated with the status of the connection to the Internet and a simple outline. Either of 

these can be switched off if this doesn’t fit with your page design, but we would recommend 



you keep the status bar on so that your user knows what is going on. 

Note: The use of the Browser Viewport requires Internet Explorer v3 or higher, or Windows 98 

or higher to be installed on the recipient’s machine. 

DocView Properties This object allows you to create a live Viewport for any active X document 

such as a Word document, an Excel spreadsheet or a PowerPoint presentation. You will be able 

to move through slides or scroll through text and the items will be formatted exactly as they 

would in their native programs. Use the Browse button to locate the document you wish to 

view. It must be in the same location on your user’s computer This object uses the inbuilt 

viewing facilities provided by the compatible software and therefore the software for 

documents you are viewing must be installed on your computer and on your user’s computer. 

Other Properties 

The rest of the property dialog tabs are the same for all objects, though not all are necessarily 

available for all objects and only a selection of these properties apply for different appearances 

(see Setting Different Appearances)... 

General Properties The first tab of any Properties dialog allows you to specify precisely the size 

and location of the object and to edit its name. However, its main use is to let you easily set 

some display criteria for the object. Firstly you can set the object to be hidden. 

This means it will not appear when the page first opens but will wait until you use an action to 

display it. For example, this can be useful for message boxes or for revealing an illustration or 

definition of something in the main content of the page. A shortcut button is provided for this 

on the toolbar. If you want the hidden object to appear after a certain length of time 

irrespective of what the user may do, you can tell it to display after a certain time. Simply check 

the Show after box and set the time interval in the edit box by typing it in or using the spin 

buttons. 

If you want an object to stay displayed for only a certain length of time, whether it was initially 

hidden or not you can set this using the Timing panel. 

Simply check the Display for box and set the time interval in the edit box by typing it in, or using 

the spin buttons to. Now, whenever the object is displayed it will stay on screen only for the 

time specified. This is particularly useful for prompts, message boxes and the like. The other 

important option to note here is the Ignore Transparent Area which ensure that the object only 

responds to triggers referring to the object itself and not its surrounding bounding box. This is 

key for se with hotspots or with collision detecvtion triggers. Like the other options on this 

dialog, this is dealt with the Advanced Features section of this manual and in the Help file. 

Background Properties You can set the background for an object in the same way as described 

for setting the page background (see page ). Obviously the background will not show up if the 



object contains an image or video that completely fills the object. 

TIP It is can be very effective to combine a background with the Transparency effect 

described later to let an object sit on a tinted area of the page background. 

Border Properties This section allows you to specify a border to the object. This is one of the 

most versatile features of Opus and as it allows you to shape and surround objects, including 

video, it offers opportunities for some exciting effects. There are several different types of 

border available here and they are divided into categories. Choose the category from the first 

drop down list box and then choose the specific border you want from the list below it. In the 

basic category of borders there are some presets which have additional propeties you can set. 

The different types of borders provided across these categories include... 

• line borders (plain, double, neon, sunken etc), 

• borders which display the object within a particular shape, either a basic polygon (ellipse, star 

etc.) or more complex shapes (UK Map, Think Bubble etc.), and... 

• graphical borders which both shape the object and surround it with some graphical design 

(e.g.: Pinned Up, Film Frame etc.) Some of the most useful border styles are detailed below. To 

view the others we recommend you simply select them and see their effect in the Preview 

window where the border is combined with a thumbnail of your current object. 

TIP Additional borders can be added to Opus without updating the program by adding 

appropriately formatted WMF graphics to the Borders subdirectory of your Opus installation. 

See the Help file for further details. 

Plain This places a single line border around the object. It uses the width specified in the Width 

box (use the spin buttons to increase or decrease the value) and the colour specified in the 

Primary Colour well. (See page 70 for details of changing this colour or choosing a custom 

colour.) 

This style can be customised to provide an additional border style by clicking the Round Corners 

checkbox and setting an amount of curve for the corner. 

Double This border style is a variation on Plain, which draws two parallel lines in the primary 

colour and uses the secondary colour to fill the gap between them. 

Ellipse This border displays the object in an ellipse. It is the only shape border that uses the 

internal line settings so you can put a line around the edge using the Width and Primary Colour 

settings. 

Raised/Sunken These are very useful border styles in that they can provide a bevelled edge to 

the object using light and dark bevel edges. This makes the object look raised or sunken in the 

manner of many panels and buttons in Windows, creating a look familiar to Windows users. 

The Width sets the width of the bevel, the Primary Colour is used for the light bevel and the 



Secondary Colour is used for the dark bevel. The Transparency setting can be used to make 

these edges partially transparent so that the object itself shows through. Use white and black 

with a reasonable amount of transparency and you can tint the object or the background to 

look as though the object is bevelled. 

Note however, that using the same colour for the bevel as the background of an object may 

result in the bevel becoming the same colour as the object and not appearing. 

Other Styles  

Other borders are provided offering graphical borders and shapes but these are used as is and 

do not have additional controls or settings. 

Effects Properties  

This section of the dialog allows you to set up special effects for the object. You switch on the 

effect you require by clicking on the box next to it in the list so that a tick appears. 

The relevant options for this effect will then be available on the section to the right and you can 

set them up there. Several of these effects are available via shortcut buttons on the toolbar, 

with drop down palettes providing the most common examples. See Toolbar Shortcuts to 

Properties. 

Stretch  

This effect allows you to stretch an object horizontally, vertically or both. Whilst this simply 

performs the same action as you resizing the object in the editor it is done on command and 

can be useful for automatically resizing objects for different appearances. For example you 

might want to select the Mouse Over appearance of an object and then enlarge it by 10%. This 

way the item will grow by 10% every time the mouse moves over it. Use the spin buttons or 

type the figures to set the edit boxes to the required size you want the object to be as a 

percentage of its current size. 

Flare  

This very useful effect applies a glowing effect to the object. 

You can set the colour by selecting it from a standard colour well or creating a special colour via 

the Custom option. 

You can control the width of the flare... 

...and how transparent it is... 

...and the amount it fades at the edge. 

You can quickly apply or switch off the preset Flare styles in the current Flare colour via a 

shortcut button on the toolbar. 



Again this is particularly effective when used as for the Mouse Over appearance as it then 

highlights the object when the mouse moves over it. 

Texture  

Opus also allows you to apply a texture or bump map to an object. A variety of presets are 

provided which you can simply select from the list provided. Alternatively you can use any 

bitmap graphic by selecting the <custom> option at the bottom of the list and then using the 

Browse button. The colours in the bitmap will be translated into bumps for the texture on the 

basis that the brighter, lighter the colour will be the higher the bump. 

Animated Textures  

You can have animated textures by selecting animated GIF files using the <custom> option 

explained above. 

Blend  

This is a potentially spectacular feature providing alpha channel blending which basically allows 

you to apply a pattern of transparency to the object, rather than the overall Transparency 

option, which affects all areas of the object equally. There are a number of preset options 

providing graduated transparency in various directions, and patterns and shapes, which you 

select from the list provided. You can also add your own via the <custom> option at the bottom 

of the list. This allows you to browse for a bitmap graphic file to use as the effect. Once 

selected, Opus will use the level of light and dark in the image to set the level of transparency 

of the object where light areas are the least transparent and dark areas the most transparent. 

Animated Blends You can even have animated blends by using the custom option to 

incorporate an animated GIF file. Please note that these will only be successful on higher end 

computer systems if there is lots of other animation and transitions on the page and should be 

used sparingly. 

Shadow  

This option creates a drop shadow of the object. The Width setting lets you specify how far the 

shadow is from the object in pixels. 

The Shadow Position settings let you specify where the shadow will fall in respect to the object. 

The Transparency setting lets the background show through as you would expect with a 

shadow. You can also specify a Colour by selecting it using a standard Opus colour well. 

As with the Flare effect you can also set how much the shadow blurs at the edge. 

Transition Properties This section of the Properties dialog allows you to specify a special way in 

which the object will appear on screen, such as slide or scroll or fade into place. The page 

transitions are set via the Transitions section of the Properties dialog for the page, which you 

can call up by double-clicking anywhere on the page. 



The first choice to make is whether you want a transition for when the page appears (Page On) 

or when it leaves (Page Off) or both, which you can do by clicking on the relevant checkbox so 

that a tick appears in it. 

A selection of the most popular or your most recently-used transitions is provided in a drop 

down list box from quick selection. 

Alternatively you can select the More... button to view the complete range of transitions. This 

will call up the Transitions dialog with a list of different styles of transition on the left and an 

icon list of the transitions in that style, alongside it. 

Select the style you are interested in and then click on an individual icon for the particular 

transition. The result will be previewed in the panel at the top right. The other setting available 

is Transition Length. This sets the length of time that Opus takes to perform the chosen effect. 

Use the spin buttons (arrows) to increase or decrease the value in the edit box, which 

represents the seconds the transition will take. Any interval smaller than a few tenths of a 

second is unlikely to make a noticeable difference but may be useful for timing purposes. 

Text Animations Properties  

This tab is specific to text objects and works in the same way as Transitions Properties above 

except that it refers to style of animation used to bring text onto the screen. You can select 

from a range of preset effects for letter-by-letter animations or those which bring on whole 

words or whole lines. 

Cursor 

 It can be very useful to change the cursor when the mouse moves over a particular object. This 

is especially useful when that object does not look like a button, and enabling the user to know 

that something is going to happen when they click on that object. This tab allows you to specify 

a special cursor for when the mouse pointer moves over the object... 

And for when the user actually clicks the mouse button on the object... 

Note that in the case of Text objects, the On Press cursor is actually used for indicating 

hypertext links instead. In both cases you can choose from one of the standard cursors 

provided by clicking the Standard option and selecting the cursor you require from the drop 

down list. 

Or you can choose a custom cursor from a disk-based file by clicking the From File option and 

using the Browse button to locate the cursor you want to use. This can include animated 

cursors. 

The chosen cursor is previewed in the box to the left of the appropriate panel. 

Drag and Drop  



This section of the Properties dialog allows you to specify whether the user can drag the object 

around or whether it can have other objects dropped onto it. This subject is explained more 

fully Advanced Techniques. 

Text Properties  

Text objects and button captions have an additional section of the Properties dialog relating to 

Text properties, which are different from the standard formatting. 

On the left of the dialog are Text effect styles. These are certain styles which text can have 

when being used in a particular context, namely when the text is highlighted during 

AutoNarration or the style used when you turn a piece of text into hypertext: when that 

hypertext is highlighted and when it is clicked. These can be selected from the appropriate 

drop-down list box. You can edit these styles or create your own using the Customise button 

(see page 305 in the Advanced Techniques section for further details). The rest of the dialog 

allows you to set certain characteristics for the text such as whether the edges of fonts are 

smoothed using anti-aliasing. 

and several function to decide how the text will appear within the frame that you have drawn 

to contain it... 

Sets the vertical position of the text within the frame. Select Top, Centre or Bottom from the 

drop down list. 

This is a special feature of Opus, which makes it easy to divide your text up into readable 

chunks. People are less familiar with reading large amounts of text on the screen so it can work 

a lot better if you display the text one paragraph at a time and press a key, or move the 

scrollbar, to show the next paragraph in the same location. This option automatically displays 

text until it comes to a blank line. You can then reveal the next section using the scrollbar 

properties, (see Custom Scrollbars on page 299), or the text scrolling actions on the Text section 

of an Actions dialog. 

If your text is longer than the frame you have drawn, this option lets you force Opus to display 

only complete lines in the frame as illustrated below. This is a text box with the Do not display 

partial lines option off. 

This is the same text box with the option switched on. 

The advantage of the former is that the user can see that there is further text to view whilst the 

latter looks neater. A further option to enhance readability is to double the spacing between 

words. This is also useful for AutoNarrate if your narration highlight causes the text to overlap. 

The Text Properties also lets you set a tab spacing for when you put tabs into pieces of text; the 

measurement is in pixels. 

You can also set the position of the shadow effect when applied using the text effect styles. 



(Note that this is different to the Shadow Effect discussed previously, which applies to the 

default style for the text.) 

As discussed previously, there may be times when you wish to create a text object to display 

text that is updated after the publication has been published as a stand-alone project. This 

might be text actually created during the running of the publication such as a customer 

questionnaire or order, or training feedback. Alternatively, it might be a basic text file which 

you want other people to be able to edit outside the Opus editor, distributor details for 

example or a local currency price list. 

This option allows you to specify the file to be handled in this way. Remember to ensure that 

the path and file name used here will be the same on the user’s computer. 

Text Input  

Text objects also have an Input properties tab. This is for turning the text object into a text 

input box and is dealt with in the Advanced Techniques section. 

  



Toolbar Shortcuts to Properties 

Many of the basic properties in Opus are available for all objects and are so commonly- 

required that we have provided toolbar shortcuts to them so that you can experiment with 

different styles and colour schemes without going backwards and forwards between the object 

and the Properties dialog. All of the properties set up in this way can be edited subsequently via 

the relevant sections of the Properties dialog. These items are provided on the Object 

Properties toolbar, which, by default, looks like this... 

If this toolbar is not visible or does not contain the items illustrated above you can regain the 

default items via the Customise option on the Tools menu (for further details see Customising 

Opus). 

Transparency Slider 

The first tool on this toolbar is the transparency slider. By sliding this control backwards and 

forward you can control how transparent the selected object is, allowing the background to 

show through it. 

Initially Hidden 

This button provides a shortcut to set the object to be initially hidden, that is, it will not appear 

when the page first appears but instead will wait for a Show action to reveal it. 

Background Shortcut Button 

This button allows you apply the chosen background style. Click the button down to apply the 

current background style and click it again to switch the background off. Clicking the arrow 

alongside the button provides a drop down palette of the most commonly-used options for you 

to pick from. 

Click on a style and it can be applied using the shortcut button until you select an alternate 

style. The colour scheme for these is taken from the current colours in the Opus Palette (see 

Choosing Colours). The foremost colour in the colour indicator box is the main colour and will 

be used for flat colour backgrounds, the other colour will provide the second colour for 

gradient fills. 

Border Shortcut Button 

This button works in a similar way to the Background shortcut button but provides a palette of 

commonly-used border styles. 

Shadow 

In the same way as the preceding buttons this one allows you to choose from a set of presets 

and then quickly apply or remove a drop-shadow effect to the selected object. 

Flare 



Provides a shortcut to applying one of several preset Flare effects to your object as with the 

preceding tools. 

Show Transition 

This allows you to quickly switch on and off a transition for when the object appears on screen. 

Click on the arrow alongside the button to bring up the most commonly or recently used 

transitions. Simply click on the one you require – the result will be displayed in the preview box 

provided. 

To access the full list of transitions via the More... button, which will bring up the Transitions 

dialog allowing you to choose the category of transitions you are interested in before choosing 

the precise transition itself by clicking on the appropriate icon. 

Clicking the toolbar button on and off without using the drop down list will apply and remove 

whatever transition was chosen most recently. 

Hide Transition 

This option works identically to the option above except that it applies to the transition used 

when the object disappears from view. 

Outline Width and Style 

A special toolbar provides a drop down list of pen widths and styles with which to draw the 

outline of an object. If an object is currently selected the outline will be changed accordingly. 

This option is only applicable to objects drawn with the Opus drawing tools. 

Line End Caps At each end of this toolbar is an additional drop down which provides a range of 

endcaps which will be placed at the relevant end of the line. 

The size will be set according to the thickness of the line. You can set a different end cap for 

each end. This is invaluable for designing arrows in a variety of styles and directions but can 

also be used for purely decorative purposes. Any end cap can be combined with any line style 

(though obviously in some cases the result may not be very useful). Note that the first option in 

this drop down is the normal style of end cap so if you want to remove an endcap simply select 

this style in its place. 

  



Setting Different Appearances 

One of the most common features of interactive multimedia interfaces is that objects which do 

not look like buttons can be active and can be clicked on to make things happen. This might be 

graphics or pieces of text for example. In order to show the user that these items are active 

and/or that they have responded to a click from the user the multimedia designer will often 

create different appearances for when the mouse moves over an object or when the user clicks 

on the object. Opus provides a shortcut to this requirement by allowing you to edit the 

properties of an object for each of several different states as listed below. Simply select the 

appearance required from the list on the left of the properties dialog. (Use the scrollbar if the 

one you want is not visible). Note that whatever appearance you have currently selected is 

what is displayed in the editor. 

Normal Appearance This is the default appearance for the object. Anything you have set for this 

appearance will be used on the other appearances unless it is explicitly changed. 

Mouse Over This appearance will be used whenever the mouse cursor moves over the object. 

This is obviously very useful for highlighting the object to show that it is active. 

Down If you want the object to react to the user clicking on it then this is option allows you to 

select how the object will appear when the mouse button has been clicked down. 

Mouse Over Down This appearance is only available for buttons and is primarily useful for radio 

and toggle buttons, where a button stays down to show that the option is on. A mouse cursor 

going over a button already in the down position is different to the “Down” appearance, which 

responds to a click. 

Disabled This state is used when the object has been disabled using the Disable Object action. 

No other appearances will be used if the object is disabled. Not all the properties of an object 

are available in the additional states as most are not appropriate. However, each state can have 

its own image so you can create custom graphics to suit. Alternatively you can simply use the 

background, border and effects tabs to set these differently in a particular state. The Flare 

effect is particularly useful to highlight objects on mouse over. Changing the background colour 

or adding a plain border can also be effective. You might choose to use a lightening of colour for 

mouse over and then a darkening of colour for the down appearance. 

Modifying Text on Buttons When using buttons in your publication it can often be useful if the 

caption of the button can change, or at least change colour, in response to different states. 

Opus provides a special tab allowing you to modify the text according to the different state. 

Select the relevant state as above and then set the options for the text. Or type replacement 

text in the box at the bottom of the dialog. 

You can change any aspect of the text including font and size and you can offset it from the 



previous state. This is particularly useful if you are just creating a text-only button and you want 

the text to appear to respond to the mouse click by moving down. Those options which can be 

switched off as well as changed have a tri-state checkbox. This means they can be on, off or left 

as they are. If the checkbox is ticked but greyed out this means the setting will be inherited 

from the previous state. The presence of a tick in this case does NOT mean that the particular 

item is on it indicates that whatever setting has been made before is active. 

Master Pages 

Opus allows you to specify any page in your publication as a master page. You can then specify 

that other pages will use this page as the basis for their design and will include all objects. This 

provides a way of doing that without having to recreate the same objects over and over again. 

This is particularly useful where you wish to use the same background or basic layout (perhaps 

including the publication title or a company logo) or provide a consistent set of options such as 

Back, Forward and Exit buttons. When you use a Master Page it means you not only have a set 

of standard objects included on every new page created from it but that you can go back and 

edit the Master Page afterwards and the changes will be made automatically across all the 

copies of that page. This can be particularly useful for presentations where you might use a 

consistent style of presentation but simply adapt the title or change a client’s logo but keep the 

bulk of the material the same or similar. You can specify as many Master Pages as you like and 

you can choose which to use when you create your new page. You can make a page a Master 

Page or a Clone Page at any time and change them back again by simply switching the options 

detailed below on or off. 

Creating a Master Page To create a Master Page simply add a new page to your publication and 

go to the General tab of the Properties section of the settings dialog for that page. Click on the 

checkbox to specify that This page can be a Master Page. 

Creating a Clone Page You do not have to use the Master Page for every subsequent page, you 

can switch the option on and off as required via the General tab of the Properties dialog for the 

page. To set a page to be based on a Master Page you must have first set at least one page to 

be a Master Page. Then go to the General tab of the new page’s properties and click on the Use 

Master Page... option (this will be disabled if you have no Master Pages in that publication). 

If the page you want to use is not already listed in the box provided select it from the drop 

down list provided. None of the master page objects that appear on the clone page can be 

edited on the clone page. 

Hiding Your Master Page Pages you have designated as Master Pages will not appear in your 

publication. Should you ever need a page that only displays the elements of the master page 

and has no further additions, you can, of course, simply create a clone page with nothing added 

to it. The best location for your Master Page in the Organiser is just before the page that first 



requires it, so that the program has already loaded the Master Page elements when the page 

needs them. Do not put the Master Page at the very end of your publication as the program will 

then need to search through the whole file before finding it. 

Making Things Happen 

Once you have added some content to your publication you will quickly want to start adding 

some activity and interaction and start making things happen. In Opus, you use Actions to do 

this. It is not only buttons and hotspots that can make things happen, although these are the 

most obvious candidates. Any object can have activity attached to it so that something occurs 

when the user clicks on the object or presses a key on the keyboard, or simply when the object 

appears. An action occurs in response to a Trigger (something which causes the action to take 

place. The trigger is often the mouse being clicked on an object or a keypress but it can also be 

automatically triggered whenever an object appears on the screen (including the moment the 

page containing it is opened) using the On Show trigger. The actions associated with an object 

are displayed in the Action Organiser on the Actions section of the settings dialog, which can be 

brought to the front by clicking on the tab labelled Actions. 

They are also displayed in the main Organiser (again you can bring it to the fore by clicking on 

the tab labelled Actions at the side of the window). 

In both cases you can click and hold down the right mouse button to drag the actions around in 

this view to reorder or duplicate them just as you can with objects. The illustration below shows 

the Set Bookmark action being moved to the above the Play Sound action. 

Use the right mouse button to drag and you will be given the option to Copy or Move the 

action. 

TIP If you Copy an action (animation, for example) that is set up to refer to This Object, the 

action will refer to the new object. If you want it to control the original object you must select 

the object name explicitly. The Actions section of the settings dialog is divided up in three 

ways. To the left is the Actions Organiser with an Explorer-style tree view of your actions with 

a small toolbar above it for adding, deleting and reordering actions. 

The rest of the dialog is covered by another set of tabs allowing you to set the options for each 

element of an action. This section is divided by a set of three/four top level tabs... 

A fourth tab will often appear after the Programming tab and is specific to the chosen action 

and allows you to set the particular options for that element of the action. If the item does not 

have any additional settings or options this tab does not appear. The Actions tab is divided into 

tow columns. Th first provides a list of categories of actions while the second provides the list of 

actions in that category. These are detailed fully in the Actions Reference and the Help file. 

There are four elements to an action in Opus... 



Trigger Firstly you must decide what will trigger the event. This could simply be On Show (that is 

when the object appears) or most commonly it could be in response to a Left Mouse Click (that 

is when the user clicks on it with the left mouse button). 

Action Secondly, you have the action itself, which you assign to a particular trigger by double-

clicking on its icon or dragging it over onto the Organiser. Note that you must have the relevant 

trigger selected or the action will not be applied. 

Programming Thirdly you can make the action conditional; that is you can specify that it only 

happens when certain conditions are met. To do this you put the actions underneath an If 

action. 

The Programming tab also lets you create loops for actions so a single trigger can make an 

action happen repeatedly. It also lets you perform simple programming tasks such as setting 

the contents of a variable or doing simple maths functions. In these latter cases you may not 

require another action. These items are further explained in the Advanced Techniques section 

of the manual. 

Action-specific Settings When you have chosen an action a fourth top-level tab will appear 

allowing you to set the particular options for that action. For example, choosing which object to 

show or which page to go to and so on. 

Working with Multiple Actions All objects can have multiple actions assigned to them. You 

simply add as many actions as you like underneath each trigger. 

Note that actions will be started in the order they are listed even though they are triggered by 

the same event. This can be important if, for example, you are using the Show action to show 

an object that has a lengthy and exclusive transition, as this could delay subsequent actions. 

Working with Multiple Triggers In many cases you will want to make the same action happen in 

response to several triggers. The most common example of this is if you want to assign a key 

press to a button that can also be clicked on – for example, you might want to exit a publication 

by clicking on a button or by pressing “X” on the keyboard. 

Instead of having to build the same action(s) twice you can simply set the action(s) to be 

triggered by multiple triggers. To do this you assign the first trigger, then select it by clicking on 

it. But instead of selecting and applying an action you select and apply another trigger. The tree 

view will change to display the multi-trigger and the constituent triggers will be listed below it 

along with any actions you apply to that set of triggers. 

Creating Hypertext The other way of applying actions to a page is to turn pieces of text into 

hypertext. Hypertext is "active text", a word or phrase, which acts like a button and links to 

another part of the publication. It is familiar to Internet users as hyperlinks and is used in online 

help files to link different topics. Hypertext can have similar uses in your publication by 



providing active cross- references, pop-up definitions, footnotes or extra information. You can 

create a piece of hypertext as follows: Firstly select or create the text that contains the word or 

phrase you want to use as hypertext. Then use the flashing I-beam cursor to highlight the word 

or phrase you want to use as hypertext. 

Click the Create Hypertext button on the toolbar or select Create Hypertext from the Text 

menu. The Actions dialog appears to allow you to assign one or more action to this piece of 

text. You can then set up your action as you would with any other object. Click OK to apply the 

action(s) to this piece of text and you will notice that the text style changes to indicate that the 

word or phrase is now a piece of hypertext. 

You can edit the action after you have created it by placing the I-beam somewhere in the piece 

of hypertext. Then click with the right mouse button to bring up the right mouse menu and 

select Edit Hypertext from there. You can remove the hypertext by following the same 

procedure but selecting Delete Hypertext from the right mouse menu instead of Edit Hypertext. 

You can also edit the style of text used for hypertext via the Text tab of the Properties dialog for 

that object. (See Editing Text Styles for details). 

Disabling Objects There will be occasions when you wish to have an action associated with an 

object at certain times or under certain conditions only. You will want to be able to disable and 

enable an object as required. Opus provides specific actions to enable and disable objects, 

which are detailed in the Actions section of this manual. 

Triggers 

This section of the Actions dialog allows you to set up the event (if any) that causes an object to 

perform an action. It is divided into two sections. The first is a list of categories of triggers while 

the second is an icon list of the triggers in that category. 

The action can take place in response to: 

1. activity by the mouse or joystick both clicks and movement, 2. a key being pressed on the 

keyboard, 3. another object being dragged onto the object, 4. synchronised with the start or 

end of another event, 5. at set intervals using the Ticker trigger. 6. if a variable has changed 7. if 

another object is dropped onto it or 

8. can start automatically when an object appears (On Show) or disappears (On Hide). Note 

that, both On Show and On Hide happen automatically when a page appears or disappears if 

that object is on show on that page. 

Mouse Opus can respond to the activity of the mouse in several ways, it can respond to a click 

or double click from each button or it can respond simply to the mouse cursor moving over an 

object (Mouse Over), or moving off an object (Mouse Exits). 

TIP You do not need to use the Mouse Over action simply to change the properties of an 



object as you can set up specific properties for specific states of the object via the Properties 

tab. Each of these activities is represented by an appropriate icon and you can add the 

appropriate Trigger by double-clicking on that icon or dragging it onto the Action Organiser. 

When this trigger is used the action occurs when the user clicks on the object with the left 

mouse button and then lets go. 

When this trigger is used the action occurs when the user double-clicks (clicks twice in quick 

succession) on the object with the left mouse button and then lets go. 

When this trigger is used the action occurs as soon as the user presses down on the object with 

the left mouse button and does not let go immediately. All of the above actions are also 

provided for the right mouse button. 

Modifiers Mouse click triggers can also be combined with keyboard modifiers, that is you can 

set up a trigger for a left mouse click with the Ctrl key pressed at the same time. You can do this 

via a fourth top-level tab, which appears once you have selected the appropriate mouse click 

trigger. 

You can select Ctrl, Shift or Alt keys or any combination of these to modify the mouse click 

trigger. Simply click the checkbox to tick the modifier you want. Click it again to remove the 

setting. 

Mouse Movement 

When this option is used, the action occurs as soon as the mouse cursor moves over the object 

and does not require the user to click the mouse button at all. This might be used to bring up a 

message relating to that object such as notes or "tool tips", or to highlight the object in some 

way. 

When this option is ticked the action occurs as soon as the mouse cursor moves off the object 

irrespective of whether the mouse button has been clicked or not. This might be used to cancel 

or stop the action started by the mouse-over event. 

Mouse Repeat You can set the mouse button to repeat its action if the mouse button is held 

down, just like auto-repeat on the keyboard. This option is provided on the General tab of the 

Properties for the object. 

Joystick These triggers are specific to publications which support the use of a joystick – most 

often training programs or simple games. 

You can trigger actions whenever the joystick moves left, right, up or down or when the fire 

buttons are pressed. Note that as the joystick can be held over in a particular direction the 

actions assigned to a Joystick move trigger will be repeated for however long the joystick is held 

in that direction. 

On Show 



This option allows you to trigger an action whenever an object becomes visible, whether it is by 

a specific Show action or that the page on which it appears has appeared on screen. This 

effectively allows you to trigger actions automatically without any action by the user. 

On Hide 

This option allows you to trigger an action whenever an object is no longer visible, whether it is 

by a specific Hide action or that the page on which it appears is no longer on screen. This latter 

case is not terribly useful for visual events (it will happen out of view) but can be useful for 

saving information to a variable or disk file etc. 

Key Press 

A key being pressed on the keyboard can trigger an action. You can use the function and arrow 

keys, as well as the standard alphabet and numerical keys. This option is available in the second 

subsection of Triggers, which you can bring up by selecting the Advanced Triggers section. You 

can also use Space and Enter, but please note that Enter can be set for use by the text input 

boxes so using it on pages where there are text input boxes may cause confusion. Also note 

that the Alt key is not available. You choose the actual key you want after you have applied the 

Key Press trigger to the appropriate object by double-clicking on the Key Press icon as before. 

Once you have done this a fourth top level tab will appear allowing you to specify the key you 

want to be pressed to trigger this action. 

To do this simply click in the edit box in the Key pressed = and then press the actual key or 

combination of keys that you want to trigger the action. The keys you press are reflected in the 

edit box. Thus pressing the space bar will bring up the word Space in the box as illustrated 

below. 

Then click the Apply button to apply this to the Keypress trigger. You will note that this 

description in the Action Organiser is updated to reflect this. 

Key Release There is also a trigger for when the key is released. This allows you to have an 

action triggered by a keypress which repeats while the key is beign held down and then 

stopped when the key is releaed. 

Ticker 

You can set up an action or series of actions to occur repeatedly at set intervals by using the 

Ticker trigger. This is also on the Advanced Triggers subsection of the dialog and once it is 

applied to an object another tab appears allowing you to set the interval at which the action 

will be repeated. 

Simply use the spin buttons to set the timing required or type it into the box. Then click on the 

Apply button. As before you will notice that the description in the Action Organiser is changed 

to reflect the setting. 



Variable Changed 

An action can also be triggered by the fact that a variable has changed. Variables are explained 

in more detail in a later section for now it is enough to note that this option is applied in a 

similar way to the preceding two options. 

When you have applied the trigger to an object another tab appears allowing you to choose 

which variable to watch for a change. Note that this is not the same as checking for a specific 

value in a variable – this is done via the If action on the Programming tab. 

Object Dropped 

You can trigger an action by having another object dragged onto the current object. You must 

have set up the Properties of the object so that it can receive objects that are dragged around 

the screen (see Drag and Drop on page 347 for further explanation) and you must have created 

another object that is capable of being dragged around the screen. You can then use this trigger 

to start an action in response to the arrival of the dragged object. You can select whether it will 

be triggered by any object being dropped or by a specific object. 

Other triggers related to drag and drop are alos provided and are delat with in the advanced 

sections of these support materials. 

Starting things Automatically Video, animation and slideshows can be set to start automatically 

as part of their properties. You can make other things happen automatically simply by 

triggering them with an On Show trigger for the page you want them to happen on. 

Synchronise to Start/End 

You can set the action to occur at the start or end of a sound, slideshow or video. This is useful 

for allowing for variations in the speed of individual systems when playing video or sound and 

holding the next action until the item has finished however long that takes. Select the object 

you want to trigger the action and then apply either of these options by double-clicking on their 

icon. Then select the object you want to synchronise with from the list box provided. 

Synchronise to Start is particularly useful for ensuring that a sound or video is fully loaded and 

playing before an event starts. 

Actions: General 

The first categories of the Actions catalog are General and Miscellaneous, which provides some 

of the most commonly used actions. Note that not all the actions are covered in this manual to 

enable you to understand basic principles. Additional actions are provided and are covered in 

the Actions Reference manual and the electronic help file. NOTE: The icons illustrating the 

actions in the following sections are lage format to make the detail clear in this manual. The 

small format icons which appear on screen may differ slightly for clarity but should be readily 

identifiable from the examples here. 



Show Object 

This allows you to display one or more objects that were not previously showing on the page. 

When you assign this action to a trigger by double-clicking its icon or dragging it onto the 

Actions Organiser a fourth tab appears at the top of the window that provides access to the 

specific settings. In this case it allows you to pick the object you want to show. 

A list of available objects is provided with checkboxes alongside. Check the box to select the 

object you want to display in the list to the right. To cancel the selection, simply click the box 

again. Only objects on the current page can be accessed by this command. The object must 

have previously been hidden by the Hide Object action or have its Properties set to be Initially 

Hidden. You can choose to reveal the object with a transition whether it has one set via its 

Properties or not. Select the transition you want to use by clicking on the This Transition box 

and picking the transition required from the drop down list box. 

Or click on the Use Default Object Transition setting to use whatever transition has been set up 

in the Properties of the object. If you have a series of objects you wish to show in turn using the 

same trigger you can use the Show in Turn action on the Miscellaneous tab. 

Hide Object 

This action works in the same way as the Show action but hides objects that are currently on 

view. A list of available objects is provided with checkboxes alongside. Check the box to select 

the object you want to display in the list to the right. 

To cancel the selection, simply click the box again. If you have a series of objects you want to 

hide in turn using the same trigger you can use the Hide in Turn action on the Miscellaneous 

tab. 

Go to Page 

The most commonly used option is to go to a specific page. When you assign this action to a 

trigger by double-clicking its icon or dragging it onto the Actions Organiser a fourth tab appears 

at the top of the window which provides a list of all the pages available in the publication, 

together with some special preset options as detailed below. 

In the list select the option or page you require by clicking on it. Then click the Apply button. 

Note how the description of the action in the list is updated to reflect your choice. The special 

preset options that can be selected are as follows: 

Forward This option moves you forward to the next page in the publication. The order follows 

the order the pages appear in the Publication View and the Organiser. 

Backward This option moves you to the page in the publication immediately before the current 

page, based on the page order in the Organiser pane. 

Previous Moves you to the page you just came from irrespective of where that is in the 



publication. 

Random Creates a randomised list of all the pages in the current chapter and then goes to the 

first one on that list. In this way you can display pages of your publication randomly either as a 

random presentation or to pick question pages at random. 

Next Random Goes to the next page in the randomised list of pages. If no randomised list exists 

it performs the same function as Random. If the previous page was the last page in the 

randomised list this option goes back to the beginning of the list. 

Exit 

This action closes the publication. There are no additional settings available via this dialog but 

the publication will be closed down following any exit procedure you have set up in the Options 

section of Publication Properties. 

Print 

The print action provides a variety of printing options, which you select by clicking on the 

appropriate radio button on the Printing tab that appears when you apply this action. Firstly it 

allows your user to print the current page of your publication, 

or a specified page of the publication (which you specify by choosing it from a drop down list 

box) 

Finally you can print a disk-based text file. 

In this last case your publication will need to know where to look for this file as its location on 

your computer might not be the same as your user. Opus allows you to specify that the file is in 

the Windows Temp directory (the exact location of this directory is always available under 

Windows so Opus will know where to look on any machine). This is the option to choose if you 

want to print a file that is created or updated in the course of viewing the publication. 

You can also tell Opus to distribute the file with the publication. 

There are two additional options allowing you to specify what control dialogs will be displayed 

when printing... 

Clicking this option on displays the standard Windows Printer Setup dialog before printing 

starts so that your user can set up the printer and page size and number of copies before 

printing. 

Displays a message box telling your user that printing is going on and providing a Cancel button 

to stop the printing 

Enable/Disable Object 

This pair of actions will allow you to switch an object’s actions on and off. If the object is 

disabled it will display the Disabled appearance if you have set one and any actions you have 



applied to it will not occur. If you enable the object it will use the other appearance styles you 

have designed and any actions you have applied will be able to take place. 

Delay 

You can also choose to delay an action by a set amount of time. Once you have applied this 

action a fourth tab will appear to let you set the number of seconds you want the delay to last. 

Use the spin buttons to increase and decrease the value or type the value into the edit box. This 

is one way in which many events in Opus can be timed. 

Actions: Animation 

Opus provides tools to apply quite sophisticated animations to the objects in your publication. 

There are some basic preset animations such as bounce and fade, you can draw a path or shape 

to move the object along or you can write a script to provide very precise instructions as to 

how, when and where an object should move. Animation is different to the movement 

provided via the Transitions for objects as those occur when the object appears or disappears 

and animation works on visible objects and it is much more versatile. 

TIP  If the object is a sub-element of a frame the animation you set will refer to the frame 

rather than the whole page. This can be very useful if you want an object to animate in a 

particular place. 

Animation Wizard If you do not wish to create an animation from scratch, Opus provides an 

Animation Wizard that will lead you step by step through the creation of a wide selection of 

animations. You can then either use them as they stand or you can customise them to suit. To 

use the Animation Wizard simply select the object you want to animate and click on the 

Animation Wizard option on the right mouse menu or the QuickBuild menu. If you wish to edit 

an animation created using the wizard simply go to the Actions dialog for the object in 

question, find the actions the Wizard has created and edit them as you would if you had 

created them from scratch. NOTE: The icons illustrating the actions in the following sections are 

lage format to make the detail clear in this manual. The small format icons which appear on 

screen may differ slightly for clarity but should be readily identifiable from the examples here. 

Follow Path 

This action allows you to move an object along a path created using the animation path tool 

described on page 95. 

Firstly select the object and trigger you want to perform this action in the usual way and then 

apply the Follow Path action by double-clicking its icon. You can then choose which object you 

want to follow the path by selecting it in the Object list box and then choose the path by 

selecting that from the drop down list labelled Follow Path (this will be empty if you have not 

created any animation paths on your page). 



You can select the time it takes for the object to move along the path by using the spin buttons 

to set the Duration edit box or typing in the required number of seconds. 

There are a number of additional controls available as follows: 

Position 

Sets the position along the path where the object starts and ends as a percentage of the whole 

path. Allows you to have several objects moving between different positions on the same path. 

Set the start and end positions as appropriate by using the spin buttons or by typing the 

appropriate number in the box 

Type 

Allows you to specify whether the object moves along the path exactly where the path is drawn 

or whether it moves along the path as though the path was drawn where the object is and so it 

moves parallel to the actual path. The first option is achieved by setting the Absolute option 

and the second is the Relative option. 

Repeat You can also specify how often the object should travel the path. 

By clicking on the relevant radio button you can tell the object to travel the path once, or 

continuously or you can specify a number of times using the spin buttons or by typing the 

relevant number in the edit box. 

Orientation 

This option allows you to specify whether the object will face in the same direction throughout 

its journey (choose the Fixed option) or whether it will always face the direction it is travelling 

in, rotating as appropriate to match the direction of the path. (choose the Aligned option). 

In the illustration above the tortoise on the left is aligned to the path while the tortoise on the 

right has a fixed orientation. 

Speed Control 

The speed at which the object moves along the path is determined by the length of the path 

and the Duration setting. You can also apply various types of acceleration, which can be 

selected from the drop down list provided 

Constant The object moves at the same speed across the whole animation 

Linear Acceleration The object moves more and more quickly as it moves along the animation. 

Linear Deceleration The object travels more and more slowly as the animation progresses. 

Ease In The object is slow to get going but then picks up speed quickly. It is as though the object 

is overcoming inertia. 

Ease Out The object starts at full speed but slows down to bring itself to a smooth stop. 



Ease In & Out The object starts and stops smoothly and hits top speed about the middle of the 

animation. These last three controls are more subtle and more natural than straightforward 

acceleration and they are often used by professional animators to make objects start and stop 

more naturally. 

At End... The final option allows you to specify when the object reaches the end of the path. 

By clicking on the appropriate radio button you can make the object simply stop at the end, 

reset to the beginning of the animation or return back along the path in the opposite direction. 

Bounce 

This animation will cause the object to move around the page or frame and bounce off the 

sides. You can set the angle the object starts to move at and this obviously sets the style of the 

animation. Opus provides three preset bounce animations via quick set buttons... The object 

bounces up and down vertically, 

or left to right across the page, 

or it can set off at an angle and then bounce off the edges of the page like a ball hitting a wall. 

These presets can subsequently be edited using the other controls. You can also set an angle for 

the path the object will take by clicking on the angle indicator and dragging it clockwise or anti-

clockwise round the control to the angle you require. This will be displayed in the angle edit 

box. 

Alternatively you can click on the Random option to let Opus pick an angle randomly. 

You can also set a specific number of times the object bounces or whether it should bounce 

continuously. 

You can set the speed of the animation using the Speed slider. The further to the right you drag 

the slider the faster the animation will happen. 

Please note however, that on some systems large objects may not animate very smoothly at 

higher speeds and will jump or jerk too much. The starting point for the bounce is wherever you 

have positioned the object on the page. 

Follow Script 

This is the most versatile animation as it allows you to set up a series of commands, which your 

object follows to move around the screen. It is also the most complex and is therefore dealt 

with the Advanced Techniques section of this manual. 

Fade 

This option allows for you to fade objects in or out, to or from a particular transparency, which 

is set by adjusting the Transparency, edit box to the level of transparency required. 



You can choose to fade to a specific amount or by a specific amount. 

Note that the Fade By option works from the existing transparency setting so if your object is 

not transparent, fading it in by any amount will not work as it is already 0% transparent. Instead 

you must use the transparency slider to set its transparency to a level where the change will be 

relevant or use another Fade action to reduce the transparency before fading in. 

Roll, Spin, Rotate 

All these animations work in the same way but animate the object in a different direction. Roll 

will move the object top over bottom, Spin moves the object side over side and rotate moves 

the object as though it is cartwheeling across the screen. Use the rotation control to set the 

number of degrees through which the animation should spin the object. One full turn is 360 

degrees but you can set more than this by continuing to wind the rotation control around or by 

typing the number required in the edit box provided. 

Thus 360 will turn the object over completely once, 720 will tumble it twice, 1080 is three times 

and 1440 is four times and so on. You can select which direction the animation should occur by 

clicking down the relevant Direction button. 

The first button specifies a clockwise rotation which for Spin means the right hand edge will 

come forward over the left hand edge and for Roll means the top will roll over the bottom. The 

second button reverses these directions. 

Setting the type of animation to relative will perform the animation relative to the current 

position – i.e. if the object is rotated 10 degrees and you set it to rotate 15 degrees it will end 

up rotated by 25 degrees. If you use the Absolute setting it would rotate only by 5 degrees so 

that its final rotation angle was 15 degrees. As with all other animations you can set the Speed 

Control and what happens at the end of the animation and how often it is repeated. 

Move There are three Move animations... 

Move Horizontally – allows you to move the object by a certain number of pixels across the 

screen or to a specific horizontal position. 

Move Vertically– allows you to move the object by a certain number of pixels up or down the 

screen or to a specific vertical position. 

Move Vertically and Horizontally – allows you to move the object both horizontally and 

vertically (Move By) or to specify an exact location for it to move to. The top left corner of the 

object is aligned to the location specified. These work in very much the same way and offer the 

same controls as other animations. In this instance you can use the Move by option to tell the 

object to move a certain distance from its current location in the direction specified or use the 

Move to option to specify an exact location. 

Scale Again there are three variations on this action allowing you to stretch an object 



horizontally, vertically or both at once. In all cases use the spin buttons provided to set the 

amount of stretch, which is measured as a percentage of the object’s size. 

If you set the Scale by option the animation will resize the object by the given percentage of its 

current size while with Scale to the percentage to resize will be calculated from its original size. 

For example if your object is at its original size and you use Scale by 10% twice the object will 

end up over 120% its original size as the second use of Scale by 10% was calculated from an 

object which had been scaled by 10% already. Using Scale to 10% twice will be redundant as the 

first action will scale the object to 10% of its original size and the second action does nothing. 

Skew 

Skew works in the same way and with the same option as the Scale animation option above 

except that the result is to shear the object by the given percentage rather than scale it. 

Scrolling On and Off Page This is a commonly used animation, that lets you scroll the object on 

or off the page or frame, to or from wherever you placed it on the page. As such we have 

included it as a transition rather than an explicit animation. Select one of the Scroll Page actions 

as the Show or Hide transition for an object to animate it on or off the page in the direction the 

Scroll provides. 

Combining Animation Styles You can also combine more than one animation style to create a 

third effect. For example you might want an object to move across the screen and reduce in 

size as though it is travelling into the distance. Ordinarily this is not possible as animation is 

exclusive and temporarily blocks out all other actions by your publication or any other software 

so that it can be performed in a consistent and smooth way. Therefore giving an object two 

animations will simply result in one animation following the other. Although this can also be 

useful it is also possible to combine two or more animations so that they run together and 

thereby have the combined effect as the above example. 

You can achieve this by running the animations in a Simultaneous Action Group. This is a special 

process control action that allows you to attempt to perform actions simultaneously. Any 

actions you add to this control action will be started together. Several of these types of effects 

are provided via the Animation Wizard. 

Actions: Audio Visual 

This section of the Actions dialog provides you with controls for playing sound, video, and CD 

tracks. Opus supports most popular audio and video file formats. However, each file format has 

its own specific characteristics and you should consider the suitability of different files 

depending on the situation. For example, MP3 is a compact but competent audio format, but 

there may be a small percentage of end-users whose systems cannot play the MP3 format. The 

WAV format can be understood by all systems and provides excellent sound quality, but these 



files are often huge and take up a lot of space. For video, the new ASF format is particularly 

recommended as it automatically provides streaming of the video in Opus (particularly useful 

for web publications). Alternatively MPEG and QuickTime are competent and popular formats 

but note that QuickTime replay requires that QuickTime v4 or greater is installed. NOTE: The 

icons illustrating the actions in the following sections are lage format to make the detail clear in 

this manual. The small format icons which appear on screen may differ slightly for clarity but 

should be readily identifiable from the examples here. 

Play Sound 

This lets you select a sound file to play and set the relevant options for it. You can use the same 

action to start Midi, WAV, MP3, WMA or ASF sound files. Use the Browse button to locate the 

file you want. This will bring up an Open File dialog that will allow you to locate the file you 

want. The file will automatically preview, when you select it. Click the OK button when you have 

found the file you require. Note that Midi is a different type of format to the others and you 

cannot play more than one midi file at one time. If you set up an action to play more than one 

midi file at a time only one of the chosen files will play. 

Play This section of the dialog allows you to specify how, and how often, the sound should 

play... 

Select the first option to play the sound just once. Select the second option and use the spin 

buttons to set a specific number of times you want the sound to play. Select the third option to 

play the sound continuously. You can also specify whether the sound should stop when the 

page changes. 

If the sound is specific to a particular piece of content, for example, you would not want it to 

continue on the next page. However, if the sound was intended as background music for the 

whole publication you would leave this option off. If you only wish to play a section of the 

sound file you can specify a start and end point by using the spin buttons or typing the required 

amount into the edit boxes provided. 

In the above example on 13.5 seconds of this file will be played starting from 40.5 seconds into 

the file. Note that this does not wait for 40.5 seconds before playing the sound. Opus allows 

you to mix some sound formats and the final option on the Play panel of this dialog allows you 

to specify the Channel used by a particular sound but in most cases you will want to leave this 

set at Auto. 

Volume In addition to the actions controlling volume you can also specify some volume control 

here at the time the sound is played. 

You can select an initial volume (useful for adjusting the sound levels across several sound files 

if they are too varied, or to play a sound as an underscore). 



You can also chose to fade the sound in and/or out by setting these options and then use the 

spin buttons to set the amount of time taken for each fade. In the case of a Fade In of 5 seconds 

the sound will not have reached the initial volume setting until 5 seconds after it starts playing. 

If you set a start position for the play command it will be 5 seconds after that position. On the 

other hand, a Fade Out of 5 seconds will result the fade will begin 5 seconds from the end of 

the piece, or the end position if you have specified one. That is, it is not “fade out after...” the 

given time. but “fade to end over...” the given time. 

Options 

You can also specify whether the sound should be exclusive and that the sound must finish 

before the next action can start by clicking on the option labelled Wait for sound to finish 

before next action can start. In most cases you will not want this option on but it will be 

particularly important to turn it off for long sound files or there will be a lengthy pause in your 

publication’s activity. In addition you can ask Opus to load the sound in advance of it being 

required. This is particular useful for ensuring that small quick sounds are ready for instant 

response – e.g.: for button clicks. When using large sound files which might take a moment to 

load on slower systems it may be worth using the Synchronise to Start option to ensure that 

any related events do not start until the sound file is ready to go. 

Stop WAV Sound 

This action allows you to select a sound or sound(s) that you wish to stop playing. Once it is 

applied to a trigger you can select to stop a particular sound by choosing it from the list, or to 

stop all sounds, or to stop all sounds playing through a particular sound channel. Simply click on 

the relevant setting as illustrated below. 

If you wish you can choose to stop the music by fading it out over a specified amount of time. 

This is separate from the Fade Out setting on the Play action as that applies only when the 

sound reaches its natural end rather than when it is explicitly stopped. Click the Fade out in 

checkbox and then set the number of seconds required for the fade using the spin buttons or 

dragging on the meter bar or by simply typing the amount required into the box. 

Click the Apply button and note how the description in the Action Organiser is updated to 

reflect your setting. 

Stop Midi Sound 

Because Midi is a different format to the other sound types a separate action is provided to 

stop Midi files. Otherwise it works the similarly to the preceding action. You can choose to stop 

any Midi file or you specify a particular file. You can only play one Midi file at one time but it 

might be that you wish an action to stop a specified Midi file if that is playing but not stop 

another Midi file that is currently playing. 

Play CD audio 



This action allows you to play a track from an audio CD. Obviously this action will only work if 

the audio CD is in the CD-Rom drive when the publication is run – Opus does not take a copy of 

the track and distribute it with your publication. Use the spin buttons to set the track number 

you wish to play. You can also choose to specify whether the CD will continue playing after the 

track you specified has finished, in which case it will move on to the next track on the CD. If the 

current track is the last track it will stop. You can only have one CD track playing at any time. If 

you attempt to play another track while one is playing the publication will move on to the track 

requested most recently. The remainder of the options on this dialog are the same as with the 

Play Sound action described above. 

Eject/Close CD Tray 

This option allows you to open or close the CD tray. 

Stop CD audio 

This action explicitly stops a CD track the publication is playing via the previous action. You can 

either set the action to stop Any CD audio track by clicking this option on... 

or you can specify a particular track for that action to stop (if that track is playing) by selecting it 

in the list provided. 

This list will only display tracks explicitly played by the Play CD Audio action. 

Play Video 

This action will start a video or animation file playing or restart it if it is paused. Choose the 

trigger you want to start the action and double-click the icon to apply it to that trigger. A fourth 

tab section will appear allowing you to select the video you want to control by selecting it in the 

list. Note that if you do not have any videos or animations on this page this panel will be empty. 

Once you have selected the video you want to start, simply click the Apply button. Note how 

the description in the Organiser is updated to reflect the setting. If you want to play just a 

portion of the video you can set the start and end time using the edit boxes and spin buttons at 

the bottom of the panel. 

Seek Video 

This action allows you to seek out a particular part or frame of the video and go to that point. If 

the video is playing it will continue to play from the point onwards. 

Allows you to move the video forward by a specific amount. Use the spin buttons to increase or 

decrease the amount, or type the time required in the edit box. It will move the video forward 

even if it is not playing. 

Rewinds the video by a specific amount. Use the spin buttons to increase or decrease the 

amount, or type the time required in the edit box. 



Moves the current position to the start of the video. 

Moves the current position to the end of the video. If the video is not set to play more times 

than it has so far done it will stop and so, if the Properties for the video are set to Display only 

when playing the video will disappear. 

Allows you to specify a precise position for the current frame of the video. If it is playing it will 

continue from there. Use the spin buttons to increase or decrease the amount, or type the time 

required in the edit box. 

Stop Video and Reset 

Allows you to halt a specified video or animation. Once applied to a trigger you will get another 

tabbed section to the dialog allowing you to choose the video or animation you wish to stop by 

selecting it in the list. Click the Apply button. Note how the description in the Actions Organiser 

is updated to reflect the setting. 

Pause Video 

To temporarily stop your video and enable it to resume where you left off you can use the 

Pause Video command. Use the Play action to resume 

Play System Sound 

This allows you to have an object play one of the user’s standard Windows system sounds such 

as when an error or information message comes up. Simply select the system sound you want 

to use from the drop down list provided. 

The sound that this actually uses will depend on what the user has set up via the Control Panel 

in Windows. 

Change Volume 

This action allows you to change the volume of a sound file or CD track. Choose which item the 

change of volume refers to by selecting the appropriate option from the panel at the bottom of 

the dialog. You can choose to change all Wav format sounds, any Midi or CD audio files which 

are playing or a specific file selected in the list of those available. 

To alter the volume to a specific value, click on the Set to value option and then click on the 

arrows of the spin buttons to increase and decrease the new volume level required: 

To alter the volume by a specific value, click on the Adjust by option and then use the spin 

buttons to increase and decrease the amount the volume should be changed by: 

Alternatively you can retrieve the value for the volume level you want from a variable by using 

the following option and selecting the variable from the drop down list provided. 

You can make either of the preceding two changes happen by fading over a certain time simply 

by using the spin buttons or the meter bar to set the time required in the following control: 



Actions: Slideshow 

This subsection provides a series of actions giving full and versatile control over any slideshows 

you have set up on the page... NOTE: The icons illustrating the actions in the following sections 

are lage format to make the detail clear in this manual. The small format icons which appear on 

screen may differ slightly for clarity but should be readily identifiable from the examples here. 

Play Slideshow 

Plays the slideshow from the beginning. A separate tab will appear providing a list of slideshows 

available similar to the list of videos in the preceding chapter. 

Select the slideshow you wish to play by clicking on it and then click the Apply button to apply it 

to the action. 

Stop Slideshow 

Stops the selected slideshow on the current frame. You can select the slideshow this control 

applies to in the same way as with the Play action. 

Pause Slideshow 

Stops the selected slideshow on the current frame temporarily, allowing you to use the next 

option to continue playing from the current frame rather than starting back at the beginning. If 

the slideshow is already paused this will have no effect. 

Continue Slideshow 

Allows you to continue playing a slideshow that has previously been paused. If the slideshow is 

not paused this will have no effect. 

Go to Frame 

This action allows you to specify a particular frame to go to. If the slideshow is playing it will 

immediately jump to that frame. If it subsequently started by a Start Slideshow action it will 

start playing from that frame. Select the slideshow you want to control as before and then 

chose the slide you want to start from by typing or using the spin buttons to set the Slide 

number edit box as required. 

Next/Previous Frame 

Immediately moves the slideshow you select to the next frame after the one currently 

displayed. This has an effect even if the slideshow is playing, so moving the slideshow to the 

next frame immediately rather than waiting for the timing of the current slide. 

Immediately moves the slideshow you choose to the frame before the one currently displayed. 

If the slideshow is playing, (rather than paused or stopped), it will then continue from that 

frame in accordance with the timing of that frame. 



Go to Start/End 

Sets the current position of a slideshow to the first frame, displaying that frame and, if the 

slideshow is playing, continuing from that point. As with all these actions you must select the 

slideshow to which the action refers by selecting it from the list on the fourth top-level tab that 

appears. 

Moves the current position of the slideshow to the last frame, displaying that frame. If the 

slideshow is not set to play more than once or if it has completed all the specified number of 

loops the slideshow will stop. 

Play from Frame 

Allows you to set the frame the slideshow will play from instead of starting at the beginning. 

After you have selected the slideshow you require, you can use the spin buttons to increase and 

decrease the number or you can type the number directly into the edit box. 

Actions: Text 

This subsection of the Actions panel allows control over text objects and narration. Note: The 

icons illustrating the actions in the following sections are large format to make the detail clear 

in this manual. The small format icons which appear on screen may differ slightly for clarity but 

should be readily identifiable from the examples here. 

Scrolling Text The first set of actions in this section provide a series of actions to scroll up and 

down through text by certain amounts. They only work on text objects that are larger than the 

box displaying them. These are: 

Scrolls text up by one line so that a new line from the text appears at the bottom of the frame. 

Will do nothing if the bottom line of the text is already showing. 

Scrolls text down by one line so that a new line appears at the top of the frame. Will do nothing 

if the top line of the text is already on display. 

Scrolls text up by one paragraph. A paragraph is taken to be indicated by a single carriage 

return. Will do nothing if the bottom line of the text is on display. 

Scrolls text down by one paragraph. Will do nothing if the top line of the text is on display. 

Scrolls text up by a whole page. In this case, a page is taken to mean the amount on view in the 

frame you have drawn not the original page size of the text or the page size of the printer. 

Again this action will do nothing if the bottom line of the text is already showing. 

Scrolls text down by a whole page (frame) but will have no effect if the top line of the text is 

already showing. 

Scrolls to the end of the text file if it is not already showing. 



Scrolls to the start of the text file if it is not already showing. Each of these actions work in the 

same way but simply change the text by a different amount or in a different direction. Apply 

the action to a trigger by selecting the trigger, selecting the Actions: Text tab and then double-

clicking on the icon for the action you want to take. A fourth top-level tab appears providing a 

list view of all the text objects available on the page. Select the piece of text you want this 

action to control by clicking on it with the left mouse button and then click the Apply button. 

Notice how the description in the Actions Organiser has changed to reflect the setting. 

AutoNarration This is an option relating to a specialised technique explained in more detail in 

Advanced Techniques and has now been superseded by the tween animation feature so you 

may wish to ignore this section until required. This option is only relevant if you have set up an 

AutoNarration of a piece of text. The actions provided allow you to Play (start) 

and Stop an AutoNarration. 

When you have applied the relevant action to a trigger a list view will appear on a fourth tab 

section, allowing you to select the piece of narrated text you wish to control. Only text objects 

that have already had an automatic narration added to them will be visible. Once you have 

selected the text you must then click on Apply to apply this to the action. 

Actions: Bookmark 

It can often be useful in large or very linear publications to be able to jump quickly back to 

where you left off. It is also useful for training materials where you might want a user to be able 

to return to or start from a particular place in the training. You can do this by using bookmarks 

just as you might with a real book. This subsection of the Actions dialog allows you to set an 

action to save a bookmark so that the user can return to a page easily or the publication can 

start from a certain point automatically. The bookmark is stored to disk and thereby retained 

even when the publication is closed, and as Opus uses the Windows temporary directory to 

store this, it will work for publications on CD-Rom. 

Single vs. Multiple Bookmarks To begin with you must decide whether you wish to use multiple 

bookmarks in your publication. In most instances this will not be necessary as you will simply 

want to be able to return a user to the point where they left off. However, using multiple 

bookmarks allows you to have a number of markers in your publication and to call up a dialog 

allowing the user to choose which of those markers to move to. The single bookmark option 

will retain only one bookmark at any one time. Each time a new bookmark is saved this will 

replace the existing one. When returning to a bookmark there will only be one possibility so 

some of the bookmark functions will not apply and you will not need to ask your user to choose 

a bookmark to move to. Alternatively, multiple bookmarks will allow you to keep any number of 

bookmarks for a publication. When this option is on Opus will keep adding bookmarks to a list 

and when you program an action to go to a bookmark a dialog box will appear asking your user 



to choose a bookmark they want to jump to. If you want to restart the list of bookmarks you 

should use the Clear All Bookmarks option. The option for multiple or single bookmarks is a 

publication-wide setting and so this option is provided on the General tab of the Publication 

Properties. Right click on the publication title in the Organiser and select Properties from the 

menu that appears or select Publication Properties from the Publication menu. 

Then got to the General tab if that is not showing and switch the Use multiple bookmarks 

option on or off as required. When a tick appears in this box the publication will allow multiple 

bookmarks. 

You must then choose which action you want to perform with regard to bookmarks by clicking 

on the relevant option as described below: 

Bookmark Actions None of these actions have any additional options to set once you have 

assigned them to a trigger. 

Set Bookmark 

This action will store a bookmark at the current page. If you are using single bookmarks this will 

be the page a Go to bookmark will go to until you store another bookmark. If you are using 

multiple bookmarks this page will be stored in the bookmark list to be displayed using Show 

bookmark dialog. 

Clear All Bookmarks 

This action will delete all the stored bookmarks and clear the multiple bookmark list if 

appropriate. Then there will no longer be any bookmark to move to, whether you are using 

single or multiple bookmarks so the Go to Bookmark action will not work. There is no way to 

clear individual bookmarks from a multiple bookmark list. 

Go to Bookmark 

This is the option used to move the user to where they left off. It moves the publication to the 

page you have previously bookmarked using Set bookmark. If you are using multiple 

bookmarks, this will be the first bookmark in the list. 

Go to Next Bookmark 

This action is only used for multiple bookmarks and allows you to move forward by one 

bookmark. 

Go to Previous Bookmark 

Similarly, this action is only used for multiple bookmarks and allows you to move forward by 

one bookmark. 

Show Bookmark Dialog 

Finally this option, again for use with multiple bookmarks, displays a dialog listing all the 



available bookmarks from which your user can select the page he/she wants to go to. This 

option allows you to print a specific page of your publication. Select the page you want to print 

from the drop down list. The page does not have to be displayed in the publication so it can be 

specially created, allowing you to control the exact layout and style. . 

 

Actions: Browser 

Opus allows you to display an internet browser Viewport in your publication and this subsection 

of the Actions dialog allows you to control a browser Viewport. This can be useful for either 

providing the user with the same controls as in an independent browser or to move to 

particular HTML pages in response to other actions or conditions in the publication. To use 

these controls you need to have drawn a Browser object on the current page. You also need 

Internet Explorer v3 or higher installed on your system and your user will require this too. Once 

you have attached these actions to a trigger you will get a fourth top level tab allowing you to 

set the various options described below. The following actions can be chosen for whichever 

browser you subsequently select: Note: The icons illustrating the actions in the following 

sections are large format to make the detail clear in this manual. The small format icons which 

appear on screen may differ slightly for clarity but should be readily identifiable from the 

examples here. 

Navigate 

The most common action you want the browser to perform is to show a page directly from an 

intranet or Internet – this is called navigating. The control illustrated above lets you set the 

address (or URL) for a web page to navigate to. Attach the action to a trigger by selecting the 

trigger and then double-clicking on the icon illustrated above. On the Navigate tab, which now 

appears, you must first select the browser you want this action to apply to by selecting it from 

the drop down list of browsers on the page. Obviously this list will be empty if you haven’t 

created a browser object on that page. Next you must specify the page/address/URL you wish 

to show. Simply type the full URL (as it would appear in Internet Explorer, e.g.: 

http://www.digitalworkshop.com) into this box. 

You can use this action to specify an HTML page on your local intranet or on your computer but 

if you are then distributing your publication you must be careful to ensure that the file your 

refer to here is in the same location on the user’s computer. The next three actions provide the 

standard controls available in Internet browsers that can 

interrupt the loading the current page of HTML, 

go forward a page, or 

go back to a page previously displayed. 



The final action allows you to direct the browser to open the web page it is set to start on when 

it is first launched. In Internet Explorer, for example, this is the page set as the Start Page in the 

Navigation section of the Options. 

Navigate to Variable 

Rather than specify the page the browser should show you can use this action to ask the 

browser to show a page directly from the Internet by getting the address or URL for that page 

from an internal Opus variable, where you have saved it previously using the Set Variable 

action. Simply select the variable required from the drop-down list provided. 

Actions: Scoring 

This section of the Actions dialog provides a simple way to incorporate scoring into your 

publication, which is particularly useful for computer-based training and simple games. Opus 

also includes the Question Wizard, which is covered in Training Materials and Scoring on Page 

353. The Question Wizard guides you through the process of setting up complex questionnaires 

containing text, numeric or multiple- choice answers with scoring facilities. However, scoring 

simple questions is easy enough without the wizard and familiarity with the Scoring actions 

function will allow you the versatility to create your own from scratch. As with all actions you 

assign the action to a trigger. This might be straightforward mouse click on a chosen answer, it 

could be in response to a dragged object or alternatively, it could be triggered as part of an “If” 

statement which tests for a more complex answer. For example 

If <UserAnswer> contains “James Watt” then... 

...Score Correct with Total Value 15 The scoring actions are available on the 

Scoring subsection of the Actions tab and the main action you will use is the Store Score action. 

NOTE: The icons illustrating the actions in the following sections are lage format to make the 

detail clear in this manual. The small format icons which appear on screen may differ slightly for 

clarity but should be readily identifiable from the examples here. 

Store Score 

As the name suggests this action stores the score for you with a specific value if required. It 

stores scores automatically in the preset variables provided in the program. The answer can be 

scored as Correct, Incorrect or Partially correct by selecting the relevant radio button as 

illustrated below. 

You can give this answer a specific score value by using the Total Value option. Use the spin 

buttons to increase or decrease the value required in the edit box provided. Note that you can 

use negative numbers to subtract an amount too. 

If you have marked an answer as partially correct (as above) you can score this as a certain 

value out of the total possible score. A running total of the number of correct answers is stored 



in the preset variable SCORE_CORRECT and the number of incorrect answers are stored in 

SCORE_INCORRECT. The total number of questions answered is stored in SCORE_TOTAL and the 

percentage of correct against incorrect answers is stored in SCORE_PERCENT. A running total of 

the score is stored in a preset variable called SCORE_VALUE.And the maximum possible score is 

stored in SCORE_TOTALVALUE. 

Custom Score Variables You can transfer the scores from these inbuilt variables to custom 

variables if you wish by using the Set Variable action explained in a later chapter. 

Update Score 

Alternatively you can make an answer use the Update Score action to amend the current score 

value in a particular way. It does not specifically mark answers as correct or incorrect but you 

could amend these by updating the content of the relevant variable. As such this action can be 

used for more specific changes. You first select the variable containing the score you want to 

update by selecting it from the drop down list box. If you want to use an entirely new variable 

you can create one via the Create New Variable... button. If you want to create a blank variable 

then leave the text field/number field for this new variable blank. 

Next you specify the amount by which this action will revise the Total Value. 

You can then choose to revise the score to a particular value or add a particular value to the 

current score. Use the meter bar or spin buttons to set the update value to the full amount by 

which the Total Value has been changed or merely part of it. 

The variable you specified will then by updated as you have specified whenever this action is 

called. 

Note that the scores will not be retained if the user closes the publication unless you save the 

values in the above variables to disk using the various actions in the Storage section (as detailed 

in the next chapter). 

Reset Score 

You can also reset the scores and all the inbuilt scoring variables by triggering this action. 

Obviously you will need to run this action prior to starting a new quiz in order to ensure that 

the scoring variables are empty and no false results are given. 

Actions: Storage 

This section of the Actions dialog allows you to store information in memory or to disk. This 

might be used to track the user's progress, to store purchases or user details. Opus provides 

three ways of storing information – via a binary disk file, in text format, or by reading and 

writing information to the Windows Registry. All are used in the usual way by assigning them to 

a trigger and then setting the additional settings as required. 



Write to Disk File 

This action allows you to write information in a variable to a binary disk file. These files are 

often smaller than text files and more secure. Firstly you select the variable containing the 

information you want to store by selecting it from the drop-down list provided. 

To store a number or piece of text which is not in a variable simply create a new variable by 

clicking on the New... button and filling in the details as required. 

Then choose the file you wish to write to be typing the name in the box provided or selecting 

one you have already used in this publication from the drop-down list provided. Alternatively 

use the Browse button to locate an existing file on disk. 

As Opus will need to know exactly where this file is when the publication is operating outside 

the editor you can specify the Windows TEMP directory as a location. This is because your Opus 

publication can find out where this is on any computer and because it will always be in a 

location that can be written to. 

You can also encrypt your data so that it cannot be easily read by others. To do this click the 

Encrypt Data option on and then type a Key (similar to a password) in the edit box provided. 

This can be any combination of letters and numbers in both uppercase and lowercase and we 

recommend it is more than six characters. You will need to remember this key or you will not 

be able to read the information from the file again. If you select the encryption option but do 

not specify a key then Opus will use its default key to encrypt the data. You must ensure that 

you use no key for reading the data either. 

Read from Disk File 

This allows you to retrieve information from a specified disk file and store it in a variable. You 

set this up in a similar way to the preceding option but in reverse. If the information was 

encrypted when it was stored you will need to set the decrypt option to on and use the same 

key as was used when the information was saved. 

Write to Text File 

This action allows you to store a specific piece of text information into a standard text file. If 

you do not encrypt the data this allows it to be read by other programs. You can choose the 

information you wish to save by typing into the box. 

TIP You can include field identifiers for databases by typing them in here along with the text 

you want to store. This will enable you to store material in a manner that can be read by an 

external database. Next you have to specify where you want the information stored: 

Allows you to save the information to disk as a standard text file. Note that you will need to 

specify a location that can be written to rather than a CD-Rom drive or a network location, 

which is read only. As with the preceding options you can specify that this file is created in the 



Windows TEMP directory so that you can be sure of where it is. 

Next you need to decide whether this information should replace any information already at 

the location you have chosen or whether it should be added to it. 

Will overwrite any information currently at the location you have chosen to store this 

information. The first time you store information in a variable or file you will probably want to 

overwrite the contents to ensure that there is no spurious information left to confuse what you 

are storing. You will also want to use this option if you are using a file or variable that you have 

used before and wish to start afresh. 

Will add the current information to any already held in the location you have specified. Don't 

forget to include spaces if you want to save separate words and carriage returns if you want to 

save text on separate lines. You can also choose the apply certain basic formatting controls 

such as ensuring the new entry appears on a new line. 

or is separated by a comma (as in a comma-delimited database or CSV file) 

and/or is surrounded by quotation marks. 

These standard formats are particularly useful for interfacing with databases. As before you can 

also encrypt your data so that someone else cannot easily read it. To do this click the Encrypt 

Data option on and then type a Key (similar to a password) in the edit box provided. This can be 

any combination of letters and numbers. You must remember the key you have used or you will 

not be able to read from the file. 

Read from Disk File 

This option allows you to retrieve information previously saved into a disk- based file and save 

it into a variable. Firstly you must specify the name of the file you want to read. For your 

convenience a drop down list of the files you’ve recently used is provided. Alternatively use the 

Browse button to locate the file you want to read. 

If you wrote the file to the Windows’ TEMP directory you can specify that again here. 

You can then specify the variable where you want to store the information by selecting it from 

the drop down list provided or using the New... button to create a new variable. 

If the data was encrypted when saved you will need to use the decryption option and specify 

the same key as was used to encrypt it. 

Read from a Specific Position There are a number of other storage actions that allow you to 

specify particular positions in the file to read information from. 

This action will read the first line of the file, and then the following action will read the next line 

of a file. 

If you want to skip a line without reading it simply use this action 



which will go to the next line. Opus also provides an action to go to the beginning of the file, 

wherever you currently are. 

You can also read a file in sections or “fields” 

for which you will need to specify how the fields are delineated. 

These actions work in a similar way to the Read from File action. 

Read/Write Data to Registry 

These last two actions allow you to read and write information via a special section of the 

registry, with a label attached so that you can easily refer to it. Please note that it does not 

allow you to edit the standard settings of the Registry as this configuration information should 

only be edited if you are sure of what you are doing, otherwise programs might fail to operate 

properly. It simply allows you to use the registry as a reliable location for storing information. 

Write You can either choose to store the information in a variable by selecting it from the drop 

down list. Or you can type the text you want to store in the box provided. Then you provide a 

label for the information so that you can refer to it again. 

Finally, because the registry can be specific to a particular user under Windows you can specify 

whether this information should be restricted to the current user or open to all users. 

This item is not suitable for large amounts of text. 

Read 

When reading information back in you simply specify the label where you stored the 

information and whether you saved the information in the current user’s registry or the registry 

used for all users. 

You must then select the variable where you want the information stored in the usual fashion. 

 

Actions: Launch 

This subsection of the Actions dialog provides three distinct functions. It allows you to launch a 

web page. You can launch a searchable index of your publication, launch another program or a 

second publication. NOTE: The icons illustrating the actions in the following sections are lage 

format to make the detail clear in this manual. The small format icons which appear on screen 

may differ slightly for clarity but should be readily identifiable from the examples here. 

Launch Publication Search 

This option launches the Opus search dialog which will display the index of keywords as set up 

via the Page Properties for each page, allowing the user to select a keyword and a page on 

which it appears. When you create a series of keywords for pages, Opus builds a publication 



search database, which this action requires to function properly. This database is automatically 

distributed with your finished project but if you need to override this for any reason you can do 

by deselecting the Use publication search database option on the General tab of the publication 

properties. 

Launch Web Page 

This option launches the user’s default web browser and connects to the page you type into the 

edit box provided, this could be a page on the internet or simply an HTML page on the local 

network. 

Launch File 

Allows to start running a separate program or another Opus publication. Applying this to a 

trigger will provide an additional tab to set up the various options. The first part of this allows 

you to specify the file you wish to launch. 

Use the Browse button to locate the file you want to launch or type the path into the box 

provided. If the program you are launching accepts a run-time parameter you can pass that to 

the program by typing it into the box provided. 

This is most often used to give the program a file to open or by setting options it will start with. 

Obviously your publication will need to know where to find this program when it runs on your 

user’s system so Opus allows you to specify a location. There is also the option of getting the 

location from a variable. While this can be a variable set up during the course of the publication 

it is perhaps most useful to use preset variables to specify particular system locations. This 

includes various standard system directories and the system CD-Rom drive that will 

automatically search for a CD-Rom drive irrespective of the actual letter the drive uses. (See the 

glossary of inbuilt variables for further details.) 

You can also specify whether you want the publication to close when the program is launched 

or to continue to run in the background for the user to switch back to later. 

  



QuickBuild 

Opus provides a special set of functions which are shortcuts for commonly- required tasks or 

for improving productivity when creating a publication. They are often a combination of 

existing functions provided in one simple shortcut. The exact set of QuickBuild functions will 

depend on which particular version of Opus you have bought but the following chapter 

provides an overview of the most common ones. Step-by-step instructions on how to use each 

function are provided in the Help file. Most of the functions are provided via a dedicated 

QuickBuild menu or are provided on the right mouse menu for the relevant object. 

Copying Appearances Opus lets you select multiple objects and set the properties for them all 

at the same time to quickly create a consistent appearance. However, there are times when 

you will have already designed a key object or cannot use this feature for some other reason. In 

this case QuickBuild provides several functions to allow you to copy and paste the style of one 

object to another. Obviously the object must support the type of property you are trying to 

copy and, for example, vector objects can have some styles applied to the whole object while 

you can also copy the fill and outline of individual polygons separately. To use this QuickBuild 

function you simply select the object containing the style you want to copy and then select the 

relevant function to Copy the appropriate style to memory. Now you can choose the object to 

apply the style to and select the complementary Paste function from the QuickBuild menu. 

Note that while your publication remains open and until you use the Copy command again, the 

properties you have chosen will remain available to Paste again and again as required. The 

commands available are: Copy/Paste Appearances – allows you to copy the properties used for 

the different states of an object; mouse over, down, disabled etc. Coy/Paste Appearance 

Elements – allows you to copy the elements of an objects appearance such as background, 

borders, texture, blend and so forth. Copy/Paste Text Style – lets you reproduce the style and 

formatting of a text object not including the justification. 

Copy/Paste Vector Fill and Outline – allows you to copy the fill style and colour and/or the 

outline style and colour of individual polygons in a drawn object. 

Rename All objects in Opus are given default names based on their object type but when 

building even simple publication it is often useful to have a name which is more indicative of its 

content, especially when you come to look for it in a list to apply an action to it. QuickBuild 

provides two functions to help with this. Rename from Contents – this function renames the 

object based on its content. Thus for text objects and buttons it takes the first word or two. And 

for images it uses the name of the image. Rename – a more basic renaming function allows you 

to name a series of objects with the same name but apply a number. This mimics the default 

style of naming but allows you to select subsets of objects or to make numbering consistent 

after copy and pasting or deletions. 



QuickBuild Sound Effects Some QuickBuild functions are not found on the QuickBuild menu at 

all some are provided exactly where they are required. This is the case with the QuickBuild 

sound effects functions. These are provided via a button on the dialog for buttons and for 

transitions and text animations and allow you to quickly apply a sound effect to that activity. 

Click the button and the Opus Sound Browser will appear and you can choose a sound to use. 

Then click OK and QuickBuild will automatically build the action required to play the sound 

when the transition happens or the button is clicked. Once you have used the QuickBuild option 

you can go to the Actions dialog for the object and change the actions or the sound file in the 

usual way. 

Other Functions The other functions of QuickBuild included in most versions is the option to 

insert special text characters and is dealt with separately on page 127. In advanced versions of 

Opus QuickBuild will also include options for creating tables, script templates to perform 

specific tasks and these are dealt with in the relevant manual for those versions and, of course, 

in the Help file. 

  



General Properties 

You can set general properties for your interactive publication by using the Publication 

Properties, you can then qualify some of these on a chapter by chapter basis using the Chapter 

Properties. In particular these sets of properties allow you to edit and vary the window within 

which your publication is displayed in. Some of these options are not relevant in special types of 

publications such as video or DVD-Video publications. In more advanced versions of Opus you 

can quickly move between the different levels of Properties without leaving the Properties 

dialog using a mini toolbar in the bottom left corner of any Properties dialog. 

The first buttons allow to quickly move to Publication, Chapter or Page Properties. The 

remaining arrow buttons allow you to move up and down through the objects at the level of 

properties you are currently or to move up and down the objects in the Organiser tree view. 

While you familiarise yourself with which button takes you where it is important to watch the 

Organiser to ensure that you have not inadvertently moved to another the properties of 

another publication or chapter. But once you are familiar with this toolbar it can provide an 

invaluable shortcut during development. 

Publication Properties The Publication Properties allow you to set a range of aspects to apply to 

the whole publication including how it exits, resets and whether it is password protected. In the 

Organiser view, select the title of the Publication you wish to edit and then select Properties 

from the right mouse menu. Alternatively select Publication Properties from the Edit menu. As 

with all Opus objects this will bring up a tabbed dialog box providing the full complement of 

options. In this case there are four tab sections. 

General 

At the top of this section is an edit box for you to enter the title of the publication as required 

for the setup program and the file name of the disk-based file to which you have saved your 

publication, or the default name if you haven’t yet saved it. 

To create or edit a title simply type in the edit box as required. The filename is automatically 

maintained by Opus from the disk file you have saved the publication file to. Opus also provides 

the ability to consolidate the resources of your publication which copies any external material 

(images, sounds, etc) which you have used in your publication to a single sub-directory of 

you’re the directory where you have saved your publication. Click the Change button to call up 

the following dialog allowing you to type the new resource directory name in the box provided 

and/or to specify whether the resource consolidation should merge duplicated files (that is, the 

same file used in two distinct places in the publication). 

The other consolidation option on this tab allows you to tell Opus to automatically consolidate 

the resources whenever it saves the publication file. The options are to do this automatically 

every time, to ask you if you want to consolidate or to never consolidate when saving, allowing 



you to use the separate Consolidate Resources option from the Publication menu whenever 

required. 

Simply click the radio button for the option you require. 

This tab also provides the options to set whether the publication uses multiple bookmarks and 

whether or not to use the publication search database both of which are dealt with in their 

specific sections. 

Options The options tab allows you to control certain general options for your publication. They 

apply across the whole of your publication. 

Reset This allows you to tell the publication to go to a certain page if it has been inactive for a 

period of time. This can be useful when you have a touch screen publication, which the public 

will probably explore and then leave at a certain point. This option allows you to return to the 

main menu or attract sequence after a certain period of time. Simply set the time interval 

required using the spin buttons and choose a page to go to from the drop-down list of those 

available. You can also choose to exit the publication if required. 

Note when setting the time interval that you need to give your user time to read and think 

about what you have displayed on the page containing the most information, or the user will be 

frustrated by the publication being reset when he/she is still using it. If you have an order form 

or similar page in your publication you will need a very generous time interval. 

Exit On this tab you can also choose how the publication will be closed down and how it will 

behave when it does. You can set an action to close down the publication by selecting the Exit 

Publication on the General tab of any Actions dialog, but you might also wish to set the Esc key 

and/or the familiar Alt+F4 key combination to exit the publication at any point. 

In either case you may wish to stop unauthorised users from halting the publication by 

protecting it with a password, which you can type or edit in the box provided. 

You may also wish to ensure that however the publication is closed down, a particular page is 

displayed, perhaps a thank-you message or set of credits and/or copyright notice. These 

facilities are provided in the On Exit section. Remember not to include another Exit button on 

the exit page or your user may become confused. Opus will recognise that you have already 

called the Exit routine before and will leave the publication if an Exit action is asked for again. 

Surround Colour Finally, this section of the dialog allows you to specify a colour, which is used 

to surround the publication if the page is smaller than the user’s screen size, or the window in 

which the publication is being displayed. Simply select a colour from the colour well as 

required. 

Window This tab allows you to set the manner in which the pages of your publication will be 

displayed. You can choose to display the publication full screen, thereby blocking out Windows 



completely. If the user’s screen mode is larger than your publication, the surrounding area will 

be filled with the Surround Colour as set on the next tab. If you do not want this to happen you 

can force the user’s computer to change to a particular screen mode by checking the box 

provided, and selecting the screen mode you require from the drop down list provided. 

 TIP Alternatively you can set your Chapter Properties to allow your pages to be resized and if you don’t restrict 

the size and keep Publication Properties set to full screen they will automatically take up the whole screen 

whatever screen mode your user is running. Alternatively you can run your publication in a Window and can set 

all the various options relating to that Window. In particular you can set the publication to stay on top of any 

other Windows on screen. This is ideal for tutorial publications or help files which can be played over the top of 

the program to which they refer. You can give it a title bar by clicking the relevant checkbox and a title to display 

by typing into the edit box provided. 

By clicking on the appropriate checkbox you can add a system menu and minimise and 

maximise boxes (the window controls which appear at the right hand edge of the title bar). 

You can give the Window a thin single line border, or a resizable border as is traditional. This 

latter option allows you to create a publication that can be resized by the user. Resizable 

publications will stretch to fill the window, but please note that they will not reduce to smaller 

than the page size. If your user resizes the Window below the page size scrollbars will appear. 

If you want a publication where the objects can all be reduced to quite a small size, you should 

design your publication with pages set at this minimum size, but then set the size of the 

Window to start much larger. By using the spin buttons to increase and decrease the values you 

can also edit the size of the window and its position on screen. 

Cursors This section of the Publication Properties allows you to specify particular cursors to be 

used throughout the publication. You can choose the cursor used for normal selection and 

another for indicating that the system is busy. The former is overridden by the custom cursors 

you set for specific objects as described previously (see page 148). As with other custom cursors 

you can select a cursor from the standard ones available, or assign a disk-based cursor file such 

as those provided on the Opus CD-Rom. 

Passwords You can set passwords to limit access to the publication or to individual chapters 

within it. These are set up via the Passwords tab of the Publication Properties. From the 

Organiser view select the title of the publication and then select Properties from the right 

mouse menu. 

Click on the Enable Passwords option to activate publication passwords. The box labelled 

Passwords, on the left of this dialog contains a list of passwords available, and the section on 

the right contains a list of the Chapters with checkboxes alongside. To add a new password click 

on the Add button and enter the desired password. When you click OK the new password 

appears in the Passwords list. The password is not case sensitive, and you are allowed to enter 

spaces. To attach a password to a chapter, select one of the passwords on the left and then 



click into the check boxes of the chapters to which the password is to be attached. If you do not 

want to attach a password to a particular page then you must select <None> as the password: if 

you don’t select a password or <None> then that chapter becomes inaccessible. If you specify 

more than one password for a particular chapter then either of those passwords will allow 

access to it. The Password Input section of the dialog allows you to specify when the user is 

prompted for the password. Use the Prompt for password at start option when you want to 

specify a single password controlling access to the publication. In this case you should give all 

the chapters the same password. Use Prompt for password as required when you want to 

control access on a chapter by chapter basis. The user is then prompted for the appropriate 

password when they carry out any action that would normally move them to another chapter 

(for example a Button with a Go to page action attached). To enable interaction with the user 

you can alternatively select Don’t prompt – use CHAPTER_PASSWORD variable. Use this option 

if you want the user to enter the password into a Text Input box within the publication. To do 

this you would draw a Text Input box and in the Text Properties specify that the input typed by 

the user is stored in the CHAPTER_PASSWORD variable. Then, when they carry out any action 

that would take normally take them directly to a new chapter, this variable is used as the 

password (See the sections in the main manual on “Getting Text Input” and “Understanding 

Variables” in Advanced Techniques for more details regarding this.) In case the user enters the 

wrong password, it is possible to direct them to a specific page by checking the If go to page 

fails, go to this page: checkbox, and specifying a page. This page could contain information for 

the user regarding password entry and/or provide appropriate buttons to continue with the 

publication or alternatively exit. 

The last checkbox, Disable passwords in editor preview, allows you to disable passwords whilst 

you are creating the publication. In this case passwords are only enabled within the final 

published publication as it can be annoying to have to type in a password to return to Opus 

every time you preview a page while you are still editing the publication and probably 

previewing the result quite often. It is recommended however that password access is 

thoroughly checked before final publication. 

Variables Finally you can set up, view and/or edit a list of the custom variables used in the 

publication. These are variables you have created for the publication rather than the inbuilt 

variables provided by Opus, which are automatically available in all publications. 

Chapter Properties Chapter Properties allow you to specify certain properties for all the pages 

in a particular section of the publication. In particular they are used for setting the page size for 

the pages in that chapter, and for allowing you to display the pages in that chapter in a separate 

window. 

General On the first tab you can edit the Chapter Title as displayed in the Organiser and specify 

a page size for the pages in that chapter. Page sizes for the standard screen resolutions are 



provided as preset options, but you can choose any page size you wish via the Custom Size 

option. 

You can also set whether the pages can be resized or are fixed. If they are resizable you can 

restrict them to a particular maximum size. You can also specify that they retain their original 

proportions (aspect ratio) when being resized. 

Window The second tab of the Chapter Properties allows you to specify that the pages in this 

chapter are to be displayed in the Window detailed in Publication Properties as previously 

explained, 

or whether they should be displayed in a new window, in which case you can set the same 

options for the new window as you could for the main publication window. Including whether 

the pages automatically resize to fit the window and whether the window will be Always on 

top, which means it, will always appear on top of any other window on the desktop. This latter 

setting is particularly useful for help files and software training publications where the 

instructions can sit permanently over the software being used. 

TIP Setting the Location to 50% in both directions will cause the window to display in the 

centre of the screen whatever the screen resolution is. 

This facility is excellent for providing supplementary information in windows, which overlay the 

main window, such as help or dictionary definitions. Pages in the separate windows can be used 

independently. You can have multiple additional windows. 

  



Previewing Your Publication 

As you begin to lay out your publication and add actions you will want to see how your 

publication will look to your user. You can preview your publication at any time in one of two 

ways. You can preview the page you are working on by selecting Preview Current Page from the 

Publication menu, pressing F5 on the keyboard or clicking the Preview Page button. 

Or you can Preview the whole publication from the start by pressing F4 or pressing the Preview 

Publication button. 

In both cases your publication will appear on screen exactly as it will appear to the user except 

that it may be slightly slower. You can exit the preview by closing the publication. If you haven’t 

got an exit button on the current page you can use the overall exit procedure defined in 

Publication Properties. By default pressing the Esc exits the publication so you can use this or 

Alt+F4. 

 

  



Working with Files 

Throughout the time that you are creating your Opus publication, you will obviously want to 

save your work and load it back in again when you next work on it and so on. You should also 

note that Opus does not incorporate the resources you use directly into the publication until it 

is published. This lets you edit them independently and also means that you don’t get two 

copies of what can be very large files chewing up your disk space. 

Loading and Saving Your Work You can save your publication by clicking the familiar Save 

button on the toolbar or selecting Save or Save As... from the File menu. Save simply saves the 

file under its existing name while Save As... allows you to give it a particular name. If you have 

more than one publication open at a time you can use the Save All option to save them all in 

one go. 

Opening Publications When you start Opus, the program will automatically load the publication 

you were last working on unless you switch this option off in the Options dialog. You can cancel 

this automatic loading by pressing Esc. You can open your publication again using the familiar 

Open button on the toolbar or by selecting Open from the File menu. You can open several 

publications at one time enabling you to cut and paste material between them if required. 

Closing Publications You can Close any publication and thereby remove it from the editor 

without closing the editor itself by selecting Close from the File menu, or from the right mouse 

menu when you click on a publication title in the Organiser. If you haven’t saved the publication 

you will be prompted to do so. 

Emailing Your Publication 

You can email your publication to an alternative location for yourself or to friends or colleagues 

who are using Opus. Select the Email Publication option from the File menu. This will create a 

zip file of your current project and allow you to email it. Note that it does not distribute the 

finished standalone publication, which should be distributed using the Distribution Wizard. You 

will be asked if you wish to consolidate the resources for the publication into the distributed 

file. If the resources are not available to the recipient you will need to do this but it can increase 

the size of the file substantially. 

Backup Publication Opus regularly creates an automatic backup of your publication as you work 

but you can create a backup of your publication as a ZIP file (i.e. a compressed file) that can be 

sent to other others users. The backup can also include the resource files if required. This is 

most often required when you have completed a project or to keep a fallback point. 

To backup your publication: 

1. Click on the File menu, then select the Backup Publication option. This 

will open a warning dialog box on the screen. The warning dialog box asks if you want to 



contain your resources in the zip file. Adding your resources could dramatically affect the size of 

the file but will ensure that the user will see the resources if they run the publication in the 

Opus Editor. 2. Click on the Yes button if you want to add the resources. Click on the No button 

to not add the resources to the file. Clicking either button will open a new Save As dialog. 3. The 

Save As dialog will provide a name for the zip file you are about to create. The name of the zip 

file is based on the filename of the publication, plus the current time and date. You can change 

the name if required. The folder in which the zip file will be stored is the same as the folder in 

which your publication was created. Again, you can select a different folder to save the zip file if 

required. 4. Click the OK button in the Save As dialog to create the backup. 

You can open the backup file using a program, such as, WinZip to unzip the file. 

Note: Opus automatically keeps a backup of your publication while you are working so that if 

your computer crashes for any reason not all your work will be lost. However, we strongly 

recommend that you do not rely on this feature and save your publication regularly as you 

work. We also recommend that if you experience a problem while editing your publication you 

close the program and revert to your previous version or you may find that you compound an 

issue which then causes greater problems later on. Multimedia publications often place 

considerable strain on a computer’s resources and Opus relies on technology incorporated in 

Windows or in graphics drivers which can sometimes cause temporary glitches. 

Revert Publication If you make changes to your publication during your current session and you 

decide that you no longer want to keep them, you can go back to the last saved version of your 

publication. 

To Revert Publication: 

1. Click on the File menu, then select Revert Publication – a message box will appear on screen 

asking you if you want to lose all the changes you have done since your last save. Click Yes if 

you want to revert to the last publication and No if you want to keep the changes you have 

currently made. 2. The Redo buttons history will be empty, in other words, if you change your 

mind and you want to keep your changes, you cannot. So be careful – only use this option if you 

really want to revert to the last saved version. 

Component Galleries Opus allows you not only to load and save publications but also any of the 

resources and component objects of your publication. These can range from simple graphical 

buttons and image frames containing company logos to whole pages and combinations of 

objects. The function is particularly useful to store objects that you are going to use repeatedly 

in the publication, or in a series of publications, as well as to act as a pasteboard for objects 

while you redesign a page or decide whether an alternative option is going to work. A number 

of galleries of these objects are provided with Opus so that you can create your publications 

even faster. 



You can temporarily store your objects by pressing the right mouse button down and dragging 

them from your page onto the Scratch Pad component gallery. A small menu will appear letting 

you decide whether you want to move or copy the object to the gallery. 

You can permanently save your objects by using the process above to copy them to galleries of 

your own making and then saving these galleries to disk. The Components menu offers all the 

tools for managing your component galleries including creating a new gallery, renaming a 

gallery and opening and closing galleries. 

Creating a Gallery You can create a gallery by selecting New Gallery from the Components 

menu. 

When you select this option the Gallery Wizard will be started. The first page of the wizard 

simply prompts you to enter a name for the gallery. When you click on Next, the second page 

prompts you for a file location (remember that galleries are stored as independent files 

available for re-use). Either accept the default location or use the standard Windows Browse 

button to select a location. 

On the third page of the wizard you may either choose to create an empty gallery into which 

you can then drag objects from your publication(s), or automatically fill the gallery with files 

from a specified directory. If you have already collected your resources (pictures, video, text 

files etc.) within a file directory then this option allows you to fill your gallery with resource 

thumbnails that can then be simply dragged onto your pages as required. If you select this 

option, then the next page of the wizard asks you for the location of your resource directory 

and the types of file to be added. You can even choose to look in subdirectories beneath the 

chosen directory. This is ideal for creating clip art browser galleries or libraries of other 

resources. 

When you click Next the gallery is loaded with the resources selected. Click Finish to return to 

Opus. The new gallery is ready for use in the Organiser and you can select it by selecting its 

name from the list at the top. 

Component Resources You also have the same tools for managing the resources used in 

components as you have for managing them in publications (see below), via the Resources 

option on the Components menu. 

In particular you should consolidate the resources of any components you want to keep long 

term to ensure that they are not lost or deleted and remain available for use by the 

component. 

Components with Multiple Objects When creating your own components it is important to 

remember that to save components containing multiple objects, especially those which work 

together, you should ensure that all the objects are drawn as sub-objects of a frame which can 

then be saved as a component. 



Managing Resources Until you publish a stand-alone copy, Opus does not keep a copy of your 

resource (video, image etc) in the publication file but instead refers back to your original disk-

based file. This allows you to update the resource at any time and have the publication 

automatically updated. In even moderate-sized publications it can be difficult to keep track of 

all your resources unless you are very well organised. When you load a publication, Opus will 

warn you if it can’t find any resources used in it. The program also provides a Check Resources 

option on the Tools menu, which will see if any of your resource files are missing. If some of the 

objects or pages suddenly go blank this is likely to be the reason. You will need to use Check 

Resources to find which ones are affected and try to work out why – perhaps they were on a CD 

you removed to make way for another, or they were on a network drive which is temporarily 

unavailable. There is also a Consolidate Resources option, which will copy all the relevant 

resources used in the publication into a resource subdirectory of wherever you have saved your 

publication (or the Windows Temp directory if you haven’t yet saved the publication). Choosing 

this option brings up a dialog box which allows you to specify a different subdirectory. 

It also allows you to merge duplicate files, which means that if you have used the same graphic 

in several places Opus will keep just one copy. 

Furthermore, because some users will also want to access their publications on different 

network drives, or colleagues may work on them on different workstations, Opus lets you 

quickly change the data drive for resources. The Change Data Paths option on the Tools menu 

allows you to re-direct Opus to the new directory where the resources may be found. 

When distributing resources with works in progress, Opus will automatically maintain relative 

paths to resources, so if the material is in the same relative location to the publication (in a 

subdirectory of the publication directory for example), Opus will find it without needing you to 

change data paths. Finally, when you’ve completed your publication and are confident that you 

no longer require any unused resources, you can use the Purge Resources to remove them from 

your resource subdirectory. 

Material from Other Programs As well as being able to import all the most popular file formats 

used in multimedia, Opus fully supports the Windows Clipboard so you can use the familiar Cut, 

Copy and Paste commands to transfer material from other applications into your publication 

and vice versa. Most often the material will transfer from other programs either as text or as a 

bitmap graphic. Remember that scaling a bitmap graphic may cause a degradation of the 

image. If the pasted object is very poor and seems to have bits missing you should either switch 

the Scale to fit option off or resize the object in the original program. 

Using Paste If you have a particular and compatible object selected in Opus then the object you 

paste will be pasted into that object overwriting its existing content. Otherwise you will be 

given the relevant object creation tool so that you can create the object on the page as you 

would any other object. 



Notes View A Notes View option is provided for each page in your publication so you can store 

information about the page which will not appear in the publication. Thuis can be useful for 

providing speaker’s notes to accompany a presentation or for passing information between 

colleagues working on the same project. The Notes View supports Rich Text Formatting (RTF) 

and can be printed-out showing both the notes and a picture of the page. At the bottom of 

each page is a new panel in which you can type-in your notes... 

The panel always appears below the page and is separated by a bar. You can resize the Notes 

View by clicking on the bar that separates the notes from the page: 

Move the mouse between the page and the Notes View and the cursor will change to a splitter 

control illustrated on the left. 

Click and drag the divider to the new position where you want it. 

When you release the mouse button, the two panels will resize to their new position. 

Any text that you enter into the Notes View can be formatted using the Format toolbar... 

As with any text object on a page you can change the Notes View font style and size or make 

the text bold, italic or underlined. You can justify the text and make bulleted lists, as well as 

change the colour of the text. Bulleted lists may be particularly useful if you are creating 

speaker’s notes that accompany each page. When you print the page, you can include the text 

in the Notes View on the print-out, as described in the next section. 

Printing the Notes View text Often you may want to add notes to a page to simply remind you 

of changes or amendments you have to make to the page before it is completed. At other 

times, you may want to be able to print the text along with a representation of the page. For 

example, when you create a presentation it is often useful to have speaker’s notes to refer to as 

you are delivering a presentation. In large projects it is also useful to add developers notes to 

each page to show the current status of the page, e.g. whether the page is completed, awaiting 

more information, under construction, and so on. In both examples above, being able to print 

the Notes View is very useful and in Opus it is also very easy to do. Select the Print Publication 

option from the File menu to open the Publication Print Layout dialog. At the bottom of this 

dialog, tick the Include notes view option to add the Notes View to the print-out: 

You can align the notes to appear underneath the page thumbnail on the print- out by selecting 

the Bottom option or to the Right of the page thumbnail. 

A preview of the page layout appears on the right of the dialog. Below is an illustration of the 

preview window showing the Notes View aligned to the Bottom of the page... 

The position and size of the Notes View in the preview window is shown as a red grid box. You 

can change the size of the Notes View on the print-out by increasing or decreasing the Page Size 

slider... 



When the slider is positioned to the right-most edge, the page will be the largest size that can 

fit width ways on the page. In the Illustration above, the page size will be approximately half 

the size of the page width, which means there is more space available for the Notes View text. 

Use the slider to set the size of the Page and Notes view, and then click on the Print Preview 

button to check if it matches your desired affect. For more information on the other options on 

this dialog, search for the term ‘Publication Print Layout’ in the online help. 

Turning off Notes View When you start a new publication, the Notes View is automatically 

displayed at the bottom of each page. To turn off the Notes View for new publications or for 

the publication you are currently working on, select Options... from the Tools menu and click on 

the View tab. 

Un-tick the Use Notes View option to turn off the Notes View. At any time you can turn Notes 

View back on by ticking this option. Any notes you have previously entered in the Notes View 

for a page are saved and will re-appear when you turn this option back on. Finally, the Notes 

View is only visible in the Opus Editor and will not appear when you preview or publish your 

publication. 

  



Publish - Distribute - Upload! 

When you have finished your masterpiece of interactive multimedia you will want to create a 

copy of the program that runs independently of the Opus editing environment. This is called 

publishing. 1. You can publish to a single stand-alone publication which you would use to run 

from the hard disk of your computer or to copy onto a CD-Rom to run from there. 2. You can 

choose to create the publication in a version suitable for use on an internal intranet or a web 

page on the internet using the Plexus plug-in. Note that unlike HTML editors, Opus offers full-

blown multimedia on the internet through the Plexus plug-in so your publication will appear on 

the internet exactly as it appears on your machine. Note that Opus also allows you to create 

files in Macromedia Flash format for the internet by choosing the Opus Flex publication type. 

This has the additional advantage of making your publication compatible with Apple Mac 

computers but some of the multimedia and graphics functionality in Opus is not available in 

Flex. 3. Finally you can choose to create your publication as a screensaver. This can be 

particularly useful for creating motivational or information material that automatically comes 

up on the recipient’s computer whenever they leave it inactive for a period of time. Opus also 

provides the facility to create a distributable copy in which your publication requires are 

combined into a setup program to install it just like any other Windows program. You can even 

install an icon for the program and allow uninstallation of your publication. If you have created 

a publication for use on the internet you will also want to upload it to your website. Opus takes 

you through each of these processes step-by-step using a wizard for each. The Publish Wizard is 

available from the Publication menu and the Distribution Wizard Upload Wizard and the 

CD/DVD Burnign Wizard are available on the Tools menu. 

Publishing Wizard The first page of the wizard asks you to select the type of publication you 

require, as described above. 

The second dialog will ask you to enter, or Browse for, the directory in which you want to store 

your final publication. Opus will create a directory if the one that you specify does not already 

exist. 

Click Next to continue. When you click on Next the publication will be created and the wizard 

will display confirmation that the publication has been created. You then have the option to 

test-run the new publication or to return to Opus. 

Publishing Settings Opus is specially designed to optimise your publication and make the 

smallest most efficient, but best-looking publication possible. However, there may be times 

when you wish to override the default settings. You might, for example, need to reduce the 

JPEG compression of images to ensure that they retain all their original detail or you may want 

to increase the file compression even further even though this might slow the publication. 

These options are available via the Settings button on the final page of the Publishing Wizard. 



This will bring a dialog with a set of three tabs covering general items, publish options and font 

handling. 

General 

Separate Data Files 

By default, Opus creates a single from all the resources and data in your publication but you can 

also choose to separate the resources out into a separate single data file or in some 

circumstances you might wish to divide the publication up into separate files for each chapter 

or even for each page. These latter options allow you to distribute parts of your publication 

separately or to update pages/chapters individually. 

Using this option will cause the publish wizard to create an executable file for the base 

publication and an .ilm data file for each page/chapter labelled appropriately. 

Icon You can choose an icon for your publication by using the Browse button to locate the 

appropriate file. It will be previewed in the box provided. A number of icons are provided with 

the program. If you do not select your own the Opus publication icon will be used. 

Cover Dialog This section allows you to specify a cover dialog for your publication. This is the 

small opening splash screen that pops up when the publication is launched. By default this is an 

Opus Publication logo but you can use any bitmap graphic you like by using the Browse button 

to locate it on your computer. An option is provided to include the Opus logo even on your 

custom bitmap to give your user some confidence in the provenance of the program. 

Note that this functionality is NOT provided in versions of Opus which have education-only 

licences. These products must display the Opus logo in publications. 

AutoRun Finally you have the option to create an autorun.inf file for your publication which can 

be used if your publishing to CD-Rom to cause the publication to be run automatically when the 

CD-Rom is inserted in the drive. You can also set this option during the Distribution Wizard. 

Screensaver Settings If you choose to create a screensaver you have slightly different options 

available to set. Primarily these allow you to set how the screensaver can be interrupted. But it 

also allows you to specify that the mouse cursor is hidden during the screensaver. 

In most circumstances you will leave all these options on, as this is the standard behaviour for a 

screensaver. 

Options 

Image Compression Opus uses JPEG compression to reduce the size of the image files of your 

publication but this is a lossy compression technique which means that detail may be lost if the 

compression is too high. By default Opus uses a compression amount that will be unnoticeable 

in most instances. However, this option is available to change the image compression settings 

in either direction. You can choose to switch the JPEG compression off and use a compression 



technique that doesn’t have the potential to reduce detail. 

You can use lower colour depth images but this may require dithering, which can also affect the 

quality of the result. 

Or you can turn the JPEG compression up or down as required by using the spin buttons or 

meter bar provided. 

File Compression A simple slider control is provided for you to choose between six levels of 

compression for the file(s) your publication comprises. 

Note that setting the compression to the maximum level will significantly increase the time the 

publishing process will take. However, the greater the file compression the quicker the 

publication will load. 

Fonts The final section of this dialog allows you to specify which fonts are rendered and which 

can be assumed to be present on your users machine. In most cases you will only want to 

assume the basic fonts are available and therefore ask Opus to embed or render the rest. This is 

the default setting. Note that some fonts can be “embedded” which means they are 

incorporated in your publication file. Others are not provided by their copyright owners on this 

basis and therefore need to be rendered instead. However, if you are only distributing the 

publication within an organisation or through a controlled distribution where you know which 

fonts are going to be available then you can edit this option here by ticking or clearing the 

checkboxes for each font as required. 

Distribution Wizard When you have created your independent publication, you can create a 

version that can be distributed via CD-Rom, floppy disk or the web. 

When you have completed the publishing process the Publication Wizard will give you the 

chance to run the Distribution Wizard, which will take you through the steps to create a 

distributable version of your publication, or the Upload Wizard, which will take you through the 

process of uploading an Internet publication to your web site. If you choose not to run these 

wizards at this time you can run the subsequently by selecting them from the Tools menu. In 

which case an additional dialog will be included in the wizard asking you to specify the files you 

want to distribute. The first dialog asks you for the default installation directory. This is where 

the publication will be installed on your user’s machine unless the user changes it in the course 

of the setup program. It is not the location where the files will be stored on your machine – this 

can be specified on the final dialog of this wizard. It also allows you to restrict access to the 

setup program by using a password. Again you must ensure that you take good note of the 

password and remember it or you will not be able to use the setup program. The final dialog of 

the wizard asks you to specify the directory where the finished setup file(s) will be stored on 

your computer. It also provides the option to create a single setup file (suitable for distribution 

on CD-Rom for example) or to break it up into pieces small enough to fit onto floppy disks. 



When you have set these options and pressed Next to continue the program will combine and 

compress a simple setup program with your publication file(s). Please note that Opus does not 

create floppy disks or CD-Rom’s for you. If you selected the floppy disk options then your 

publication is created in the specified directory on your machine, with a subdirectory created 

for each of the disks necessary to distribute your publication (called Disk1, Disk2 etc.). You then 

simply need to copy the contents of each subdirectory to a floppy disk for distribution, using a 

file manager such as Windows Explorer. If you selected CD-Rom then the publication file is 

again saved in the specified directory on your machine, and need copying to CD-Rom using CD-

writing software. 

Upload Wizard 

Available from the Tools menu or from the final page of both the Publishing operation, this 

wizard effectively provides an automatic ftp program to upload your publication files to your 

website. If you run the wizard from the Tools menu you will need to select which files you want 

to use but otherwise there is only one dialog to complete. This allows you to set the name of 

the server to which the file(s) will be uploaded, the username (or ID) and password required to 

access the server. You can also specify the directory on the server where you want the files 

placed. 

Publishing to CD-Rom If you want to publish your publication so that it can be run from a CD-

Rom you can select the Create stand-alone publication option and then use a CD writing 

software to copy your publication onto a gold disk for duplication. If you want to publish a 

publication which can be installed from CD-Rom you should run the distribution wizard to 

combine your finished publication with a setup program but remember to consider your users 

hard disk space if your publication includes substantial video or sound files. Once again you 

must then use CD writing software to copy the files onto a CD-R disk. 

Opus provides inbuilt CD-Rom and DVD burning facilities using via the CD/DVD Burning Wizard. 

This uses third party software which may be updated or adapted separately and we 

recommend that you refer to the Help file for current details. 

AutoRun Many CD-Roms are designed to run automatically under Windows so that their main 

program runs as soon as the CD-Rom is placed in the drive. You can set your publication to run 

automatically by creating the autorun.inf file, which tells Windows launch the publication CD-

Rom upon insertion. The option is provided on the Publish Options dialog available via the 

Settings button on the Publish wizard. Simply check the box provided to create the required 

file. It is also available during the Distribution Wizard. 

Uninstallation Options Any distributed publication can be uninstalled via the Add/Remove 

Programs section of the Windows Control panel. The final page of the setup program advises 

your user of this. Once your publication is complete you can choose to test the result by 



pressing the Test button. Pressing the OK button will return you to editing your publication. You 

can run your stand-alone publication at any time by using Explorer to find the publication.exe 

file (it will be in the directory you specified and have the publication title as a filename) and run 

that as you would any other program. If you are publishing a distributable copy of your 

program, all the relevant files will be combined into data files of the correct size to fit on the 

disks you specified in the Distribution Settings section of the Publish Options dialog. These will 

then be created into separate subdirectories for each disk. These subdirectories are called 

disk1, disk2 etc as appropriate. Disk 1 will include the setup.exe and setup.ini file together with 

the first data file, disk1.dat. The remaining disks will contain a single data file named 

appropriately disk2.dat, disk3.dat etc. 

Copy to Floppy Disk For publications to be distributed on floppy disk you should copy over the 

contents of the subdirectories described above onto individual, formatted floppy disks using 

Explorer or similar. 

Publication Cover Dialog When Opus starts up, it loads a small start-up screen that tells the user 

that the publication is loading. By default this is a small dialog indicating that an Opus 

publication is loading but you can change this via the Publication Properties. 

Use the Browse button to locate a graphic image you want to use instead. You can then also 

choose to have the Opus logo overlaying this image. This can be useful to “certify” the 

publication as an Opus-based publication. 

Opus Flex Start Up If your version of Opus provides Opus Flex publications you should note that 

the standard cover-dialog is not used. Instead a special header is provided which appears while 

the Flex publication is being downloaded to inform the viewer of what is happening. If you have 

visited a website with a large Flash file on it you will be familiar with these “Loading...” 

animations which often appear on these pages. These are called preloaders. By default Opus 

uses a simple branded loading screen but you can change this to an image of your own or use 

an animated preloader which is a special Flash file. A number of these have been provided or 

you can use an alternative package, such as Presto, to create a Flash file to use though you may 

need to be familiar with scripting to represent progress properly. 

Opus DVD Opus also provides a different cover dialog for DVD-Video publications because of 

the difference in style and appearance of these publications. 

More Sophisticated Installations If you require more sophisticated installations or a single self-

extracting compressed installation program, you can create a stand-alone publication and then 

combine the files using a specialist installation development tool. We recommend Wise 

Installation System and with the kind permission of developers GLBS have provided a trial copy 

with this product. 

What Files Are Created? The files created by the publication process will depend on what you 



have included in your publication, what target system you have published to and whether you 

have created a stand-alone, distributable or web publication. The basic publication will contain 

an executable file for your publication. If you requested a separate data file or files the 

publication will include an .ilm data file for each data file as specified in the Publish options. 

These will be given the title of your publication as a file name e.g. MyPub.exe and MyPub.ilm. 

When publishing to screensaver format the .exe file is replaced with a .scr file. When publishing 

to the Internet, the .exe file is replaced by an .htm file, on which further details are given below. 

What Happens to the Resources? All the resources you use in a publication are compiled into 

the finished data files and are not available independently to your user thus allowing you to 

safely distribute copyright material. The exception to this is video files (i.e.; AVI, MOV, MPEG 

etc), which are distributed as separate files in order to retain their compression. 

Publishing to the Internet When you publish to the Internet, Opus produces a single .htm file, 

which serves as the “interface” for the publication, as well as an .ilm file, which contains all the 

additional information and resources necessary for the publication to run. If you have chosen 

separate data files for each chapter or page it will produce an .ilm file for each chapter or page. 

The .htm file draws on this as required to run the publication just as if it were a stand-alone 

Opus publication. In order to do this however an additional plug-in is required, this is the Plexus 

plug in and it is included with your Opus installation. This is loaded automatically from the 

Digital Workshop website when the user first accesses the publication, and doesn’t normally 

need to be downloaded more than once. This procedure is fully automatic for Internet Explorer 

and most other browsers. 

An alternative method of publishing to the internet is to build an Opus Flex publication which 

will export your publication to Macromedia Flash format. This can be displayed on any 

computer which has the popular Flash player installed and can be incorporated into a website 

or even used to create a whole site itself. The publishing process will create an HTML file to 

display the Flash on the site. This has the additional benefit of being compatible with Apple Mac 

computers and allows your publication to be displayed by Mac users without PC-emulation 

software. An Upload Wizard is provided to help you upload the publication files to your web 

server. Alternatively you can simply use any FTP program to copy the files above to a single 

directory on your site. 

  



Recording Interactivity 

Opus now includes the ability to record mouse and keyboard input during the editor preview 

for later playback in the published version. This can be used to produce non-interactive demos 

and, with the Video Creator publication type, to create videos of a publication in use. These 

videos could then be used for training purposes or integrated into the publication as "visual 

help". 

To record the publication: 1. Select the Record Publication option from the Publication menu. 2. 

Your publication will now preview in the normal way – use it in the manner you want to be 

recorded. All keyboard and mouse input you make will be recorded as it takes place. 3. To stop 

the recording and return to the editor, simply press the Esc key. 

To play back the recorded publication in the editor 1. Select the Playback Recording option 

from the Publication menu. 2. Your publication will now preview and all user input will be 

played back as though the user was performing the operations. 3. To stop the playback and 

return to the editor, simply press the Esc key. 

To use the playback in a Video Creator publication The mouse and keyboard recording is most 

useful for creating demonstration publications to be turned into videos via the Video Creator 

publication type. Once the publication has been recorded. 1. Click on the Publication menu, 

then select the Publish option. This will open the Publish Wizard. 2. Follow the normal 

procedure for publishing up to the page with the Settings... button and then click this button. 3. 

On the Settings dialog go to the General tab. 

a) Tick the Show Cursor in Playback option if you want the 

mouse cursor to be visible in the published video file. 

b) Tick the Publish keyboard and mouse recording data option if you want the recorded mouse 

and keyboard recorder data to be used when creating the video file. This is independent of the 

Show Cursor in Playback option, so it is possible to playback the recording without the cursor 

being visible. 4. Continue the publish process as normal. The final output video will use the 

mouse and keyboard recording data and all user input will be played back as though the user 

was performing the operations. 

To use the playback in a standard Opus publication The mouse and keyboard recording can also be used in 

standard Opus publication (including DirectX) to create non-interactive demos. 1. Click on the Publication menu, 

then select the Publish option. This will open the Publish Wizard. 2. Follow the normal procedure for publishing up 

to the page with the Settings... button. Click the Settings button to open the publication settings. 3. On the Settings 

dialog go to the General tab and tick the Publish keyboard and mouse recording data option. 4. Continue the 

publish process as normal. When the publication is run the mouse and keyboard input will be played back as 

though the user was performing the operations. Note: The playback of recorder keyboard and mouse data is not 

available in Opus Flex publications. 



  



 

DVD Publishing 

Most Opus versions now allow you to create publications that produce content that can be 

played on standard DVD-Video players. Opus lets you design both menu and content pages and 

connect the two into an integrated DVD-Video. This opens up the burgeoning domestic DVD 

market for entertainment products, creative publishing, marketing and training materials. Opus 

DVD is not meant to be a DVD Authoring package. It is a DVD publishing package. Unlike other 

DVD programs you can combine amounts of text, presentation images, still images, voiceover 

and animation into your DVD publication, not just video with a few titles and a soundtrack. It 

opens up a whole new opportunity for communication with an even broader audience. Opus is 

very different to DVD-Video and many of the functions provided by Opus are not compatible 

with DVD-Video. However, we have left the functionality in when creating Normal pages so that 

you can create sub-elements of your publication which are ultimately rendered to non-

interactive video but can support any functionality you require to demonstrate. To convert 

human interaction with your publication into a video which will be compatible with DVD-Video 

use the Mouse and Keyboard Recorder function provided. Please note; that third-party 

software is required to "burn" the final DVD. We have integrated support for the Nero range of 

tools so if you have Nero v5.5 or higher installed you can burn DVD and CDs directly from within 

the program. Alternatively you can publish the material to a directory to burn with your 

preferred DVD-burning program. 

DVD Format Restrictions The DVD standard imposes a number of restrictions on what can be 

included in the publication. Remember that DVD is intended as a playback format and cannot 

achieve the levels of interactivity possible in a normal Opus publication. In particular the 

following limitations should be noted. 

Menu Pages 

• Menu hotspots must not overlap. 

• There is a maximum of 20 menu items on a single page. 

• There is a maximum of 70 menu pages per publication. 

Video Pages 

• Quicktime (.mov) files cannot be converted. 

Normal Pages 

• The Browsers, DocView and QuickTime VR objects are not available. 

• Multiple windows or any functions that invoke extra windows (such as bookmarks or the 

publication search) are not available. If any of these errors are encountered during the initial 

publish process an error will be reported. 



Safe Area The safe area is that portion of the whole video frame considered safe for important 

information. Typically it occupies the centre 90% of the screen, giving a 5% border on all edges. 

Domestic television sets overscan – that is, they display the pictures slightly too large to fit on 

the visible screen. This is done to hide imperfections in the television set’s handling of sharp 

changes in brightness (which cause the picture to bow and distort). This overscan is not fixed 

and can vary widely; particularly on older television sets. Typically around 5% of the image is 

lost on each edge. Professional television monitors and computer displays do not use 

overscanning and the concept of a safe area does not apply. The alternative is to use the 

guidelines to indicate the safe area on the page and only place objects inside that area. That 

way you can be sure your background will stretch to fill the screen but no objects will be lost. 

General tab for Opus DVD The General tab in the Publishing Settings dialog for Opus DVD 

publications is different than for the other types of publications you can create in the Publish 

Wizard. The General tab allows you to set the way the publish should output the published 

version. All of these options have initial default settings. The Show Cursor in Playback option 

lets you show the mouse cursor in the published video file. While the Publish keyboard and 

mouse recording data option lets you display the recorded mouse and keyboard recorder data 

to be used when creating the video file. This is independent of the Show Cursor in Playback 

option, so it is possible to playback the recording without the cursor being visible. 

The Stop after... option if you want the published video file to run for a specific length. If the 

publication exits via an Exit action at any point then the video will stop at that point. If however 

there is no the video would continue to run indefinitely (or until the available disk space is used 

up). To ensure this does not happen, set a video length here if there is no other exit point in the 

publication. 

Page types in Opus DVD To make developing DVD publications simpler Opus DVD provides 

three types of pages, each with a specific purpose. The page types are: 

Menu Pages These pages are used to link together the pages produced using the Video and 

Normal page types. Menu pages are the only place where user interaction can take place in a 

DVD. Interactivity in DVDs is limited to a simple mouse click in computer based players, or a 

press of the OK button on standalone players, and navigation through the available options 

Video Pages These pages play back a single video file full screen. This is the simplest way to 

include any material generated from other sources. For example you could edit the video 

portions of a DVD in a suitable editing package and then use Opus DVD to combine the video 

material into a finished DVD. If you have video in DVD compatible MPEG2 format files they can 

be included directly into the DVD without any re-encoding. Other formats and sizes of video 

must be re-encoded during the publish process. This can result in a loss of quality so it is always 

advisable to start with source material that is uncompressed or has been compressed with a 

lossless codec. 



Normal Pages Normal pages are exported to MPEG2 video in the same manner as the standard 

video export publications. Most Opus actions and object types are available but there is no 

interactivity. User interaction can be simulated through the Mouse and Keyboard recorder. 

DVD Page Type tab The Type tab in the Properties dialog box for a page allows you to set the 

different page types to determine what features are available for that page. 

The Type tab settings: 

The Normal Page option sets the current page as a normal Opus page. All the functionality of 

Opus will be available but any interaction the pages have (buttons etc) will have to be 

performed manually and recorded using the mouse and keyboard recording facility. 

Alternatively any activity associated with interactive elements will never appear on the DVD. 

These pages have no specific settings. 

The Menu Page option to set the current page as a menu page. 

The pages have several specific settings: 

a) Hotspot colour – The active items of a DVD menu page are hotspots and the currently active 

hotspot is indicated by a simple graphic or a rectangular highlight in a single colour. This option 

allows you to set the colour by selecting it from the dropdown colour well in the usual way. b) 

Hotspot Style – Opus provides a range of simple graphics to indicate the active item. You can 

choose these from the dropdown palette provided. Alternatively you can set the hotspot to be 

a rectangle which will be drawn around the hotspot object by selecting the Rectangle option at 

the bottom of the palette. 

c) Run page for – This determines the length of time the video for the menu should run for. 

Menu pages can have non- interactive animations or video backgrounds. If the menu page has 

no animation or music and the Repeat option is not used, this time can be set as short as 1 

second. Please see the Note below for the Repeat at End option when setting short page times. 

d) Repeat at end - Check the Repeat at end option if the menu page should loop. This can be 

useful for animated menu pages or those with background music. Note: DVD players take a 

noticeable period of time to reset at the end of a looped menu page. If the page time is set to a 

very short period then it can become difficult to select a menu item as the menu state is reset 

at the end of each repeat. It is therefore recommended that if the Repeat at end option is used, 

the Run page for time should be set to a minimum of 10 seconds, and longer if disk space 

permits. The Video Page option to set the current page as a video page. 

Video pages have several specific settings: 

a) Filename – Use the Browse button to locate the video file to display. b) Go to this page when 

finished – This is the page that that will be displayed when this video page has completed. This 

page can be any kind of page; so you can return to a menu or play another video page, for 

example. c) Don’t re-encode video – If you have source video files that are already in DVD 



compatible MPEG2 format selecting this option will cause the files to be included into the final 

DVD without re-encoding them. This will preserve their original quality and speed the publish 

process. All other formats must be re-encoded. 

Note: This is an advanced option. Opus cannot detect in advance whether the source file is DVD 

compatible, so you should only check this option if you are certain the file is in the correct 

format. 

DVD Settings tab for Opus DVD The DVD Settings tab in the Publishing Settings dialog for Opus 

DVD publications allows you to set DVD specific options. All of these options have initial default 

settings. 

To edit the General tab settings: 1. The Video Format panel sets the format used for the video 

output of the DVD publish process. Select NTSC if you want the DVD to be playable in countries 

using that system (Primarily North America and Japan). Select PAL for the rest of the world. 

Some players are capable of playing both formats, others will play the format but the picture 

quality will smear or break up to a greater or lesser degree. Notes: a) Although France and 

some of its former colonies use their own television format (SECAM), DVDs do not use this and 

these countries use PAL for DVD. b) The video format does not have any relationship to the 

region coding used by commercial DVD producers to restrict sales of their products. Opus DVD 

does not use or set region codes. 2. The Aspect Ratio panel determines the aspect ratio used for 

the video output of the DVD publish process. Select Fullscreen (4:3) to produce video that fills a 

"normal" television display. Select Widescreen (16:9) to produce video that fills a widescreen 

display. Note that the widescreen formatting is not represented in the Video Export process – 

the image will be correct when displayed on a widescreen television. Note: The aspect ratio of 

the original Opus pages does not effect to final DVD output; however it is much easier to design 

your publication using the correct page sizes, as this will ensure the DVD looks the same as your 

source publication. 3. The Safe Area panel is used to ensure an Opus page appears within the 

television safe area a border can be added to the output video. The border is set to the colour 

of the Surround Colour, which is set in the Options tab of the Publication Properties dialog. The 

option to set an image on the surround is not supported. Notes: 

a) You can set this border to zero but you must remember to allow for the safe area when 

designing the publication. As a rough guide, keep objects that must be on screen at least 5% of 

the page size away from the edges. You can use the rulers and guidelines to assist with this. b) 

Computer monitors do not overscan. If the final DVD will only ever be viewed on a computer 

then you do not need to compensate for the safe area. 4. Make your changes to the other tabs 

in the Publish Settings dialog, then click the OK button to close the dialog and return to the 

third page of the Publish Wizard to start publishing. 

Publishing a DVD publication Firstly run the Publishing Wizard by clicking on the Publish option 

on Publication. Note that the first time you create a video a warning message will appear to 



remind you to set an exit point or total time for the video to run. If you do not set an exit point 

or total time the video export process will continue indefinitely until the available disc space is 

used up, or the Windows file size limit (4Gb for NTFS drives or 2Gb for FAT32 drives) is reached. 

Follow the instructions given to build your publication. This creates an intermediate file from 

which the DVD file will be exported. Then click Next to go to the next stage. At this point the 

actual DVD export process will begin. Please allow a few seconds for the DVD exporter to start 

the video export dialog will provide feedback on the progress of the export process. Note that if 

you want to stop the export process click the Abort button or press the Esc key. Terminating 

the video export requires some time to complete so the process may not abort immediately. 

When the abort process is complete the Abort button with change to OK. When the export 

process is complete click OK to return to the Publish Wizard. If you do not wish to create the 

DVD disk at this point then click Finish to exit the wizard and return to the Opus editor. This has 

now created the files required for copying to a DVD-Video disk. 

Writing (Burning) a DVD To enable the files produced by Opus DVD to be read on a stand-alone 

DVD player they must be written (or "burned" as the process is known) to a DVD disk as a DVD-

Video. If a copy of Nero Burning ROM is installed on the same computer as Opus, this process 

can be handled automatically. If not it is a simple process to create a DVD-Video disc in most 

DVD writing packages. 

To burn an Opus DVD project using Opus and Nero Once the video export process has been 

completed, select OK and return to the DVD Publish Wizard. Ensure you have a writable DVD-

Video disk in your DVD drive. Click the Write DVD button. The DVD is automatically created 

directly from within Opus without any further interaction. 

To burn a DVD using third-party DVD software These instructions are by their nature non-

specific as each DVD creation package works in a slightly different way but this should guide 

you along the right lines. If you experience difficulty please consult the DVD software help or 

manual on the process for writing a DVD-Video format disc. Firstly publish the DVD project to a 

folder as detailed above then run your chosen DVD creation tool.. In that tool create a new 

DVD-Video project. The type of project is very important. It just be a video project as a DVD 

data disc is intended for computer DVD drives and cannot be read on stand-alone DVD players. 

Insert the files produced by the Opus DVD publishing process into the new project. In many 

DVD writing packages this is as simple as dragging and dropping the AUDIO_TS and VIDEO_TS 

folders into the top level of the project. Some packages will provide the AUDIO_TS and 

VIDEO_TS folders for you. In this case you only need to add the contents of the Opus DVD- 

VIDEO_TS folder into the same folder of the DVD project. The audio is embedded in the video 

files and the AUDIO_TS Finally use the relevant option to actually write the DVD-Video disk in 

your drive. In some programs this process will be called “burn” or “create”. 


